Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. This manual is also copyrighted and all rights are reserved. This manual may not, in whole or in part, be copied, photocopied, translated, or reduced to any electronic medium or machine-readable form without prior consent, in writing, from Progress Software Corporation.

The information in this manual is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear in this document.

The references in this manual to specific platforms supported are subject to change.

A (and design), Actional, Actional (and design), Affinities Server, Allegrix, Allegrix (and design), Apama, Business Empowerment, ClientBuilder, ClientSoft, ClientSoft (and Design), Clientsoft.com, DataDirect (and design), DataDirect Connect, DataDirect Connect OLE DB, DataDirect Technologies, DataDirect XQuery, DataXtend, Dynamic Routing Architecture, EasyAsk, EdgeXtend, Empowerment Center, eXcelon, Fathom, IntelliStream, Neon, Neon New Era of Networks, O (and design), ObjectStore, OpenEdge, PDF, PeerDirect, Persistence, Persistence (and design), POSSENET, Powered by Progress, PowerTier, ProCare, Progress, Progress DataXtend, Progress Dynamics, Progress Business Empowerment, Progress Empowerment Center, Progress Empowerment Program, Progress Fast Track, Progress OpenEdge, Progress Profiles, Progress Results, Progress Software Developers Network, ProVision, PS Select, Sequelink, Shadow, ShadowDirect, Shadow Interface, Shadow Web Interface, ShadowWeb Server, Shadow TLS, SOAPStation, Sonic ESB, SonicMQ, Sonic Orchestration Server, Sonic Software (and design), SonicSynergy, SpeedScript, Stylus Studio, Technical Empowerment, Voice of Experience, WebSpeed, and Your Software, Our Technology—Experience the Connection are registered trademarks of Progress Software Corporation or one of its subsidiaries or affiliates in the U.S. and/or other countries. AccelEvent, Apama Dashboard Studio, Apama Event Manager, Apama Event Modeler, Apama Event Store, AppsAlive, AppServer, ASPen, ASP-in-a-Box, BusinessEdge, Cache-Forward, DataDirect Spy, DataDirect SupportLink, DataDirect XML Converters, Future Proof, Ghost Agents, GVAC, Looking Glass, ObjectCache, ObjectStore Inspector, ObjectStore Performance Expert, Pantero, POSSE, ProDataSet, Progress ESP Event Manager, Progress ESP Event Modeler, Progress Event Engine, Progress RFID, PSE Pro, SectorAlliance, SmartBrowser, SmartComponent, SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame, SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, Sonic, Sonic Business Integration Suite, Sonic Process Manager, Sonic Collaboration Server, Sonic Continuous Availability Architecture, Sonic Database Service, Sonic Workbench, Sonic XML Server, The Brains Behind BAM, WebClient, and Who Makes Progress are trademarks or service marks of Progress Software Corporation or one of its subsidiaries or affiliates in the U.S. and other countries. Vermont Views is a registered trademark of Vermont Creative Software in the U.S. and other countries. IBM is a registered trademark of IBM Corporation. JMX and JMX-based marks and Java and all Java-based marks are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries. Any other trademarks or service marks contained herein are the property of their respective owners.

Third party acknowledgements — See the “Third party acknowledgements” section on page Preface–9.

February 2008

Last updated with new content: Release 10.0A

Product Code: 4496; R10.1C

For the latest documentation updates see the OpenEdge Product Documentation category on PSDN (http://www.psdn.com/library/kbcategory.jspa?categoryId=129).
## Contents

1. **Results for Administrators and Programmers** ........................................ 1–1  
   - Results product architecture ................................................................. 1–2  
     - Basic components .................................................................................. 1–2  
   - Results development and administration ............................................... 1–4  
     - Understanding the relationship between roles .................................... 1–5  
   - Starting and stopping Results ................................................................. 1–6  
     - Using the startup commands ............................................................... 1–6  
     - Starting a sever for an OpenEdge database ......................................... 1–7

2. **Administering Results** ................................................................. 2–1  
   - Before you begin ....................................................................................... 2–2  
     - Feature prerequisites ............................................................................ 2–2  
   - The Results Site Admin menu ................................................................. 2–2  
   - Results and application databases ......................................................... 2–3  
     - Database configuration files ................................................................. 2–3  
     - Table aliases .......................................................................................... 2–6  
     - Table relationships and multi-table queries ......................................... 2–8  
   - The Join Construction dialog box ........................................................... 2–13  
   - User management .................................................................................... 2–15  
   - Site security administration .................................................................... 2–17  
     - Application security ............................................................................... 2–19  
     - Data security ........................................................................................ 2–23
## Site defaults
- Standard page sizes ........................................... 2–29
- Standard export formats .......................................... 2–30
- Standard label sizes ............................................... 2–31
- Label Field Selection defaults .............................. 2–32

### 3. Programming Results ........................................ 3–1
- Before you begin ................................................. 3–2
- Results architecture and application development ....... 3–2
  - Basic tasks to develop a Results application .......... 3–3
- Application configuration .................................... 3–4
  - Application base files .................................... 3–5
  - Application preferences ................................... 3–6
- Integration points and procedures ....................... 3–9
- Features ......................................................... 3–12
  - Developing new features overview ....................... 3–12
  - Feature procedures ....................................... 3–13
  - Feature Editor .............................................. 3–15
  - Menu Editor ............................................... 3–18
  - Tool Bar Editor ............................................ 3–22
  - Feature and interface management ...................... 3–24
- Results application programming interface (API) .... 3–24
  - API basics ................................................... 3–25
  - Accessing and editing the current query .............. 3–31
  - Generating new queries .................................... 3–46
- Output solutions in Results ................................ 3–49
- Export solutions in Results ................................ 3–52
- Results main application procedure .................... 3–53
- Code generation ............................................... 3–54
  - Generating code from within Results .................. 3–55
  - Generating code from an application ................. 3–55
  - Ask At Run Time values ................................... 3–56

### 4. Deploying Results Applications .......................... 4–1
- Before you begin ................................................ 4–2
- Deployment process and site requirements ............. 4–2
  - Initiating the deployment process ....................... 4–2
  - Building a Results application ........................... 4–3
- Application files for deployment ...................... 4–3
  - The deployment report ..................................... 4–4
  - Other possible deployment files ....................... 4–7
  - Graphics files ............................................... 4–8
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application databases . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–8</td>
</tr>
<tr>
<td>The application directory structure . . . . . . . . . . . . . . . . . . . . 4–9</td>
</tr>
<tr>
<td>Relative pathnames and Propath . . . . . . . . . . . . . . . . . . . . . . . 4–9</td>
</tr>
<tr>
<td>Progress Application compilation . . . . . . . . . . . . . . . . . . . . . . 4–10</td>
</tr>
<tr>
<td>The fastload system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4–10</td>
</tr>
<tr>
<td>A. Results Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–1</td>
</tr>
<tr>
<td>Before you begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–2</td>
</tr>
<tr>
<td>Reference entry details . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–2</td>
</tr>
<tr>
<td>Reference entry example . . . . . . . . . . . . . . . . . . . . . . . . . . . A–2</td>
</tr>
<tr>
<td>About Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–3</td>
</tr>
<tr>
<td>AdminCustomizeInterface . . . . . . . . . . . . . . . . . . . . . . . . . . . A–3</td>
</tr>
<tr>
<td>AdminDeployment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–3</td>
</tr>
<tr>
<td>AdminExportType . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–4</td>
</tr>
<tr>
<td>AdminFeatures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–4</td>
</tr>
<tr>
<td>AdminIntegration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–4</td>
</tr>
<tr>
<td>AdminLabelField . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–5</td>
</tr>
<tr>
<td>AdminLabelType . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–5</td>
</tr>
<tr>
<td>AdminMenuEdit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–5</td>
</tr>
<tr>
<td>AdminProgInitialize . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–6</td>
</tr>
<tr>
<td>AdminProgInstantiate . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–6</td>
</tr>
<tr>
<td>AdminProgWrite4GL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–7</td>
</tr>
<tr>
<td>AdminRebuild . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–7</td>
</tr>
<tr>
<td>AdminReportType . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–8</td>
</tr>
<tr>
<td>AdminReset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–8</td>
</tr>
<tr>
<td>AdminSecurity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–8</td>
</tr>
<tr>
<td>AdminSubMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–9</td>
</tr>
<tr>
<td>AdminTableAlias . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–9</td>
</tr>
<tr>
<td>AdminTableRelations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–9</td>
</tr>
<tr>
<td>AdminToolBarEdit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–10</td>
</tr>
<tr>
<td>AdminWhere . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–10</td>
</tr>
<tr>
<td>Array . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–10</td>
</tr>
<tr>
<td>BrowseView . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–11</td>
</tr>
<tr>
<td>CalcSubMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–11</td>
</tr>
<tr>
<td>Counter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–11</td>
</tr>
<tr>
<td>CustomLabel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–12</td>
</tr>
<tr>
<td>CustomReport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–12</td>
</tr>
<tr>
<td>DataGovernor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–12</td>
</tr>
<tr>
<td>DateFunc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–13</td>
</tr>
<tr>
<td>Exit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–13</td>
</tr>
<tr>
<td>ExportSubMenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–13</td>
</tr>
<tr>
<td>ExportView . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–14</td>
</tr>
<tr>
<td>FieldDelimiters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–14</td>
</tr>
<tr>
<td>FieldProperties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–14</td>
</tr>
</tbody>
</table>
### Contents

<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td>A–15</td>
</tr>
<tr>
<td>FieldSeparators</td>
<td>A–15</td>
</tr>
<tr>
<td>FileClose</td>
<td>A–15</td>
</tr>
<tr>
<td>FileDelete</td>
<td>A–16</td>
</tr>
<tr>
<td>FileOpen</td>
<td>A–16</td>
</tr>
<tr>
<td>FileSave</td>
<td>A–16</td>
</tr>
<tr>
<td>FileSaveAs</td>
<td>A–17</td>
</tr>
<tr>
<td>FixedWidthFields</td>
<td>A–17</td>
</tr>
<tr>
<td>FormView</td>
<td>A–17</td>
</tr>
<tr>
<td>FrameProperties</td>
<td>A–18</td>
</tr>
<tr>
<td>Generate</td>
<td>A–18</td>
</tr>
<tr>
<td>HeadersAndFooters</td>
<td>A–18</td>
</tr>
<tr>
<td>HelpContents</td>
<td>A–19</td>
</tr>
<tr>
<td>HelpSearch</td>
<td>A–19</td>
</tr>
<tr>
<td>Includes</td>
<td>A–19</td>
</tr>
<tr>
<td>Information</td>
<td>A–20</td>
</tr>
<tr>
<td>Joins</td>
<td>A–20</td>
</tr>
<tr>
<td>LabelView</td>
<td>A–20</td>
</tr>
<tr>
<td>LogicalFunc</td>
<td>A–21</td>
</tr>
<tr>
<td>Lookup</td>
<td>A–21</td>
</tr>
<tr>
<td>MasterDetail</td>
<td>A–21</td>
</tr>
<tr>
<td>Math</td>
<td>A–22</td>
</tr>
<tr>
<td>Messages</td>
<td>A–22</td>
</tr>
<tr>
<td>NewBrowseView</td>
<td>A–22</td>
</tr>
<tr>
<td>NewDuplicateView</td>
<td>A–23</td>
</tr>
<tr>
<td>NewExportView</td>
<td>A–23</td>
</tr>
<tr>
<td>NewFormView</td>
<td>A–23</td>
</tr>
<tr>
<td>NewLabelView</td>
<td>A–24</td>
</tr>
<tr>
<td>NewReportView</td>
<td>A–24</td>
</tr>
<tr>
<td>NewSubMenu</td>
<td>A–24</td>
</tr>
<tr>
<td>NumericFunc</td>
<td>A–25</td>
</tr>
<tr>
<td>OutputHeaderRecord</td>
<td>A–25</td>
</tr>
<tr>
<td>PageBreak</td>
<td>A–25</td>
</tr>
<tr>
<td>PercentTotal</td>
<td>A–25</td>
</tr>
<tr>
<td>PrintClip</td>
<td>A–26</td>
</tr>
<tr>
<td>PrintFile</td>
<td>A–26</td>
</tr>
<tr>
<td>PrintPreview</td>
<td>A–26</td>
</tr>
<tr>
<td>PrintPrinter</td>
<td>A–27</td>
</tr>
<tr>
<td>PrintPrinterNoBox</td>
<td>A–27</td>
</tr>
<tr>
<td>PrintSubMenu</td>
<td>A–27</td>
</tr>
<tr>
<td>ProgrammingSubMenu</td>
<td>A–28</td>
</tr>
<tr>
<td>ReadOtherDirectory</td>
<td>A–28</td>
</tr>
<tr>
<td>ReadPublicDirectory</td>
<td>A–28</td>
</tr>
<tr>
<td>ReAsk</td>
<td>A–28</td>
</tr>
<tr>
<td>RecentMessages</td>
<td>A–29</td>
</tr>
</tbody>
</table>
Contents

RecordAdd . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–29
RecordDelete . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–30
RecordEnd . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–30
RecordStart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–30
RecordUpdate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–31
ReportView . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–31
RunningTotal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–31
Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–32
SortOrdering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–32
StandardExport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–32
StandardLabel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–33
StandardReport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–33
StatusLine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–33
StringFunc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–34
Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–34
ToolBar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–34
Totals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–35
TotalsOnly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–35
WriteOtherDirectory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–35
WritePublicDirectory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A–36

B. Results Limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B–1
Results limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B–2
Results views limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B–2
Results queries limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B–2
Miscellaneous Results limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B–3
Additional information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B–4

C. Results Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–1
Results-generated files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–2
Editing the results.l file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–4
Delimiter characters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–4
Standard export formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–5
Standard label formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–8
Standard page formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–9
Editing a QC7 file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–11
Editing a QD7 file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C–12
Editing user interface and feature files . . . . . . . . . . . . . . . . . . . . . . . . . . . C–13

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Index–1
## Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1–1:</td>
<td>Results product architecture</td>
<td>1–2</td>
</tr>
<tr>
<td>Figure 2–1:</td>
<td>Join Construction dialog box</td>
<td>2–13</td>
</tr>
<tr>
<td>Figure 2–2:</td>
<td>Label Field Selection dialog box</td>
<td>2–32</td>
</tr>
<tr>
<td>Figure 3–1:</td>
<td>Results product architecture</td>
<td>3–2</td>
</tr>
<tr>
<td>Figure 3–2:</td>
<td>Customize menu</td>
<td>3–4</td>
</tr>
<tr>
<td>Figure A–1:</td>
<td>Reference entry example</td>
<td>A–2</td>
</tr>
</tbody>
</table>
Tables
Table 1–1: Results menu system ............................................................... 1–5
Table 2–1: User ID specifications ........................................................... 2–21
Table 2–2: User list examples ............................................................... 2–22
Table 2–3: Operator buttons .............................................................. 2–26
Table 3–1: Exit feature options ........................................................... 3–7
Table 3–2: Write configuration Save options ...................................... 3–8
Table 3–3: Integration points and procedures .................................... 3–10
Table 3–4: API shared variables ........................................................ 3–25
Table 3–5: API procedures ............................................................... 3–27
Table 3–6: Important Results features ................................................ 3–29
Table 3–7: The Results API and error messages ................................. 3–30
Table 3–8: View character codes ....................................................... 3–31
Table 3–9: Calculated field symbols .................................................. 3–36
Table 3–10: Aggregate string ............................................................ 3–39
Table 3–11: Elements of the qbf-rcp variable .................................. 3–40
Table 3–12: Sample output feature procedures .................................. 3–50
Table 3–13: Code generation using Query→Generate ......................... 3–55
Table B–1: View limitations .............................................................. B–2
Table B–2: Query limitations ............................................................ B–2
Table B–3: Miscellaneous limitations ............................................... B–3
Table B–4: OpenEdge-related limitations ......................................... B–4
Table B–5: Query limitations ............................................................ B–4
Table B–6: Miscellaneous limitations ............................................... B–5
Table C–1: Files generated by Results .............................................. C–2
Table C–2: Definitional codes for export formats ............................. C–5
Table C–3: Definitional codes for label formats ................................ C–8
Table C–4: Definitional codes for page formats ................................. C–10
## Examples

| Example 3–1: | u-mcheck.p example code template | 3–20 |
| Example 3–2: | u-mcheck.p code example | 3–21 |
| Example 3–3: | sffire.p | 3–29 |
| Example 3–4: | Feature procedure | 3–31 |
| Example 3–5: | tstFeat.p | 3–48 |
| Example 3–6: | Technique to manage user focus and multiple windows | 3–53 |
| Example 4–1: | sport.txt | 4–4 |
Preface

This Preface contains the following sections:

- Purpose
- Audience
- Organization
- Using this manual
- Typographical conventions
- Examples of syntax descriptions
- OpenEdge messages
- Third party acknowledgements
Purpose

This guide introduces you to the administration and development capabilities of Progress Results® Version 2 for Windows. Query/Results, more commonly referenced throughout this guide as Results, is an interactive, menu-driven software tool that lets you query, report, and maintain information contained in Progress-supported databases.

Audience

This book is a guide for both Results programmers and site administrators. A Results programmer is a Progress programmer who wants to customize and extend Results. A site administrator is a system administrator at an end user site who has the responsibility of maintaining and configuring Results for end-users. This manual requires that both audiences know and understand the end-user features and functionality of Results. For a basic understanding of the Results Version 2 product, see the OpenEdge Reporting: Query/Results for Windows or OpenEdge Reporting: Query/Results for UNIX.

Organization

Chapter 1, “Results for Administrators and Programmers”

Provides an overview of administration and development tasks in Results and describes how to start and stop Results.

Chapter 2, “Administering Results”

Describes the system administration tools and procedures to use for a deployed Results application at an end-user site.

Chapter 3, “Programming Results”

Describes the concepts, tools, and programming techniques required to customize and extend Results.

Chapter 4, “Deploying Results Applications”

Explains how to deploy a Results application to an end-user environment.
Appendix A, “Results Features”

Contains an alphabetical listing of reference entries for each feature in Results.

Appendix B, “Results Limits”

Lists the limits that exist within Results.

Appendix C, “Results Files”

Provides information about files that Results generates and file formats.

Using this manual

You need not read through the whole manual in detail. A good strategy would be to skim the whole manual once, and then re-read in detail as needed.

Also, due to the differences between the programming and administration audiences, not all portions of this manual are appropriate for both audiences. The following table suggests a reading path for each audience:

<table>
<thead>
<tr>
<th>To learn this information...</th>
<th>Read this material:</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to set up and maintain Results.</td>
<td>Chapter 1, “Results for Administrators and Programmers” and Chapter 2, “Administering Results,” Appendix A, “Results Features” and Appendix C, “Results Files”</td>
</tr>
<tr>
<td>How to develop and deploy a Results application.</td>
<td>All chapters and appendices.</td>
</tr>
</tbody>
</table>

## Typographical conventions

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, or the names of user interface elements.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Italic typeface indicates the title of a document, provides emphasis, or signifies new terms.</td>
</tr>
<tr>
<td>SMALL, BOLD CAPITAL LETTERS</td>
<td>Small, bold capital letters indicate OpenEdge™ key functions and generic keyboard keys; for example, GET and CTRL.</td>
</tr>
<tr>
<td>KEY1-KEY2</td>
<td>A hyphen between key names indicates a <em>simultaneous</em> key sequence: you press and hold down the first key while pressing the second key. For example, CTRL-X.</td>
</tr>
<tr>
<td>KEY1 KEY2</td>
<td>A space between key names indicates a <em>sequential</em> key sequence: you press and release the first key, then press another key. For example, ESCAPE H.</td>
</tr>
</tbody>
</table>

### Syntax:

<table>
<thead>
<tr>
<th>Fixed width</th>
<th>A fixed-width font is used in syntax statements, code examples, and for system output and filenames.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed-width italics</td>
<td>Fixed-width italics indicate variables in syntax statements.</td>
</tr>
<tr>
<td>Fixed-width bold</td>
<td>Fixed-width bold indicates variables with special emphasis.</td>
</tr>
<tr>
<td>UPPERCASE fixed width</td>
<td>Uppercase words are Progress® 4GL language keywords. Although these always are shown in uppercase, you can type them in either uppercase or lowercase in a procedure.</td>
</tr>
<tr>
<td>Period (.) or colon (:)</td>
<td>All statements except DO, FOR, FUNCTION, PROCEDURE, and REPEAT end with a period. DO, FOR, FUNCTION, PROCEDURE, and REPEAT statements can end with either a period or a colon.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Large brackets indicate the items within them are optional.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Small brackets are part of the Progress 4GL language.</td>
</tr>
<tr>
<td>{ }</td>
<td>Large braces indicate the items within them are required. They are used to simplify complex syntax diagrams.</td>
</tr>
</tbody>
</table>
Examples of syntax descriptions

In this example, ACCUM is a keyword, and aggregate and expression are variables:

```
ACCUM aggregate expression
```

FOR is one of the statements that can end with either a period or a colon, as in this example:

```
FOR EACH Customer:
    DISPLAY Name.
END.
```

In this example, STREAM stream, UNLESS-HIDDEN, and NO-ERROR are optional:

```
DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]
```

In this example, the outer (small) brackets are part of the language, and the inner (large) brackets denote an optional item:

```
INITIAL [ constant [ , constant ] ]
```
A called external procedure must use braces when referencing compile-time arguments passed by a calling procedure, as shown in this example:

\{ \&argument-name \}\n
In this example, EACH, FIRST, and LAST are optional, but you can choose only one of them:

\texttt{PRESELECT [ EACH \mid FIRST \mid LAST ] record-phrase}\n
In this example, you must include two expressions, and optionally you can include more. Multiple expressions are separated by commas:

\texttt{MAXIMUM ( expression \mid expression [ , expression ] . . . )}\n
In this example, you must specify MESSAGE and at least one expression or SKIP \texttt{[ ( n ) ]}, and any number of additional expression or \texttt{SKIP [ ( n ) ]} is allowed:

\texttt{MESSAGE \{ expression \mid SKIP [ ( n ) ] \} . . .}\n
In this example, you must specify \texttt{\{ include-file, then optionally any number of argument or \&argument-name = "argument-value", and then terminate with \}}:

\texttt{\{ include-file
\mid argument \mid \&argument-name = "argument-value" \ldots \}
Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split across multiple lines, groups of optional and groups of required items are kept together in the required order.

In this example, WITH is followed by six optional items:

Syntax

```
 WITH [ ACCUM max-length ] [ expression DOWN ]
   [ CENTERED ] [ n COLUMNS ] [ SIDE-LABELS ]
   [ STREAM-IO ]
```

Complex syntax descriptions with both required and optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by bracketing only the optional elements. For such syntax, the descriptions include both braces (for required elements) and brackets (for optional elements).

In this example, ASSIGN requires either one or more field entries or one record. Options available with field or record are grouped with braces and brackets:

Syntax

```
 ASSIGN {   { [ FRAME frame ]
             { field [ = expression ] } [ WHEN expression ]
             } ... 
          | { record [ EXCEPT field ... ] } } 
```
OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.

- **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.

- **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

- Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

- Returns to the Progress Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

- Halts processing of a procedure and returns immediately to the Progress Procedure Editor. This does not happen often.

- Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.
Obtaining more information about OpenEdge messages

On Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

- Choose Help→ Recent Messages to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.

- Choose Help→ Messages and then enter the message number to display a description of a specific OpenEdge message.

- In the Progress Procedure Editor, press the HELP key or F1.

On UNIX platforms, use the Progress PRO command to start a single-user mode character OpenEdge client session and view a brief description of a message by providing its number.

To use the PRO command to obtain a message description by message number:

1. Start the Progress Procedure Editor:

   ```
   install-dir/dlc/bin/pro
   ```

2. Press F3 to access the menu bar, then choose Help→ Messages.

3. Type the message number and press ENTER. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Progress Procedure Editor menu, and choose File→ Exit.

Third party acknowledgements

OpenEdge includes AdventNet - Agent Toolkit licensed from AdventNet, Inc. [http://www.adventnet.com](http://www.adventnet.com). All rights to such copyright material rest with AdventNet.

OpenEdge includes ANTLR (Another Tool for Language Recognition) software Copyright © 2003-2006, Terence Parr. All rights reserved. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. Software distributed on an “AS IS” basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied. See the License for the specific
language governing rights and limitations under the License agreement that accompanies the
product.

OpenEdge includes software developed by the Apache Software Foundation
(http://www.apache.org/). Copyright © 1999 The Apache Software Foundation. All rights
reserved (Xerces C++ Parser (XML) and Xerces2 Java Parser (XML)); Copyright © 1999-2002
The Apache Software Foundation. All rights reserved (Xerces Parser (XML)); and Copyright ©
2000-2003 The Apache Software Foundation. All rights reserved (Ant). The names “Apache,”
“Xerces,” “ANT,” and “Apache Software Foundation” must not be used to endorse or promote
products derived from this software without prior written permission. Products derived from
this software may not be called “Apache”, nor may “Apache” appear in their name, without
prior written permission of the Apache Software Foundation. For written permission, please
contact apache@apache.org. Software distributed on an “AS IS” basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied. See the License for the specific
language governing rights and limitations under the License agreement that accompanies the
product.

OpenEdge includes Concurrent Java software Copyright 1994-2000 Sun Microsystems, Inc. All
Rights Reserved. -Neither the name of or trademarks of Sun may be used to endorse or promote
products including or derived from the Java Software technology without specific prior written
permission; and Redistributions of source or binary code must contain the above copyright
notice, this notice and the following disclaimers: This software is provided "AS IS," without a
warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS
AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR
NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. AND
ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY
LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE
SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN MICROSYSTEMS, INC.
OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR
FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE
DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE,
EVEN IF SUN MICROSYSTEMS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

OpenEdge includes DataDirect software Copyright © 1991-2007 Progress Software
Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for
JDBC Type 4 driver); Copyright © 1993-2009 Progress Software Corporation and/or its
subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for JDBC); Copyright ©
1988-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights
Reserved. (DataDirect Connect for ODBC); and Copyright © 1988-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect64 for ODBC).

OpenEdge includes DataDirect Connect for ODBC and DataDirect Connect64 for ODBC software, which include ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

OpenEdge includes DataDirect Connect for ODBC and DataDirect Connect64 for ODBC software, which include software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2006 The OpenSSL Project. All rights reserved. And Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

OpenEdge includes DataDirect products for the Microsoft SQL Server database which contain a licensed implementation of the Microsoft TDS Protocol.

OpenEdge includes software authored by David M. Gay. Copyright © 1991, 2000, 2001 by Lucent Technologies (dtoa.c); Copyright © 1991, 1996 by Lucent Technologies (g_fmt.c); and Copyright © 1991 by Lucent Technologies (rnd_prod.s). Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes software authored by David M. Gay. Copyright © 1998-2001 by Lucent Technologies All Rights Reserved (decsttod.c; strtodg.c); Copyright © 1998, 2000 by Lucent Technologies All Rights Reserved (decstrtof.c; strtord.c); Copyright © 1998 by Lucent Technologies All Rights Reserved (dmisc.c; gdtoa.h; gethex.c; gmisc.c; sum.c); Copyright © 1998, 1999 by Lucent Technologies All Rights Reserved (gdtoa.c; misc.c; smisc.c; ulp.c); Copyright © 1998-2000 by Lucent Technologies All Rights Reserved (gdtoaimp.h); Copyright © 2000 by Lucent Technologies All Rights Reserved (hd_init.c). Full copies of these licenses can be found in the installation directory, in the c:/OpenEdge/licenses folder. Permission to use,
copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

OpenEdge includes http package software developed by the World Wide Web Consortium. Copyright © 1994-2002 World Wide Web Consortium, (Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio University). All rights reserved. This work is distributed under the W3C® Software License [http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231] in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

OpenEdge includes ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.


OpenEdge includes Infragistics NetAdvantage for .NET v2009 Vol 2 Copyright © 1996-2009 Infragistics, Inc. All rights reserved.

OpenEdge includes JSTL software Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.
OpenEdge includes OpenSSL software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2007 The OpenSSL Project. All rights reserved. This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes Quartz Enterprise Job Scheduler software Copyright © 2001-2003 James House. All rights reserved. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product. This product uses and includes within its distribution, software developed by the Apache Software Foundation (http://www.apache.org/).

OpenEdge includes code licensed from RSA Security, Inc. Some portions licensed from IBM are available at http://oss.software.ibm.com/icu4j/.

OpenEdge includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

OpenEdge includes Sonic software, which includes software developed by Apache Software Foundation (http://www.apache.org/). Copyright © 1999-2000 The Apache Software Foundation. All rights reserved. The names “Ant”, “Axis”, “Xalan”, “FOP”, “The Jakarta Project”, “Tomcat”, “Xerces” and/or “Apache Software Foundation” must not be used to endorse or promote products derived from the Product without prior written permission. Any product derived from the Product may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission. For written permission, please contact apache@apache.org.

OpenEdge includes Sonic software, which includes software Copyright © 1999 CERN - European Organization for Nuclear Research. Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. CERN makes no representations about
the suitability of this software for any purpose. It is provided "as is" without expressed or implied warranty.

OpenEdge includes Sonic software, which includes software developed by ExoLab Project (http://www.exolab.org/). Copyright © 2000 Intalio Inc. All rights reserved. The names “Castor” and/or “ExoLab” must not be used to endorse or promote products derived from the Products without prior written permission. For written permission, please contact info@exolab.org. Exolab, Castor and Intalio are trademarks of Intalio Inc.

OpenEdge includes Sonic software, which includes software developed by IBM. Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

OpenEdge includes Sonic software, which includes the JMX Technology from Sun Microsystems, Inc. Use and Distribution is subject to the Sun Community Source License available at http://sun.com/software/communitysource.

OpenEdge includes Sonic software, which includes software developed by the ModelObjects Group (http://www.modelobjects.com). Copyright © 2000-2001 ModelObjects Group. All rights reserved. The name “ModelObjects” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “ModelObjects”, nor may “ModelObjects” appear in their name, without prior written permission. For written permission, please contact djacobs@modelobjects.com.

OpenEdge includes Sonic software, which includes code licensed from Mort Bay Consulting Pty. Ltd. The Jetty Package is Copyright © 1998 Mort Bay Consulting Pty. Ltd. (Australia) and others.

OpenEdge includes Sonic software, which includes files that are subject to the Netscape Public License Version 1.1 (the “License”); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/NPL/. Software
distributed under the License is distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is Mozilla Communicator client code, released March 31, 1998. The Initial Developer of the Original Code is Netscape Communications Corporation. Portions created by Netscape are Copyright 1998-1999 Netscape Communications Corporation. All Rights Reserved.

OpenEdge includes Sonic software, which includes software developed by the University Corporation for Advanced Internet Development http://www.ucaid.edu Internet2 Project. Copyright © 2002 University Corporation for Advanced Internet Development, Inc. All rights reserved. Neither the name of OpenSAML nor the names of its contributors, nor Internet2, nor the University Corporation for Advanced Internet Development, Inc., nor UCAID may be used to endorse or promote products derived from this software and products derived from this software may not be called OpenSAML, Internet2, UCAID, or the University Corporation for Advanced Internet Development, nor may OpenSAML appear in their name without prior written permission of the University Corporation for Advanced Internet Development. For written permission, please contact opensaml@opensaml.org.

OpenEdge includes the UnixWare platform of Perl Runtime authored by Kiem-Phong Vo and David Korn. Copyright © 1991, 1996 by AT&T Labs. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED “AS IS”, WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHORS NOR AT&T LABS MAKE ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes Vermont Views Terminal Handling Package software developed by Vermont Creative Software. Copyright © 1988-1991 by Vermont Creative Software.

OpenEdge includes XML Tools, which includes versions 8.9 of the Saxon XSLT and XQuery Processor from Saxonica Limited (http://www.saxonica.com/) which are available from SourceForge (http://sourceforge.net/projects/saxon/). The Original Code of Saxon comprises all those components which are not explicitly attributed to other parties. The Initial Developer of the Original Code is Michael Kay. Until February 2001 Michael Kay was an employee of International Computers Limited (now part of Fujitsu Limited), and original code developed during that time was released under this license by permission from International Computers Limited. From February 2001 until February 2004 Michael Kay was an employee of Software AG, and code developed during that time was released under this license by permission from Software AG, acting as a "Contributor". Subsequent code has been developed
by Saxonica Limited, of which Michael Kay is a Director, again acting as a "Contributor". A small number of modules, or enhancements to modules, have been developed by other individuals (either written especially for Saxon, or incorporated into Saxon having initially been released as part of another open source product). Such contributions are acknowledged individually in comments attached to the relevant code modules. All Rights Reserved. The contents of the Saxon files are subject to the Mozilla Public License Version 1.0 (the "License"); you may not use these files except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/MPL/ and a copy of the license can also be found in the installation directory, in the c:/OpenEdge/licenses folder. Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License.

OpenEdge includes XML Tools, which includes Xs3P v1.1.3. The contents of this file are subject to the DSTC Public License (DPL) Version 1.1 (the "License"); you may not use this file except in compliance with the License. A copy of the license can be found in the installation directory, in the c:/OpenEdge/licenses folder. Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is xs3p. The Initial Developer of the Original Code is DSTC. Portions created by DSTC are Copyright © 2001, 2002 DSTC Pty Ltd. All rights reserved.

OpenEdge includes YAJL software Copyright 2007, Lloyd Hilaiel. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Neither the name of Lloyd Hilaiel nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Results is a query and reporting tool for end users running applications in a graphical environments. Results has a large set of default features and a flexible product architecture that allows programmers to customize Results for end-user sites.

This chapter serves as a starting point for Results programmers and site administrators. This chapter presents:

- Results product architecture
- Results development and administration
- Starting and stopping Results
Results product architecture

It is important to understand the Results product architecture from a programming and administrative perspective. The architecture of the Results product is open and modular to support programmer extensions and many different site and user configurations.

Basic components

Figure 1–1 illustrates the basic components of the Results product architecture.

![Results product architecture diagram](image)

Figure 1–1: Results product architecture

The Results product architecture consists of three basic components:

- Features
- Integration procedures
- Results engine
Features

A feature is a functional unit in Results that is usually accessed through a menu option or a button on the tool bar. The default Results product contains many features that implement the core functionality of the product. For example, the menu option Query→Open executes a feature called FileOpen that provides the ability to open a Results query. Programmers can define new features and add them to the Results menu system or toolbar. For example, you can incorporate a graphics package as a feature in Results to graph report data.

Integration procedures

An integration procedure is a Progress 4GL procedure that initializes or configures Results for security or site requirements. Each integration procedure is associated with a processing point that occurs during the execution of Results. Each processing point is called an integration point. Certain integration points occur only when you start Results and others occur when users perform certain actions in Results. Among other things, integration points facilitate the following:

- Establishment of user identity in Results.
- Control of end-user access to an OpenEdge database’s tables and fields in Results.
- Control of end-user access to an OpenEdge database records in Results queries.
- Custom access to Results queries for end users.

Programmers can override the default processing at an integration point by associating an integration procedure with the integration point.
Results engine

The Results engine supports the integration, execution, and management of features and integration procedures.

Most programming and administrative tasks focus on features, integration procedures, data access, and interface customization. Results provides several standard features that perform programming and administration tasks, such as:

- Selecting product graphics, icons, and titles for user sites.
- Controlling access to features and data on a site or user basis.
- Configuring the product menu system and toolbar.
- Customizing export formats, report page sizes, label formats, and default label generation behavior for user sites.

The Query→Site Admin and Query→Customize menus provide access to these standard administrative and programming features in Results. This guide documents the options on these menus and the conceptual information required to use them effectively.

Results development and administration

This guide is for the Results programmer and the site administrator. It is important to understand that these two roles are very different and require different skill sets. The roles are:

- **Results programmer** — A Results programmer is a programmer who customizes Results for an end-user site.

- **Site administrator** — A Results site administrator is a system administrator at an end-user site who is responsible for maintaining Results and supporting end users.
Table 1–1 identifies the Results menu system as it is designed to specifically address these two audiences. This table also notes where additional, related information is located in this guide.

### Table 1–1: Results menu system

<table>
<thead>
<tr>
<th>This menu option...</th>
<th>Provides access to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query → Site Admin</td>
<td>Features that support the administrative role.</td>
</tr>
<tr>
<td></td>
<td>Chapter 2, “Administering Results,” describes</td>
</tr>
<tr>
<td></td>
<td>• The Query → Site Admin menu option.</td>
</tr>
<tr>
<td></td>
<td>• How to set up and manage users.</td>
</tr>
<tr>
<td></td>
<td>• How to set up application and OpenEdge RDBMS security.</td>
</tr>
<tr>
<td></td>
<td>• How to define site defaults.</td>
</tr>
<tr>
<td>Query → Customize</td>
<td>Features that support the programming role.</td>
</tr>
<tr>
<td></td>
<td>Chapter 3, “Programming Results,” describes</td>
</tr>
<tr>
<td></td>
<td>• The Query → Customize menu option.</td>
</tr>
<tr>
<td></td>
<td>• How to customize Results.</td>
</tr>
</tbody>
</table>

**Note:** Chapter 4, “Deploying Results Applications,” provides information about how to distribute a Results application.

### Understanding the relationship between roles

Along with understanding the programming and administrative roles, it is important to understand the relationship between them. For example, the Results programmer must understand the administration requirements of a Results application and then customize Results to support those requirements. While the programmer might decide to deny all users access to the Customize menu in the user environment, the programmer might grant only the site administrator access to all or a portion of the Site Administration menu. For this reason, Results developers should read Chapter 2, “Administering Results,” before customizing Results. By understanding the general Results administration requirements, the developer will be able to address the needs of one of the most important users at the end-user site—the site administrator.
Starting and stopping Results

Regardless of whether you are a Results programmer or a site administrator, it is important for you to understand how to start Results. This section briefly documents the various ways to start Results and access application OpenEdge databases. For more information about starting and stopping Progress sessions and OpenEdge database servers, see the *OpenEdge Getting Started: Installation and Configuration*.

Using the startup commands

To start Results, use one of the following startup commands:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows(^1)</td>
<td><code>prowin dbspec [dbspec] ... -p results.p [parameters]</code></td>
</tr>
</tbody>
</table>

\(^1\) Modify the Client icon properties to use this command.

If you do not specify an OpenEdge database on the command line, Results prompts you to connect to at least one database at startup time. The `dbname` parameter represents the name of an OpenEdge database. All of the startup commands allow you to establish both single-user and multi-user connections to OpenEdge databases. OpenEdge connects to the first OpenEdge database specified after the `prowin` command as a single-user OpenEdge database and connects to the first OpenEdge database specified after the `mprowin` command and the `_prowin` executable as a multi-user OpenEdge database.

The Startup Procedure (-p) parameter specifies the main Progress 4GL procedure for the session. The startup procedure for Results is `results.p` located in the Results product directory. The Results product directory must be located in the `PROPATH`. The `parameters` argument represents any other startup parameter required to configure the current Progress session to meet your needs.
You can specify multiple OpenEdge RDBMS connections with each of the startup commands. The `dbspec` parameter represents an OpenEdge database connection specification with the following syntax:

```
-dbspec [dbname [options]]
```

The Physical Database Name (`-db`) parameter allows you to specify the physical name of an OpenEdge database to connect. All OpenEdge databases specified after the first database in a startup command connect as multi-user databases, regardless of the startup command. The Single-user Mode (`-1`) parameter designates a single-user database connection. You can also specify parameters that describe how Progress connects to a database (for example, identification of the host and server name of a multi-user database on a network).

**Note:** For Results, the recommended setting for the Maximum Memory (`-mmax`) parameter is 4000.

For more information about the startup parameters referenced in this section, see the OpenEdge Deployment: Startup Command and Parameter Reference.

## Starting a server for an OpenEdge database

Before you can establish a multi-user connection to an OpenEdge database, you must start a server for that database. Use one of the following commands to start an OpenEdge server for an OpenEdge database:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character</td>
<td><code>proserve dbname [parameters]</code></td>
</tr>
<tr>
<td>Windows¹</td>
<td><code>wproserve [dbname] -N DDE [parameters]</code></td>
</tr>
</tbody>
</table>

1. Modify the Server Shutdown icon properties to use this command. This command starts an interactive server shell for an OpenEdge database. The server is not a high-performance server and is provided to facilitate testing of multi-user OpenEdge applications in Windows.
As with the startup commands, these server startup commands can also take additional parameters that configure the OpenEdge database server to meet your needs.

Once you start a server process for an OpenEdge database, you cannot establish a single-user connection to that database until you shut down the server. Use one of the following commands to shut down an OpenEdge database server.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character mode</td>
<td>proshut dbname [ -by</td>
</tr>
<tr>
<td></td>
<td>-bn</td>
</tr>
<tr>
<td></td>
<td>-H host-name</td>
</tr>
<tr>
<td></td>
<td>-S server-name</td>
</tr>
<tr>
<td></td>
<td>-F ] ...</td>
</tr>
<tr>
<td>Windows¹</td>
<td>wproshut [ dbname ][ parameters ]</td>
</tr>
</tbody>
</table>

¹ Modify the OpenEdge Server Shutdown icon properties to use this command. This command displays a dialog box that allows you to specify how you want to shut down a specified OpenEdge database.

For more information about startup commands, parameters, and OpenEdge RDBMS connections, see the OpenEdge Getting Started: Installation and Configuration.. For more information about OpenEdge RDBMS servers, see the OpenEdge Data Management: Database Administration.
This chapter describes system administration tools and procedures you can use after a Results application has been deployed at an end-user site. This chapter presents:

- Before you begin
- The Results Site Admin menu
- Results and application databases
- User management
- Site security administration
- Site defaults
Before you begin

The information in this chapter is targeted primarily for site administrators; however, programmers who develop and deploy Results applications should also read this chapter. Much of the information presented in this chapter is important for both audiences.

Feature prerequisites

This chapter assumes that site administrators have full access to the Site Admin menu of a deployed Results application. Access to this menu in a deployed Results application is determined by the programmer who developed, configured, and deployed the application. See Chapter 3, “Programming Results” for information about how to develop a Results application.

The Results Site Admin menu

Most site administration tasks in Results are performed using the Site Admin menu.

To access the Site Admin menu, choose Query → Site Admin. The Site Admin menu options appear:

![Site Admin Menu](image)

The remaining sections in this chapter describe how to use the Site Admin menu options to administer a Results application.
Results and application databases

Since Results is a configurable end-user query and reporting tool, it is important for administrators to understand how it relates to application databases. In particular, site administrators must understand the following concepts:

- Results database configuration files.
- Database tables and table aliases.
- Database table relationships.
- Database schema changes.

This section of the chapter provides information about these concepts and relationships to help site administrators manage the coexistence of Results with application databases.

Database configuration files

When you first run Results against a database, the following message appears:

In this message, sports is the name of the database you are using to start Results. If you are starting Results with more than one database, only the name of the first database connected will appear in this dialog box.

Initial build and the query configuration files

The initial build creates a file called dbname.qc7, where dbname is the unique name of the you are using to start Results. This file is called the query configuration file (QC7 file), and it contains the Results default settings for table relationships, security settings, label formats, export formats, and page formats. All the users who use Results with the specified database access this file. Results cannot run without the QC7 file. Therefore, if you are running Results for the first time against a new database or group of databases, Results must perform the initial build to create this file.
The QC7 file is named for the first database connected; therefore, the order in which you connect databases when you start Results is important. For example, if you perform an initial build on the databases db1 and db2 (in that order), the QC7 file for these databases together is called db1.qc7. If you start Results with db2 and db1 (in that order), Progress returns a message that the db2.qc7 file was not found. If you start Results with only the db1 database, a message states that the database configuration has changed and requests you to rebuild the query configuration file.

**Note:** You can start Results with more databases than you used to build the QC7 file. However, the menu option Query → Site Admin → Application Rebuild causes Results to rewrite the entire QC7 file. When Results rewrites a QC7 file, it uses information from all connected databases.

### Location of the QC7 file

Results attempts to create the QC7 file in the same directory that contains the database (dbname.db). However, if the database is on another machine, and Results cannot locate that directory, Results places the QC7 file in the current working directory. Once Results creates a QC7 file, you can move it anywhere in your PROPATH.

When you start Results, it looks for the QC7 file in the current working directory. If it cannot find it there, it looks in the PROPATH. For more information about PROPATH, see *OpenEdge Getting Started: Installation and Configuration*.

### Query configuration log file

During the initial build and subsequent rewrites of a query configuration file, Results logs information in a query configuration log file (QL file). The name of the query configuration log file is dbname.q1, where dbname is the name of the first database connected for the session. The information in the query configuration log file can consist of compiler error messages and compilation times. Results creates the QL file in the same directory as the QC7 file.

Results continues to write to the QL file associated with a QC7 file for the life of the QC7 file. If the QL file becomes too large, simply delete the file. Results automatically creates a new QL file.
Results.l file and initial builds

Default information for a Results site is stored in the results.l file located in the aderes directory in the OpenEdge product directory ($DLC\GUI). The results.l file is an ASCII file that contains the following default settings:

- Delimiter characters used in report and label format displays.
- Definitions for the standard export formats, label sizes, and page sizes available for use within Results.
- Definitions for the default report format.

Results incorporates the contents of the results.l file into a QC7 file during initial build of the QC7 file. Subsequent rewrites of the QC7 file do not access the results.l file.

You can configure your default site settings by editing the contents of the results.l file prior to performing an initial build. Create a backup copy of the results.l file prior to editing it.

Note: If you introduce errors into the results.l file, you might encounter problems during the initial build of a QC7 file.

See Appendix C, “Results Files,” for information about the contents of the results.l file.

After the initial build

After the initial build, you can use the menu options Query→ Site Admin and Query→ Customize to override the default environment settings and customize Results for your own site. Most of these menu options edit the content of the current QC7 file.

The remainder of this chapter describes how you can customize Results for your site using the Site Admin menu. See Chapter 3, “Programming Results,” for information about how you can extend and configure Results using the Customize menu.
Table aliases

A table alias is another name for an existing table in a Results database. Table aliases allow you to perform self-join operations. A self-join is when you join a table to itself. For example, the demonstration sports database contains an Item table. Each record in the Item table describes a particular product in a warehouse. You can define an additional field in the Item table to store the item number of a substitute for each item. Once you create the preconditions for the self-join in the schema, you can establish an alias in Results for the Item table called Sub-Item and then join Items with Sub-Items in a Results query.

To display the Table Alias dialog box and define an alias for a table, choose Query→Site Admin→Table Aliases. The Table Alias dialog box appears:

![Table Alias dialog box]

The Table Alias dialog box contains the following user-interface elements:

**Name**

Specifies the alias for the selected table.

**Tables**

Lists the names of all tables available to your user ID in Results from the connected databases.

**Aliases**

Lists the names of existing aliases. When you select an alias from the list, Results highlights the associated table.
Relationship buttons

The Table Alias dialog box contains these buttons and check boxes that perform the actions specified:

- **Add** — Adds the specified alias in the Name field to the Aliases selection list.
- **Remove** — Removes the currently selected alias.
- **Relate Alias to Table** — Specifies whether to create a self-join relationship between the alias and the selected table. This option is activated by default.
- **Copy Relationships** — Specifies whether the existing table relationships of the selected table also become the defined relationships for the alias. This option is activated by default.

To create a new alias for a table:

1. Type the name of a new alias in the Name field. The alias name must be unique among all table names and other alias names.
2. Select a table from the Tables list to associate with the new alias.
3. As necessary, deselect the Relate Alias to Table toggle box. This option is selected by default.
4. If desired, deselect the Copy Relationships toggle box. This option is selected by default.
5. Choose Add to create the alias. The new alias appears in the Aliases list.

Results stores alias definitions in the current QC7 file when you choose OK and close the Table Alias dialog box.

**Note:** You can create several aliases for a single table, but you cannot create an alias for an alias.

Once you define an alias for a table, the alias appears as a table in every table listing in Results, and you can create queries that use the alias.
To restrict user access to the alias, choose **Query → Site Admin → Table Data Selection**.

If you remove an alias that is used in a query, the query will no longer work. If you delete a table, all associated aliases are also deleted. For more information about restricting user access to tables and aliases, see the “Table data selection” section on page 2–24.

**Table relationships and multi-table queries**

To build a query that contains information from two or more tables, Results must have a description of how the tables used in the query relate to each other. During the initial build process, Results analyzes the connected databases and defines a default set of relationships between tables in the connected databases.

A default relationship between two tables is based on the following conditions:

- A field with the same name and data type specification exists in the two tables.
- The field is defined as the only component or the leading component of a unique index in at least one of the tables.

Results stores the default table relationships in the QC7 file following the initial build process.

Default table relationships in Results are called *OF relationships* in the Progress 4GL. Two tables that meet the conditions stated above can be programmatically joined using the OF option in a Record phrase in a Progress 4GL statement that reads database records. For more information about record access and the Progress 4GL, see the *OpenEdge Getting Started: ABL Essentials*. 
To display the **Table Relationships** dialog box where you can view and edit relationships in Results, choose **Query → Site Admin → Table Relationships**. The **Table Relationships** dialog box appears:

The **Table Relationships** dialog box contains the following user-interface elements:

**Base table**

Lists the names of all tables available to your Results user ID from the connected databases. Select a table from this list to access information about the relationships defined for the table in Results.

**Available to be related**

Lists all the tables available to you in Results that are not related to the current base table. Initially, these are the tables that do not meet the OF requirements.

**Related tables**

Lists all the tables available that are related to the current base table.
**Relationship buttons**

These buttons and display area perform the following actions:

- **Add** — Adds an unrelated table to the list of related tables. If Results cannot form a default relationship between the base table and the selected table, it prompts you to define a relationship.

- **Remove** — Deletes a highlighted table from the list of related tables. During this process, Results deletes the relationship between the highlighted table and the base table, and places the highlighted table to the list of unrelated tables.

- **Edit** — Edits the existing relationship between the current base table and a highlighted table in the list of related tables.

- **Relationship** — Displays the Progress 4GL syntax of the Record phrase that forms the current table relationship. When you highlight a table from the list of related tables, the syntax for the relationship between the current base table and the highlighted table appears. For more information, see the *OpenEdge Development: ABL Reference*.

The **OK** button confirms all modifications made in the **Table Relationships** dialog box and writes the modifications to the current QC7 file. The **Cancel** button cancels all modifications made and exits the **Table Relationships** dialog box.

The default table relationships that Results creates during the initial build process should provide a strong foundation for most multi-table queries. However, you might want to customize the table relationships available to your users. The **Table Relationships** dialog box also allows you to:

- Create new table relationships that do not adhere to the definition of a default table relationship in Results.

- Delete certain default table relationships that provide inappropriate access to sensitive information.

- Redefine certain default table relationships that specify selection criteria or prohibit access to sensitive information.

**Note:** If you change or delete a table relationship, saved queries that depend on that relationship become invalid and no longer function.
Choose **Query → Site Admin → Application Rebuild** to rebuild existing Results queries based on modifications to the table relationships. This option also produces information about any existing Results queries that cannot be rebuilt as a result of modifications to table relationships. See the “Database schema changes” section on page 2–15 for more information about rebuilding Results queries.

The remainder of this section describes how to use the **Table Relationships** dialog box to create, edit, and delete table relationships.

**Creating a table relationship**

You can use the **Table Relationship** dialog box to create a new table relationship.

To create a new table relationship in Results:

1. Select a base table for the new relationship. The **Table Relationships** dialog box displays the current relationship information for that table.

2. Select a table from the list of unrelated tables.

3. Choose **Add**. Results attempts to form a default relationship between the base table and the selected unrelated table.

   If Results cannot form a default relationship between the two tables, the **Join Construction** dialog box appears to help you define the relationship. See the “The Join Construction dialog box” section on page 2–13 for information about defining a table relationship using the **Join Construction** dialog box.

   When you finish building the relationship using the **Join Construction** dialog box and return to the **Table Relationships** dialog box, the previously unrelated table appears in the list of related tables and the syntax of the new relationship appears in the **Relationship** field.

4. Choose **OK** in the **Table Relationships** dialog box to write the table relationship to the current QC7 file.
Editing a table relationship

You can also use the Table Relationship dialog box to edit a table relationship.

To edit an existing table relationship in Results:

1. Select a base table.
2. Select a table from the list of related tables.
3. Choose Edit.

   The Join Construction dialog box appears. Use it to redefine the relationship between the current base table and the selected related table. See the “The Join Construction dialog box” section on page 2–13 for information about defining a table relationship.

   When you finish redefining the relationship and return to the Table Relationships dialog box, the syntax of the new relationship appears in the Relationship field.

4. Choose OK in the Table Relationships dialog box to write the table relationship modifications to the current QC7 file.
The Join Construction dialog box

The **Join Construction** dialog box allows you to build an expression that relates a base table to a second table. The expression that you build with the **Join Construction** dialog box is called a *WHERE* clause in the Progress 4GL. Regardless of whether you are adding a relationship or editing a relationship, the **Join Construction** dialog box is the only tool that supports these tasks.

You can only access the **Join Construction** dialog box from the **Table Relationships** dialog box as described in the “Editing a table relationship” section on page 2–12. The **Join Construction** dialog box appears as shown in Figure 2–1.

**Figure 2–1:** Join Construction dialog box

The **Join Construction** dialog box contains the following user-interface elements:

**Join**

Displays the current relationship. If you add a new relationship, the **Join** field displays the beginning of a *WHERE* clause that will eventually build a table relationship. If you edit an existing relationship, the **Join** field displays the relationship. If the existing relationship is an OF relationship, the **Customize Join** toggle box appears next to the **Join** field. You must activate **Customize Join** before you edit an OF relationship between two tables. Editing an OF relationship in the **Join Construction** dialog box changes the relationship to a *WHERE* relationship.
Second table
Display the fields of the second table.

Base table
Display the fields of the base table.

Operator buttons
Comparison operators that you can use to build an expression between a field in the second table and a field in the base table. The **AND** and **OR** buttons represent logical operators that allow you to build compound expressions.

Join criteria
Specifies the syntax that forms the **WHERE** relationship between the base and second tables.
The **WHERE** clause shows how a customer table can be related to an order table:

```
WHERE sports.customer.Cust-num = sports.order.Cust-num
```

For more information about the **WHERE** clause, see the **FOR** statement reference entry in the *OpenEdge Development: ABL Reference*.

Building a table relationship
Use the **Join Construction** dialog box to define a relationship between two tables in Results.

To define a relationship between two tables in Results:

1. Select the **Customize Join** toggle box if it is displayed in the **Join Construction** dialog box.
2. Double-click a field from the second table. As you build the expression, the syntax of the expression appears in the **Join Criteria** area.
3. Choose a comparison operator button.
4. Double-click a field from the base table.
5. If you want to build a more complex relationship, choose either the AND or OR operator button and return to Step 1.

6. To save the current WHERE relationship and return to the Table Relationships dialog box, choose OK in the Join Construction dialog box.

Deleting a table relationship

Use the Table Relationships dialog box to delete an existing table relationship.

To delete an existing table relationship from Results:

1. Select a base table.
2. Select a table from the list of related tables.
3. Choose Remove.
4. Choose OK from the Table Relationships dialog box to write the table relationship modifications to the current QC7 file.

Database schema changes

Database schema changes, such as creating, modifying, or deleting a field, index, or table, can break existing Results queries. Field and table additions and deletions in an application database automatically register in the field and table listings in Results. However, schema modifications do not automatically register in the table relationships maintained in the current QC7 file, or in any existing queries based on those relationships.

To rebuild table relationships and regenerate existing queries based on those relationships:

1. Choose Query→ Site Admin→ Application Rebuild. The Application Rebuild dialog box appears:
The **Application Rebuild** dialog box lets you rebuild both the table relationships and existing queries, or just the table relationships.

2. To start the rebuild process, select one of the rebuild options, then choose **OK**.

If you choose to rebuild both the table relationships and existing queries, Results displays the **Select Query Directory** dialog box, which allows you to select the directory of queries you want to rebuild:

3. Select the queries you want to rebuild, then choose **OK**.

4. When there are no more query directories to rebuild, choose **Cancel** to end the rebuild operation.

During the rebuild operation, Results writes any problems encountered during the build process to the QL file associated with the current QC7 file. Use this information to identify problem queries that could not be rebuilt by Results. See the **“Database configuration files”** section on page 2–3 for more information about QC7 and QL files.
User management

User IDs let you manage user activities and provide services to users in Results. A user ID is a unique identifier assigned to a system user when the user logs onto the system. Most user IDs have an associated password.

Results uses user IDs to create and maintain query directories that store information about the queries that a user creates in Results. The following sections describe user IDs and how Results uses them to create and maintain query directories.

User IDs

User IDs can originate from a variety of sources. Many operating systems support and establish user IDs for system users. On most operating systems, Results can use the operating system user ID as an identifier for a Results user. For more information about user IDs, consult the system administration documentation for your operating system.

To create portable user IDs and passwords in a database, choose Admin→Security→Edit User List in the Data Administration tool.

A user ID for a user overrides any existing operating system user ID for the user. The user ID definitions must exist in the first database connected for an OpenEdge session. Once an OpenEdge database contains a user definition, an application cannot connect to the database without specifying a valid user ID and password combination. By default, Progress prompts for a valid user ID and password when Results connects to a database that contains user definitions.

There are several other ways to specify a valid user ID and password combination when you connect to a database. See OpenEdge Getting Started: ABL Essentials and OpenEdge Getting Started: Installation and Configuration for more information about user IDs and database connections.

If you are using an operating system that does not support user IDs and there are no defined OpenEdge users in the connected OpenEdge databases, your Results user ID is the blank user ID. As with any other user ID in Results, you can use feature security to restrict the access of the blank user ID to Results functionality.
Query directories

A query directory is a file that contains up to 256 query definitions for use by one or more Results users. A query definition consists of the query name and the name of the databases accessed by the query. All query directory files (QD7 files) have a QD7 file extension.

Results automatically creates a query directory for each user. The QD7 file for a user stores the queries created by that user. Results creates a QD7 file for a user when the user starts Results and there is no QD7 file for that user available in the results.l or current working directory. The user query directory files are for only one user; they are not multi-user files. The name of a QD7 file for a user takes the form userid.qd7. For users who log into Results as the blank user ID, Results creates a generic QD7 file called results.qd7. See the “User IDs” section on page 2–17 for more information about user IDs.

The public QD7 file serves as a storage place for queries shared by a number of Results users. The name of the public query directory is public.qd7, and this name is stored in the current QC7 file associated with the primary application database. There can be only one public QD7 file per QC7 file.

By default, Results creates the public QD7 files in the current working directory. Once Results creates a QD7 file, you can move it anywhere in the results.l.

Results works with one query directory file at a time. When the user chooses Query→Save, Results writes the current query to the current QD7 file. A user can open a query from another query directory by choosing Query→Open or save the current query into another query directory by choosing Query→Save As. These operations close a previously active query directory and make the query directory specified in the operation the current query directory in Results.

You can control access to the public query directory and other user query directories by setting feature security permissions on the ReadPublicDirectory, ReadOtherDirectory, WritePublicDirectory, and WriteOtherDirectory features. See the “Query directory security” section on page 2–22 for more information about restricting access to user query directories.
Site security administration

Results supports the following types of security:

- **Application security**
- **Data security**

The following sections define the concepts and introduce the tools required to configure application and data security settings in Results to meet site requirements. Chapter 3, “Programming Results,” contains information about integrating your own application and data security regimes into Results.

Application security

Application security restricts access to functional units in the Results application and application resources. You can control user access to applications in two ways:

- **Feature security**
- **Query directory security**

By default, all users can access and use all Results features and can read queries from and write queries to any other query directory or public query directory. However, Results allows you to determine access to features by user ID, and you can protect query directories using Results features.

*Features* are functional units in Results that you decide whether to make available to users. Most features are attached to menu options or buttons on the tool bar. See Appendix A, “Results Features,” for information about the standard features supplied with the Results product. See the “User IDs” section on page 2–17 for information about users and user IDs.
Feature security

The Results security mechanism reconfigures the application interface for each user based upon that user’s permissions. The interface reconfiguration occurs when the user starts Results. When the user does not have permission to use a feature, Results configures the application interface for the user in the following manner:

- Any menu option associated with the feature is removed from the menu bar at Results startup.
- Any icon on the toolbar associated with the feature is removed from the toolbar at Results startup.
- The feature does not appear in any feature listings in the Results product.

Results stores the user permissions for all features in the current QC7 file.

To access and change the user permissions for a feature, choose Query→Site Admin→Feature Security. The Feature Security dialog box appears:

The features in the Features selection list are either Results core features or add-on features created by your organization or a third party. See Appendix A, “Results Features,” for more information about a particular feature in Results.
To set user permissions for a feature, select a feature in the **Features** selection list, then edit the setting that appears in the **User List**.

A *user list* is a comma-separated list of the user ID specifications. A *user ID specification* is a string expression that specifies one user ID or a group of user IDs.

**Note:** You must define feature for security for all the features. You cannot define one feature and use the defaults for the others.

Table 2–1 shows the forms of a user ID specification.

**Table 2–1: User ID specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>All users can execute the feature.</td>
</tr>
<tr>
<td>userid</td>
<td>A specified user can execute the feature.</td>
</tr>
<tr>
<td>!userid</td>
<td>A specified user cannot execute the feature.</td>
</tr>
<tr>
<td>string*</td>
<td>User IDs that begin with <em>string</em> can execute the feature.</td>
</tr>
<tr>
<td>!string*</td>
<td>User IDs that begin with <em>string</em> cannot execute the feature.</td>
</tr>
</tbody>
</table>
If the user list for a feature contains multiple user ID specifications, you must separate the user ID specifications with commas. Do not insert blanks between the user ID specifications. Table 2–2 provides some examples of user ID specifications in a user list.

Table 2–2: User list examples

<table>
<thead>
<tr>
<th>User list example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fred,ida,wilma,delmer</td>
<td>Only fred, ida, wilma, and delmer can execute the feature.</td>
</tr>
<tr>
<td>!per,!jan,*</td>
<td>Users per and jan cannot execute the feature. Everyone else can.</td>
</tr>
<tr>
<td>doc*,dev*</td>
<td>Only user IDs that begin with the strings doc and dev can execute the feature.</td>
</tr>
<tr>
<td>!mark*,!acct*,*</td>
<td>User IDs that begin with the strings mark and acct cannot execute the feature. Everyone else can.</td>
</tr>
</tbody>
</table>

**Note:** The second and fourth user list examples in Table 2–2 show how to exclude certain users from accessing a feature. It is important to note that the trailing asterisk (*) in both examples allows all other users to access the feature. If you do not specify the trailing asterisk, then no user will be able to access the feature.

When you finish assigning user lists for features, choose **OK** to write the feature security settings to the current QC7 file and exit the Feature Security dialog box.

**Query directory security**

By default, all users can read queries from and write queries to another user’s query directory or the public query directory. Results provides several features that allow you to determine user access to query directories using these menu options: **Query → Open**, **Query → Save**, and **Query → Save As**. These features are: ReadOtherDirectory, ReadPublicDirectory, WriteOtherDirectory, and WritePublicDirectory.

**Note:** Results security does not override any operating system permissions for the query directories.

Use the Feature security capability to set user permissions for these features and secure user access to query directories. See the previous section, “Feature security” section on page 2–20 for more information about how to set user permissions for a feature.
Data security

Data security restricts access to data in a connected database to prevent disclosure of sensitive information and to preserve data integrity. There are several security mechanisms to create and enforce data security for an application database. This section describes three types of data security:

- OpenEdge data security
- Table data selection
- Data security features

The OpenEdge data security applies automatically to Results. Site administrators can add their own security on top of OpenEdge—and Results—security using these options: Query → Table Data Selection and Query → Feature Security.

Programmers can also set up their own security systems specifically for Results using integration points and procedures. See Chapter 3, “Programming Results,” for more information about integration points and procedures in Results.

OpenEdge data security

You can limit compile-time access to tables and fields in a database by user ID. All applications that access an application database, including Results, are governed by the compile-time user access permissions stored in the database. If the users do not have write access to a table or a field in an application database at compile time, they can build queries using the table or field in Results, but cannot manipulate the data in the table or field using the form view of a Results query. If users do not have read access to a table or a field in an application database at compile time, that table or field does not appear in their database table or field listings. Also, the users cannot access a Results query that accesses the table or field.

To set access permissions for the tables and fields of a database, access the Data Administration tool, then choose Admin → Security → Edit Data Security. These user access permissions for tables and fields are stored as part of the schema in the application database.

For a complete description of data security and security tools, see OpenEdge Data Management: Database Administration, OpenEdge Deployment: Managing ABL Applications, and OpenEdge Getting Started: ABL Essentials.
Table data selection

By default, if users have access to a table, they have access to all records in that table. Site administrators can define selection criteria for a table that functions as a security mechanism to limit access to sensitive data in the table on a record-by-record basis. The selection criteria is an expression that determines the records that a query returns from a table.

The Table Data Selection option allows administrators with the ability to define security selection criteria for a table. The selection criteria defined for a table executes as part of all queries that access the table, regardless of user ID.

To display the Table Data Selection dialog box, choose Query→Site Admin→Table Data Selection. The Table Data Selection dialog box appears:

![Table Data Selection dialog box](image)

Use the Table Data Selection dialog box to build selection criteria for a table.

The Table Data Selection dialog box contains the following user-interface elements:

**Base table**

Specifies the current table for the definition of selection criteria. When you select a table from this list, any associated selection criteria expression appears in the Data Selection field. By default, tables do not have associated selection criteria expressions.

**Data selection**

Specifies an expression that limits the display of records from the current base table. By default, tables do not have selection criteria in Results.
To define or redefine the selection criteria associated with the current base table, choose **Edit**. The **Data Selection** dialog box appears:

The **Data Selection** dialog box contains the following information and functionality:

**Base table**

Identifies the base table for which you are defining selection criteria.

**Base table fields**

Lists the fields in the base table.

**Operator buttons**

**Selection criteria**
Operator buttons

Comparison operators that you can use to build an expression for a selected field in the current base table. The operator buttons become sensitive based on the data type of the selected field. Several of these operator buttons, such as Begins and Contains, allow you to build specialized search criteria as defined in Table 2–3.

Table 2–3: Operator buttons

<table>
<thead>
<tr>
<th>Operator button</th>
<th>Search criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins</td>
<td>Specifies a search string to match to the beginning of values in the current base field.</td>
</tr>
<tr>
<td>Contains</td>
<td>Specifies a text search expression to locate in the text of the current base field. The current base field must be defined as a word index. The text search expression has the following syntax:</td>
</tr>
</tbody>
</table>

Review the following syntax:

Syntax

\[
\text{word} [ \& | \| | ! | ^ ] \text{word} \ldots
\]

A word is a template string as defined previously for the Matches comparison operator. The ampersand (&) represents a logical AND; a vertical line (|), exclamation point (!), or caret (^) represents a logical OR. These logical operators allow you to build complex text search expressions.

Matches

Specifies a template string to compare against values in the current base field. The template string can be a complete value or a partial value with embedded wildcard characters. A period (.) in a particular position in a string indicates that any single character is acceptable in that position of the string; an asterisk (*) indicates that any group of characters is acceptable, including a null group of characters.

List

Specifies a list of string values to compare with values in the current base field.
Range

Specifies a range of values to compare with values in the current base field.

Ask At Run Time

Controls run-time prompts for key values in the selection criteria. By default, this is not activated and there is no run-time prompt for the selection criteria. When you activate this option, Results requests a prompt string to display in a dialog box prompting for a key value when it executes the current query.

Selection Criteria

Specifies the syntax of the selection criteria expression for the base table.

Check Syntax

Specifies when to check the selection criteria. The Now button specifies to check the syntax immediately; the toggle box indicates to check the syntax when you choose OK. By default, Results checks the syntax when you choose OK.

Refer to the following procedure to define selection criteria for a table using the Data Selection dialog box.

To define selection criteria for a table:

1. Select a field from the table. As you build the selection criteria expression, the syntax of the expression appears in the Selection Criteria panel.

2. If you want Results to prompt the user for a value for the specified field at run time, select the Ask At Run Time toggle box.

3. Choose a comparison operator button. If Ask At Run Time is not selected, Results prompts for values to form the rest of the expression.

4. To save the selection criteria for the current base table and return to the Table Data Selection dialog box, choose OK in the Data Selection dialog box.

5. Choose OK in the Table Data Selection dialog box to write the selection criteria associated with each table to the current QC7 file.
Data security features

By default, all users can add, update, and delete records from a table using a Results query in the form view. Results provides several features that allow you to regulate which users can perform these data manipulation activities. These features are RecordAdd, RecordDelete, and RecordUpdate. Use the Feature Security option to set user permissions for these features and to determine which users can manipulate a database using the form view of a Results query.

See the “Feature security” section on page 2–20 for more information about how to set user permissions for a feature.

Site defaults

The Site Admin menu provides access to several tools that allow administrators to configure default formats and behaviors used in the creation of query views. These tools allow you to configure the following defaults:

- Standard page sizes
- Standard export formats
- Standard label sizes
- Label Field Selection defaults

The following sections discuss how to configure these defaults for a Results application.
Standard page sizes

The results.1 file contains definitions for standard page sizes that you can use in report views. During the initial build process, the contents of the results.1 file is used to create the current QC7 file.

To view and delete paper sizes from the current QC7 file:

1. Choose Query → Site Admin → Standard Page Size. The Standard Page dialog box appears:

```
Standard Page
A3 (29.7 x 42 cm)
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (257 x 170 mm)
Envelope-110 (9 1/2 x 4 1/8 in)
Envelope-C5 (123 x 170 mm)
Envelope-C6 (220 x 155 mm)
Envelope-Monarch (3 1/2 x 7 1/8 in)
Executive (7 1/4 x 10 1/2 in)
```

2. Choose Delete to delete a selected paper size.

3. Choose Reset to restore any page sizes deleted since you opened the dialog box.

4. Choose OK to write the changes to the current QC7 file and exit the dialog box.
Standard export formats

The results.l file contains the definitions for standard export formats that you can use in export views. During the initial build process, Results uses the contents of the results.l file to create the current QC7 file.

To view and delete export formats from the current QC7 file:

1. Choose Query→ Site Admin→ Standard Export. The Standard Export dialog box appears:

2. Choose Delete to delete a selected export type.

3. Choose Reset to restore any export type deleted since you entered the dialog box.

4. Choose OK to write the changes to the current QC7 file and exit the dialog box.
Standard label sizes

The results.1 file contains definitions for standard label sizes that you can use in label views. During the initial build process, the contents of the results.1 file is used to create the current QC7 file.

To view and delete label sizes from the current QC7 file:

1. Choose Query → Site Admin → Standard Label. The Standard Label dialog box appears:

   ![Standard Label dialog box]

2. Choose Delete to delete a selected label type.

3. Choose Reset to restore any label type deleted since you entered the dialog box.

4. Choose OK to write the changes to the current QC7 file and exit the dialog box.
Label Field Selection defaults

When you select the label view for an active query for the first time, you can generate either a default mailing label or a custom mailing label for the query. Figure 2–2 shows the Label Field Selection dialog box you can use for either purpose.

![Label Field Selection dialog box](image)

**Figure 2–2: Label Field Selection dialog box**

The Label Field Selection dialog box displays ten possible label fields for default mailing labels. Most of the label fields contain a comma-separated list of strings used to search for database fields in the tables of the active query and generate the default label view for the query.

**How Results determines values for the label fields**

Results uses the MATCHES function to match a database field name from a table in the active query to a label field. Each string listed in a label field represents a complete field name or a partial field name with wildcard characters. A period (.) in a string indicates that any single character is acceptable in that position; an asterisk (*) indicates that any group of characters is acceptable, including a null group of characters. See the “Label field considerations” section on page 2–33 for more information about how Results generates labels for queries.
Label field considerations

Before you alter the label selection information in the Label Field Selection dialog box, you must understand how Results generates default labels for queries:

- The order of field names or partial field names specified for a label address field is important. Results attempts to find a matching database field for a label address field starting with the first string specified in the list associated with the label address field and ending with the last string in the list.

- Precedence relationships between label address fields determine the default label layout associated with a query. A database field match with the Postal Code label address field suppresses the display of a database field that matches the Postal Code+4 label address field. A database field match with the City, State, Postal Code, or Postal Code+4 label address field suppresses the display of a database field that matches City+State+Zip label address field.

- For queries based on multiple tables, Results searches for database fields for the default label starting with the last table specified in the query and ending with the first table specified.

Based on this information, you can set up your own label selection parameters that determine how Results generates default labels for your users. However, Results always builds the labels in the format used in the United States.
To display and edit the parameters that Results uses to generate a default mailing label for a query:

1. Choose **Query→Site Admin→Label Field Selection.** The Label Field Selection dialog box appears:

![Label Field Selection dialog box](image)

2. Set up your own label selection parameters that determine how Results generates default labels for your users.

3. Choose **OK** to write the changes to the current QC7 file and exit the dialog box.
Programming Results

The information in this chapter is for programmers who want to customize Results for distribution in an end-user environment. This chapter presents:

- Before you begin
- Results architecture and application development
- Application configuration
- Integration points and procedures
- Features
- Results application programming interface (API)
- Output solutions in Results
- Export solutions in Results
- Results main application procedure
- Code generation
Before you begin

This chapter describes the concepts, tools, and programming techniques required to customize and extend Results. When you finish reading this chapter, revisit Chapter 2, “Administering Results,” to assess the administration requirements of your extensions.

Results architecture and application development

From a programming perspective, an understanding of the open and flexible architecture of Results is crucial for success. Most programming activities in Results center around integration points and features. Figure 3–1 shows these integration points and features.

![Results product architecture diagram]

Figure 3–1: Results product architecture

As previously discussed in Chapter 1, “Results for Administrators and Programmers,” an integration point is a processing point used to initialize or configure Results for security or site requirements. Results performs default processing at these points. You can override the default processing at an integration point by associating an integration procedure with the integration point. An integration procedure is a Progress 4GL procedure and a feature is a functional unit in the Results product. Results comes with a set of predefined features that implement the core functionality of the product. You can define your own features and add them to the Results menu system or toolbar, or call them from another feature.
Basic tasks to develop a Results application

The following steps outline the basic tasks required to develop a Results application:

1. Develop or acquire the application databases.

2. Define the application configuration. The “Application configuration” section on page 3–4 describes how to define an application and configure Results for the development of an application.

3. Develop integration procedures and integrate them into Results. The “Integration points and procedures” section on page 3–9 explains how to customize Results using integration procedures.

4. Develop feature procedures and integrate them into Results. The “Features” section on page 3–12 explains how to use features to extend Results.

5. Perform any necessary predeployment application administration. For example, you can set up users, query directories, and provide security for the Results application. Chapter 2, “Administering Results,” provides more information about the administration tools available in Results.

6. Deploy the application. Chapter 4, “Deploying Results Applications,” explains how to deploy a Results application.
The **Customize** menu is the central user interface for most application development tasks in Results. **Figure 3–2** presents an example of the **Customize** menu.

**Figure 3–2: Customize menu**

To access the Customize menu, choose **Query** → **Customize**.

The following sections describe how to use the **Customize** menu to configure Results and develop a Results application.

**Application configuration**

Once you develop or obtain an application database for your Results application, there are two tasks you must perform to define and configure your Results application.

- **To define and configure your Results application:**
  1. Define the base files for your application in Results. **Base files** are the set of files that define and store configuration information for a Results application.
  2. Customize the Results application.
The following sections provide more information about configuring Results and your application.

**Application base files**

Before you start to develop feature and integration procedures, define a set of base files to store the configuration information for your Results application. The base files of a Results application are:

- **Fastload Files** — A set of Progress 4GL procedure files that optimize loading information from the current QC7 file into Results at startup.

- **Feature File** — A Progress 4GL procedure file that defines and loads features into Results at startup.

- **UI File** — A Progress 4GL procedure file that defines and loads the layout of the menu system and toolbar into Results at startup.

The definition of a set of base files for your application is a key step in managing the development and deployment of a Results application.

To access the **Deployment** dialog box and define base files for an application, choose **Query** → **Customize** → **Deployment**. The **Deployment** dialog box appears:

![Deployment dialog box]

The **Deployment** dialog box contains the following user-interface elements:

**Fastload base**

Specifies a base string so that Results can generate the fastload files associated with the current QC7 file and application. The default base string is the first five characters of the current QC7 file. Each fastload file generated by Results for the current QC7 file and application has a filename that starts with the specified base string and ends with a unique number (for example, `sport##.r`). Limit the base string to five characters. You can specify a pathname with a base string.
Feature file

Enter a filename or choose Files to locate and select an existing feature file.

UI file

Enter a filename or choose Files to locate and select an existing UI file.

You can specify relative or absolute pathnames for the fastload, feature, and UI files. Once Results creates fastload files, you can move them anywhere in PROPATH.

When you start Results, it looks for fastload files in the current working directory. If it cannot find them there, it looks in the directories specified in the PROPATH for the fastload files. For more information about PROPATH, see OpenEdge Getting Started: Installation and Configuration.

Application preferences

You use the Preferences dialog box to define default behaviors.

To display the Preferences dialog box and define default behaviors for your Results application and development environment, choose Query→Customize→Preferences. The Preferences dialog box appears:

The Preferences dialog box contains the following user-interface elements:
Product name

Specifies a string to display in the title bar of the Results application window. This string also is displayed in certain error messages.

Icon

Represents the Results application in the current window system. Choose this icon to view and select a graphics file.

Delimiters

Specifies the left and right delimiter characters that delimit functions in report headers and footers and the fields in address (and other) labels. The curly braces { } are the default delimiter characters, but they are not appropriate defaults in some cases. For example, 7-bit character sets use the curly braces for special characters; in this case, specify angle brackets < > as delimiter characters. Do not specify the same character for the left and right delimiters. You can use square brackets [ ] as long as there are no arrays in your reports or labels. You cannot use parentheses ( ) because they interfere with the label-generation code.

Using the Exit feature

Specifies the exit behavior performed by the Exit feature in the Results application. Table 3–1 identifies and describes the two possible exit behaviors.

Table 3–1: Exit feature options

<table>
<thead>
<tr>
<th>This Exit feature option...</th>
<th>Will...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return from <em>procedure-name</em></td>
<td>Terminate the Results application and returns to the procedure that called the Results application. If you start the session with <em>results.p</em> as the startup procedure, the Progress session terminates. This is the default.</td>
</tr>
<tr>
<td>Quit from <em>procedure-name</em></td>
<td>Terminates the Results application and the current Progress session.</td>
</tr>
</tbody>
</table>
Write configuration

Specifies the configuration Save behavior. The menu options associated with the Site Administration and Customize let you define and modify the configuration information stored in the current QC7 file. This setting allows you to determine when information is written to the current QC7 file Table 3–2 identifies and describes the two possible Save behaviors.

Table 3–2: Write configuration Save options

<table>
<thead>
<tr>
<th>This Write configuration Save option...</th>
<th>Will...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit from Results</td>
<td>Save changes to the current QC7 file when you exit Results. This is the default behavior.</td>
</tr>
<tr>
<td>After each dialog box</td>
<td>Save changes to the current QC7 file when you exit an administration or programming dialog box using the OK button.</td>
</tr>
</tbody>
</table>

When you save the configuration information to the current QC7 file, Results regenerates the fastload files associated with the current QC7 file.

Rebuild check during startup

Specifies for Results to check the database schema against the compiled code at startup.

Display Results in 3D

Specifies to display all Results dialog boxes in 3D.

Setting this configuration information allows you to define the Results configuration for the end-user environment and to simulate that configuration in the development environment.
Integration points and procedures

Integration procedures are modules of the Results engine that let programmers integrate Results into an application or end-user environment. These Progress 4GL procedures execute at key integration points, such as at Results startup or just prior to executing a query. Results performs default processing at certain integration points and no processing at others. You can insert your own integration procedure at an integration point to override default Results processing.

To define an integration procedure for a Results integration point, choose Query → Customize → Integration Procedures. The Integration Procedures dialog box appears:

The Integration Procedures dialog box contains the following user-interface elements:

Integration point

Lists the available integration points. The current integration point is highlighted.

Procedure for

Specifies the Progress 4GL procedure file associated with the current integration point. Choose Files to locate an existing procedure file and associate it with the current integration point.

To remove an integration procedure from an integration point, select an integration point and then clear the associated integration procedure name from the Procedure field.
The key to using integration procedures is understanding when they will execute and what is the default processing at the different integration points. Table 3–3 provides important information about integration points and procedures.

### Table 3–3: Integration points and procedures

<table>
<thead>
<tr>
<th>Integration point</th>
<th>Common use</th>
<th>Execution/ default processing</th>
<th>Example integration procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature security</td>
<td>Prohibits the use of certain Results features by user ID.</td>
<td>Executes once at Results startup. No default processing.</td>
<td>aderes/u-secure.p</td>
</tr>
<tr>
<td>Field security</td>
<td>Prohibits access to sensitive, or available, fields by user ID. You can use this procedure to specify fields that the user cannot access.</td>
<td>Executes once prior to each time Results displays a list of fields for the user to choose from. No default processing.</td>
<td>aderes/u-field.p</td>
</tr>
<tr>
<td>Initialize vars and interface</td>
<td>Initializes new shared variables and other data structures used by features and integration procedures.</td>
<td>Executes once at Results startup. No default processing.</td>
<td>aderes/u-define.p</td>
</tr>
<tr>
<td>Log program</td>
<td>Checks user IDs at Results startup for product security configuration.</td>
<td>Executes once at startup. The aderes/_slogin.p procedure provides the default processing. You cannot edit _slogin.p.</td>
<td>aderes/u-login.p</td>
</tr>
<tr>
<td>Log screen</td>
<td>Defines the graphics used in the Results window.</td>
<td>Executes once at Results startup. The u-logo.p example procedure provides default processing.</td>
<td>aderes/u-logo.p</td>
</tr>
</tbody>
</table>
You can use integration procedures to implement your own data and feature security systems. You can also use integration procedures to instantiate variables and create other preconditions required by features.

The example integration procedure for each integration point documents the parameter definitions and other code structures required at the integration point. The examples can also serve as models for your own integration procedures. For more information about the Results Application Programming Interface, see the “Results application programming interface (API)” section on page 3–24.
Features

Features are the basic units of functionality in Results. While Results supplies a robust set of features, you might want to define your own features to extend the capabilities of Results.

A Results feature consists of two basic components: a feature procedure and definition. A feature procedure is a Progress 4GL procedure that implements the functionality of a feature. A feature definition describes a feature procedure and information about how the feature procedure is integrated into Results.

Developing new features overview

There are four basic steps to develop a new feature in Results:

1. Create a feature procedure. See the “Feature procedures” section on page 3–13 for the basic requirements for a feature procedure.

2. Define the feature in the Results product using the Feature Editor. See the “Feature Editor” section on page 3–15 for information about how to create a feature definition in Results.

3. If necessary, use the Menu Editor to integrate the feature into the Results menu bar. See the “Menu Editor” section on page 3–18 for information about how to integrate a feature into the Results menu system.

4. If necessary, use the Tool Bar Editor to integrate the feature into the Results tool bar. See the “Tool Bar Editor” section on page 3–22 for information about how to integrate a feature into the Results toolbar.

See Appendix A, “Results Features,” for more information about Results features. The “Feature and interface management” section on page 3–24 describes how you can manage the integration of features and interface changes on a product-wide basis.
Feature procedures

Feature procedures are Progress 4GL procedures that meet certain information interface requirements for Results. All feature procedures require a character input parameter and a logical output parameter. Consider the following template for a feature procedure:

```plaintext
/* Template 1 for a RESULTS Feature Procedure */
/* 1 */
DEFINE INPUT PARAMETER args AS CHARACTER NO-UNDO.
/* 2 */
DEFINE OUTPUT PARAMETER winState AS LOGICAL NO-UNDO.
/* Your code here */
```

These notes refer to the commented numbers in the template:

1. Results requires a character input parameter to pass argument values specified in the Argument field of the Feature Editor. All feature procedures must have this input parameter even if you did not specify argument values in the Argument field.

   The Progress 4GL supplies several language elements that allow you to parse strings, parse lists, and convert character values into different data types. For more information about these and other language elements, see the OpenEdge Development: ABL Reference.

2. This logical output parameter determines whether the Results window redisplays when the feature procedure finishes executing. If the feature procedure changes the current query or current view of the query, set the value of this output parameter to TRUE.

You can code feature procedures to perform all types of processing including interactive and noninteractive processing. Results supplies a complete API that you can use within a feature procedure to access and manipulate information. The Results API is based on a set of procedures and shared variables that contain information about the current state of the Results application and the current query in Results. For more information about the Results API see the “Results application programming interface (API)” section on page 3–24.
Feature procedures can manipulate the Results application window, display a dialog box, or display a secondary application window. To implement a feature procedure that displays a second window, use the following technique to manage user focus and multiple windows in Results:

/* Template 2 for a RESULTS Feature Procedure - Multi-windows */

DEFINE INPUT PARAMETER args AS CHARACTER NO-UNDO.
DEFINE OUTPUT PARAMETER winState AS LOGICAL NO-UNDO.

/* 1 */
DEFINE VARIABLE resultsWin AS HANDLE NO-UNDO.
DEFINE VARIABLE newWin AS HANDLE NO-UNDO.

/* 2 */
ASSIGN
  resultsWin = CURRENT-WINDOW

/* 3 */
resultsWin:WINDOW-STATE = WINDOW-MINIMIZED
resultsWin:SENSITIVE = FALSE.
CREATE WINDOW newWin.
CURRENT-WINDOW = newWin.

/* Your code here */

/* 4 */
DELETE WIDGET newWin.

ASSIGN
  CURRENT-WINDOW = resultsWin
  resultsWin:WINDOW-STATE = WINDOW-NORMAL
  resultsWin:SENSITIVE = TRUE.

The commented numbers in the code refer to these notes:

1. Create a variable to hold the widget handle of the Results window.

2. Place the widget handle of the Results window into the new variable. The CURRENT-WINDOW session handle returns the widget handle of the Results window.

3. Minimize the Results window and disable it for user input while the feature procedure displays the second window.

4. Restore the Results window and enable it for user input after the user closes the second window.
See the “Generating new queries” section on page 3–46 for a sample feature procedure. See the OpenEdge Development: ABL Reference for a reference entry for each language element in the Progress 4GL.

**Feature Editor**

The Results Feature Editor allows you to define, modify, and delete features in Results. You use the Feature Editor dialog box to implement the Results Feature Editor.

To access the Feature Editor, Choose Query→Customize→Features. The Feature Editor dialog box appears:

![Feature Editor dialog box](image)

The Feature Editor dialog box contains the following user-interface elements:

**Features**

Lists the programmer-defined features. As you define features, this list grows. Select a feature from this list to establish a current feature that you can copy, modify, or remove.
Feature edit buttons

Allow you to do the following:

- **Add** — Defines a new feature in Results.

- **Remove** — Removes the current feature. You cannot delete a feature from Results if it is associated with a menu option or a toolbar icon. When you remove a feature, the procedure file associated with the feature is **not** deleted from your operating system.

- **Clear** — Clears the values specified in the Feature Editor. This action does not affect the definition of the current feature.

**Name**

Specifies the name of the current feature. You cannot change the name of an existing feature.

**Program**

Specifies the name of a Progress 4GL procedure associated with the current feature. Choose the **Files** button to locate an existing procedure file and associate it with the current feature. The next section provides a general framework for the definition of a feature procedure.

**Argument**

Specifies the argument values to pass to a procedure identified in the **Program** field in comma-separated list.

**Label**

Specifies the default menu label for the current feature. This label appears by default when you add the feature to the Results menu system. You can specify a mnemonic for the label by placing an ampersand (&) before a character within the label.

**Help line**

Specifies a help string to associate with a toolbar representation of the feature. This help string appears at the bottom of the Results application window when the user right-clicks the icon associated with the feature.
Images

Identifies the default graphics files that represent the following icon states for a representation of the feature on the toolbar:

- **Up** — The unselected, sensitive (available) state of the icon.
- **Down** — The selected state of the icon.
- **Ins.** — The unselected, insensitive (unavailable) state of the icon.

To specify a graphics file for an icon state, choose one of these buttons. Results displays a dialog box that allows you to locate and browse graphics files in your operating system, view them, and select one. (In Windows, the graphics file must be a Windows Bitmap (.bmp) or Icon (.ico).)

When you finish defining a feature, you can add it to the Results menu system or toolbar. You can also use the Feature Security option described in Chapter 2, “Administering Results,” to control end-user access to features.
Menu Editor

Results provides a dynamic menu editor that you can use to customize user access to Results and programmer-defined features. Once you define a feature, you can add it to an existing menu.

**Note:** You cannot add a menu to the Results menu system; you can only add a menu option to an existing menu. You cannot delete a main menu (for example, **Query** or **Help**).

To access the **Menu Editor**, choose **Query** → **Customize** → **Menu Layout**. The **Menu Layout** dialog box appears:

![Menu Layout Dialog Box](image)

The **Menu Layout** dialog box contains the following user-interface elements:

**Features**

Lists all the features in Results. When you select a feature, the menu and menu option lists scroll to display an associated menu option and/or menu. If the feature is not in the menu system, you can specify a new label for the feature and add it to the selected menu in the menu list. The first entry in the features list is a horizontal rule that you can add to a menu as a separator.

**Menus**

Lists the menus available in the Results menu system. When you select a menu, the menu options of the selected menu appear in the **menu option** list. You can then select and add a feature to the menu or select and remove a menu option from the selected menu.
Menu items

Lists the menu options available on the selected menu in the menu list. Once you select a menu option, you can use the Remove button to remove it from the selected menu. You can also modify the menu item label.

Menu edit buttons

Allow you to do the following:

- **Add** — Adds a new menu option to the selected menu in the menu list using the feature selected in the features list.
- **Remove** — Deletes the selected menu option from the selected menu in the menu list.

The following section describes how to define menus and implement menu management strategies in Results.

Menu management

Results automatically manages the display state of default menu options and menus in the menu system. In general, there are some default menus and menu options that are sensitive, or available, only when there is an active query in Results. These menus and menu options become insensitive, or unavailable, when the user closes the active query. For example, the Table menu is sensitive only when there is an active query. And while the Query menu is always active by default, there are some menu options on this menu (for example, Save) that are sensitive only when there is an active query.

An understanding of this default menu management behavior in Results is crucial when adding menu options. Before adding menu options to Results, assess the menu management behavior and plan any additions based upon when you want users to access the new menu elements. For example, to add a menu option that is always available to a user, add the menu option to the Query menu.
By default, all menu elements that you add to the menu system are sensitive. You can override the default menu management behavior and also manage the sensitivity of additions to the Results menu system using the **Menu Item Override** integration point. A Progress 4GL procedure attached to this integration point executes once after the execution of any feature in Results. The `u-mcheck.p` procedure located in the `aderes` product directory is the example code template for this integration point:

**Example 3–1** shows this example code template.

### Example 3–1: u-mcheck.p example code template

```plaintext
/* Instructional Comments */
DEFINE INPUT PARAMETER featureList AS CHARACTER NO-UNDO.
DEFINE INPUT-OUTPUT PARAMETER sensitivityList AS CHARACTER NO-UNDO.
DEFINE INPUT-OUTPUT PARAMETER checkList AS CHARACTER NO-UNDO.

/* Your Code Here */

RETURN. /* Required last line */
```

**Menu Item Override integration point parameters**

The following list describes the parameters required by a procedure associated with the **Menu Item Override** integration point. These parameters provide information about all menu options and menus in the Results menu system and buttons on the Results toolbar:

- **featureList**

  This input parameter is a comma-separated list of feature names associated with menu options in the Results menu system and buttons on the Results toolbar.

- **sensitivityList**

  This input-output parameter is a comma-separated list of `TRUE` or `FALSE` values. Each entry in this list represents the current `SENSITIVE` attribute setting for a menu option or button associated with a feature listed in the `featureList` parameter. The order of the sensitivity settings in `sensitivityList` parameter corresponds to the order of features listed in the `featureList` parameter. You can set the state of the `SENSITIVE` attribute for a menu option or button in the integration procedure.
checkList

This input-output parameter is a comma-separated list of TRUE or FALSE values. Each entry in this list represents the current CHECKED attribute setting for a menu option associated with a feature listed in the featureList parameter. The order of the CHECKED settings in checkList parameter corresponds to the order of features listed in the featureList parameter. If the current menu option widget is a toggle menu option, you can set the CHECKED attribute of the widget in the integration procedure.

Consider the following code example that appears in Example 3–2.

**Example 3–2: u-mcheck.p code example**

```abl
/* Example u-mcheck.p */
{aderes/u-pvars.i}

DEFINE INPUT         PARAMETER featureList AS CHARACTER NO-UNDO.
DEFINE INPUT-OUTPUT  PARAMETER sensitivityList AS LOGICAL   NO-UNDO.
DEFINE INPUT-OUTPUT  PARAMETER checkList AS LOGICAL   NO-UNDO.

DEFINE VARIABLE ix AS INTEGER NO-UNDO.

DO ix = 1 TO NUM-ENTRIES(featureList):
    IF ENTRY(ix, featureList) = "myItem" AND qbf-module = "r" THEN
        ENTRY(ix, sensitivityList) = FALSE.
    END.
END.

RETURN. /* Required last line */
```

This example procedure checks the featureList for a feature name. If the feature name exists in the featureList and the current view in Results is the report view, the sensitivityList setting for the feature is FALSE. The “Results application programming interface (API)” section on page 3–24 provides more information about the qbf-module variable and the u-pvars.i include file. For more information about the ENTRY statement, RETURN statement, CHECKED attribute, and SENSITIVE attribute, see the *OpenEdge Development: ABL Reference*. 
Tool Bar Editor

Results also provides a dynamic Tool Bar Editor that you can use to customize user access to Results and programmer-defined features. Once you define a feature, you can add it as an icon on the toolbar.

To access the Tool Bar Editor, choose Query→Customize→Tool Bar Layout. The Tool Bar Layout dialog box appears:

Tool Bar Layout elements

The Tool Bar Layout dialog box contains the following user-interface elements:

Tool bar

- Represents the tool bar. Select an icon to establish it as the icon in the editor you want to edit.

Features

- Lists of all features in Results. Select a feature from this list to add to the toolbar as an icon.
Images

Specifies the default graphics files that represent the following icon states for a representation of the feature on the toolbar:

- **Up** — The unselected, sensitive state of the icon.
- **Down** — The selected state of the icon.
- **Insensitive** — The unselected, insensitive state of the icon.

To specify a graphics file for an icon state, choose one of these buttons. Results displays a dialog box that allows you to locate and browse graphics files in your operating system, view them, and select one. In Windows, the graphics file must be a Windows Bitmap (.bmp) or Icon (.ico).

Tool bar edit buttons

Allow you to do the following:

- **Add** — Adds the selected feature with associated icons to the tool bar at the selected icon location.
- **Remove** — Deletes the selected icon from the tool bar.

Tool bar management

Results automatically manages the display state of default buttons on the tool bar. Most of the default buttons on the Results tool bar are sensitive, or available, only when there is an active query in Results. These buttons become insensitive, or unavailable, when the user closes the active query. For example, the **Save** button is sensitive only when there is an active query.

By default, depending on which feature you are using, not all buttons that you add to the Results tool bar are sensitive. You can override the default tool bar management behavior and also manage the sensitivity of added icons using the **Menu Item Override** integration point. A Progress procedure attached to this integration point executes once after you execute any feature in Results. See the “Menu management” section on page 3–19 for more information about the **Menu Item Override** integration point.
Feature and interface management

One of the most powerful features of Results allows you to extend and customize it.

To display the Reset dialog box, choose Query→Customize→Reset. The Reset dialog box appears:

![Reset dialog box]

The Reset option allows you to reset the menu system, tool bar, and features of Results to their default states.

From this dialog box, you can reset the Results menu system, toolbar, feature set, or all three. When you choose OK, the reset operation is permanent and your changes to the Results interface are lost.

**Note:** You must remove features from the menu system and tool bar before you can delete them from Results. When you delete a feature, the procedure file associated with the feature is not deleted.

Results application programming interface (API)

While you can code feature procedures to do almost anything you want, most programming in these procedures centers around the following tasks:

- Accessing and editing the current query definition in Results.
- Generating new queries in Results.

You can also execute Results features programmatically from an integration procedure or another feature procedure. Results provides a full-featured Application Programming Interface (API) that supports these activities. The following sections provide some basic information about the Results API and describe how to access, modify, and create queries in Results.
API basics

The Results API consists of a set of shared variables and a procedural interface. The following sections provide basic information about how to access the shared variables and procedures of the Results API in a feature or integration procedure.

Accessing shared variables

Results establishes and maintains a set of shared variables, called API shared variables, that you can access and set from a feature or integration procedure. *API shared variables* provide information about the current state of the Results application and the current query in Results. *Table 3–4* provides summary information about the API shared variables available in Results.

**Table 3–4: API shared variables**

<table>
<thead>
<tr>
<th>Shared variable name</th>
<th>Data type</th>
<th>Extent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qbf-vers</td>
<td>CHARACTER</td>
<td>N/A</td>
<td>A version number for the current installation of Results.</td>
</tr>
<tr>
<td>qbf-module</td>
<td>CHARACTER</td>
<td>N/A</td>
<td>A character code representing the current Results view.</td>
</tr>
<tr>
<td>qbf-name</td>
<td>CHARACTER</td>
<td>N/A</td>
<td>The name of the current query in Results.</td>
</tr>
<tr>
<td>qbf-sortby</td>
<td>CHARACTER</td>
<td>N/A</td>
<td>A comma-separated list of field names to sort by. The fields are listed by precedence in the sort.</td>
</tr>
<tr>
<td>qbf-count</td>
<td>INTEGER</td>
<td>N/A</td>
<td>An integer representing the number of records returned by the current query.</td>
</tr>
<tr>
<td>qbf-governor</td>
<td>INTEGER</td>
<td>N/A</td>
<td>An integer representing the number of records to process in report, label, and export views. Zero (0) processes all records.</td>
</tr>
<tr>
<td>qbf-rc#</td>
<td>INTEGER</td>
<td>N/A</td>
<td>The number of fields (database, calculated, and arrays) in the current query.</td>
</tr>
</tbody>
</table>
To access these API shared variables in a feature or integration procedure, you must define them in your procedure. Typically, you use the `Defined Shared Variable` statement to define a previously established shared variable for use in a procedure. However, Results provides the `u-pvars.i` include file to define the API shared variables for you.

<table>
<thead>
<tr>
<th>Shared variable name</th>
<th>Data type</th>
<th>Extent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>qbf-rcn</code></td>
<td>CHARACTER</td>
<td>64</td>
<td>The name of each field in the current query and additional expression information.</td>
</tr>
<tr>
<td><code>qbf-rcc</code></td>
<td>CHARACTER</td>
<td>64</td>
<td>Information about each calculated field and stacked array in the current query.</td>
</tr>
<tr>
<td><code>qbf-rcg</code></td>
<td>CHARACTER</td>
<td>64</td>
<td>Information about aggregate fields in the query.</td>
</tr>
<tr>
<td><code>qbf-rcl</code></td>
<td>CHARACTER</td>
<td>64</td>
<td>Labels for each field in the current query.</td>
</tr>
<tr>
<td><code>qbf-rcf</code></td>
<td>CHARACTER</td>
<td>64</td>
<td>Formats for each field (database or calculated) in the current query.</td>
</tr>
<tr>
<td><code>qbf-rcp</code></td>
<td>CHARACTER</td>
<td>64</td>
<td>A comma-separated list of values for each field representing layout information for the field in a report, form, and label views.</td>
</tr>
<tr>
<td><code>qbf-rcw</code></td>
<td>INTEGER</td>
<td>64</td>
<td>The width in characters for each field in a report view of the current query.</td>
</tr>
<tr>
<td><code>qbf-rct</code></td>
<td>INTEGER</td>
<td>64</td>
<td>Data type identifiers for each field in the current query. The integer identifier corresponds to a list entry in the <code>qbf-dtype</code> shared variable.</td>
</tr>
<tr>
<td><code>qbf-dtype</code></td>
<td>CHARACTER</td>
<td>N/A</td>
<td>A comma-separated list of data types.</td>
</tr>
</tbody>
</table>
Use the following syntax to reference the `u-pvars.i` include file in the feature or integration procedure:

**Syntax**

```plaintext
{aderes/u-pvars.i}
```

Once you reference this include file at the top of your procedure, you can access any of the API shared variables. For more information about referencing include files see the *OpenEdge Development: ABL Reference*. See the “Accessing and editing the current query” section on page 3–31 for more information on how to use the API shared variables in a feature or integration procedure.

**Using the procedural interface**

Results provides an interface that allows you to manipulate Results queries and execute Results features from a feature or integration procedure. The procedure interface consists of six API procedures. All of the API procedures are located in the procedure library in the `$DLC/gui` directory. Table 3–5 provides summary information about the API procedures available for Results.

**Table 3–5: API procedures**

<table>
<thead>
<tr>
<th>API procedure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>aderes/sffire.p</td>
<td>Executes a feature defined in Results from a feature or integration procedure.</td>
</tr>
<tr>
<td>aderes/vgrpti.p</td>
<td>Retrieves report information. This procedure returns information about the format of a report.</td>
</tr>
<tr>
<td>aderes/vgtbll.p</td>
<td>Retrieves the table list of the current query in Results.</td>
</tr>
<tr>
<td>aderes/vgtbli.p</td>
<td>Retrieves table information. This procedure accesses the join and selection criteria associated with a specified table in the current query in Results.</td>
</tr>
<tr>
<td>aderes/vstbll.p</td>
<td>Sets the table list for a new current query in Results.</td>
</tr>
<tr>
<td>aderes/vsrpti.p</td>
<td>Sets page size for the current query.</td>
</tr>
<tr>
<td>aderes/vstbli.p</td>
<td>Sets the table information associated with the current query.</td>
</tr>
</tbody>
</table>
To use these API procedures in a feature procedure:

- Use the **RUN** statement to call an API procedure from a feature procedure.
- Define a local variable in the feature procedure for each input-output and output parameter specified in the API procedure call.

For more information, see the **RUN** statement and **DEFINE VARIABLE** statement in the *OpenEdge Development: ABL Reference*. The following sections of this chapter describe how to use the different API procedures in a feature procedure.

**Executing a feature from a feature procedure**

The API **sffire.p** procedure executes a feature from a feature procedure. With this capability, you can use features in Results as building blocks for other features. Use the following syntax to call the API **sffire.p** procedure from a feature procedure:

**Syntax**

```plaintext
RUN aderes/sffire.p (INPUT featureId, INPUT args, OUTPUT result).
```

**Parameters for the **sffire.p** procedure**

The following list describes the parameters associated with the API **sffire.p** procedure:

**INPUT featureId**

A string value representing the name of a feature as defined in Results. For information about Results features, see Appendix A, “Results Features.”

**INPUT args**

A string value representing one or more arguments passed to the specified feature. Specify multiple arguments as a comma-separated list. If the feature specified does not take arguments, pass the unknown value (?) for this parameter. For information about arguments for Results features, see Appendix A, “Results Features.”
OUTPUT \textit{result}

A logical value that indicates whether the API procedure executed successfully.

If you use the \texttt{sffire.p} API procedure in a feature procedure, you must define a variable for the result output parameter, as shown in Example 3–3.

\textbf{Example 3–3: sffire.p}

\begin{verbatim}
DEFINE VARIABLE result AS LOGICAL NO-UNDO.
... RUN aderes/sffire.p (INPUT "FileOpen", INPUT ?, OUTPUT result).
\end{verbatim}

In Example 3–3, \texttt{FileOpen} is a feature that does not take an argument list. If Results can execute the FileOpen feature, the \texttt{OUTPUT} parameter result returns a \texttt{TRUE} value.

Table 3–6 lists several Results features that you can use with the API \texttt{sffire.p} procedure. These features are important for developing other feature and integration procedures.

\begin{table}[h]
\centering
\begin{tabular}{|l|l|l|}
\hline
API feature          & Argument & Description                                           \\
\hline
AdminProgInitialize & None     & Clears all information from the API shared variables.   \\
\hline
AdminProgInstantiate & None     & Initializes any unset API shared variables with valid default values. \\
\hline
AdminProgWrite4GL   & \textit{proc-name}, \textit{format} & Generates 4GL code for the current query and view, placing the source in the file specified with the \textit{proc-name} argument. \\
                     &          & The \textit{format} argument must be the character \texttt{g} or \texttt{r}: \\
                     &          & \begin{itemize} \\
                     &          & \item Character \texttt{g} generates stand-alone code. \\
                     &          & \item Character \texttt{r} generates code dependent on the Results application. \\
                     \end{itemize} \\
\hline
\end{tabular}
\caption{Important Results features}
\end{table}

For information about additional features in Results, see Appendix A, “Results Features.”
Testing the Results version number

The API shared variable qbf-vers contains a string value representing the Results product version number. The product version number consists of two digits separated by a decimal point, and followed by a letter (for example, 10.0A). Check the version number to verify that the environment you used to develop your feature and integration procedures matches the version of Results at the end-user site.

If the versions do not match, API changes between Results versions could cause erratic behavior. Feature and integration procedures that access API shared variables and procedures might yield error messages. Table 3–7 lists some of the error messages that can result from a change to the Results API between versions.

Table 3–7: The Results API and error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Possible problem</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>&quot;aderes/proc-name&quot; was not found.</strong> (293)</td>
<td>The API procedure referenced in a feature or integration procedure is no longer supported in the current version of Results.</td>
</tr>
<tr>
<td><strong>Unknown Field or Variable name - var-name.</strong> (201)</td>
<td>The API shared variable referenced in a feature or integration procedure is no longer supported in the current version of Results.</td>
</tr>
<tr>
<td>Mismatched parameter types passed to procedure proc-name. (3230)</td>
<td>The parameters required by an API procedure are different in the current version of Results.</td>
</tr>
<tr>
<td>Procedure proc-name sent sub-procedure proc-name mismatched parameters.</td>
<td>The parameters required by an API procedure are different in the current version of Results.</td>
</tr>
</tbody>
</table>

These errors can prevent the feature or integration procedure from executing. To avoid this problem, rebuild your application. See Chapter 2, “Administering Results,” for more information about rebuilding an application.
Accessing and editing the current query

The following sections provide information about how to use the API shared variables and procedures to access and edit information associated with the current query in Results.

Determining the current view

Use the `qbf-module` shared variable in your feature and integration procedures to determine and set the current view for the current query in Results. The `qbf-module` character variable holds one of the characters listed in Table 3–8.

Table 3–8: View character codes

<table>
<thead>
<tr>
<th>Value</th>
<th>Current view</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>No current query or view</td>
</tr>
<tr>
<td>b</td>
<td>Browse view</td>
</tr>
<tr>
<td>f</td>
<td>Form view</td>
</tr>
<tr>
<td>r</td>
<td>Report view</td>
</tr>
<tr>
<td>l</td>
<td>Label view</td>
</tr>
<tr>
<td>e</td>
<td>Data Export view</td>
</tr>
</tbody>
</table>

When the `qbf-module` variable contains the unknown value (?), there is no current query or view in the Results application window.

When you set the `qbf-module` variable in a feature procedure, make sure the output parameter controlling the redisplay of Results is set to `TRUE`. Consider the following feature procedure example that is presented in Example 3–4.

Example 3–4: Feature procedure

```plaintext
DEFINE INPUT PARAMETER args AS CHARACTER NO-UNDO.
DEFINE OUTPUT PARAMETER winState AS LOGICAL NO-UNDO.
{aderes/u-pvars.i}
ASSIGN
  qbf-module = ?
  winState   = TRUE.
```
The last line of this feature procedure sets the `winState output` parameter to `TRUE`. This causes the Results window to redraw and display the changed module state when the feature procedure finishes executing.

**Determining the name of the current query**

The shared variable `qbf-name` contains the name of the current query in Results. If you set the `qbf-name` variable in a feature procedure to a query that does not exist in the current query directory, Results creates a new temporary query definition. To save the new query definition permanently in the current query directory, execute the **FileSave** feature from a feature procedure or choose **Query→Save** while the query is active in Results.

**Accessing the tables and selection criteria of the current query**

Results provides API procedures that retrieve information about the tables in the current query.

The `vgtbll.p` API procedure retrieves a list of the tables referenced in the current query. Use the following syntax to call the `vgtbll.p` API procedure from a feature procedure:

```
RUN aderes/vgtbll.p (OUTPUT tableList).
```

The `OUTPUT tableList` parameter is a string value containing a comma-separated list of table or alias names referenced in the currently active query.

The `vgtbli.p` API procedure retrieves information about the join and selection criteria for a specified table referenced in the current query.

Use the following syntax to call the `vgtbli.p` API procedure from a feature procedure:

**Syntax**

```
RUN aderes/vgtbli.p (INPUT tableName, OUTPUT refTable, OUTPUT joinTable, OUTPUT joinInfo, OUTPUT whereInfo, OUTPUT whereAsk, OUTPUT includeCode, OUTPUT result).
```
The following list describes the parameters of the vgtbli.p API procedure:

**Parameters for the vgtbli.p API procedure**

The following list describes the parameters of the vgtbli.p API procedure:

**INPUT tableName**

A string value representing the name of a table or alias used in the current query.

**OUTPUT refTable**

If tableName is an alias, this parameter is a string value representing the name of the table associated with the alias. If tableName is an actual table name, this parameter returns the unknown value (?).

**OUTPUT joinTable**

A string value representing the name of a table to which the table specified with the first input parameter (tableName) is joined.

**OUTPUT joinInfo**

A string value containing the Progress 4GL statement relating the specified table with another table available in the currently active query.

**OUTPUT whereInfo**

A string value representing a selection expression in the WHERE clause of the query. This string value does not contain the keyword WHERE and contains only the selection criteria defined explicitly for the query. If this output parameter yields an empty string, there is no WHERE criteria for the corresponding table.

**OUTPUT whereAsk**

A string value representing the information used to prompt for a WHERE clause value at run time. This is the syntax for the string:

**Syntax**

```
/*dataType,dbField,operator:promptString*/ TRUE
```

The database field, the data type of the database field, the operator of the criteria expression, and the prompt are listed.
OUTPUT `includeCode`

A string value containing Progress 4GL statements to execute immediately after each record access from the specified table in the current query.

OUTPUT `result`

A logical value that indicates whether the API procedure executed successfully.

**Determining the query sort order**

Use the `qbf-sortby` variable to retrieve and set the sorting information for the current query. The `qbf-sortby` variable contains `BY` clauses but does not contain the keyword `BY`. The list in the `qbf-sortby` variable has the following form:

**Syntax**

```
db-name.tbl-name.fld-name [ DESC ]
[, db-name.tbl-name.fld-name [ DESC ] ] . . .
```

The fields are positioned in the list based on sort precedence, with the primary sort field listed first. The letters `DESC` specified after a field name in the list indicate that the sort order for the field is descending. If the field is an array field, the field name is followed by a number in square brackets (for example, `[#]`, where `#` is the array element selected for ordering).

**Determining the fields in the current query**

Results places information about the fields of the current query into several different API shared variables. Many of the API shared variables that store information about the fields of the current query are arrays. In each of these field information arrays, there is one element per field in the current query. Results places information about each field into the field information arrays based on the order in which the fields are added to the current query. You can use a single index value to access information about a particular query field across these arrays. For example, an index value of 3 used with each field information array yields information about the third field added to the current query.
These are the shared variables and arrays that contain information about the fields of the current query:

- **qbf-rc# integer variable** — Represents the total number of fields (database, calculated, and array elements) in the current query.

- **qbf-rcn variable** — Identifies a character array that contains names for each field in the current query. The contents of an element of this array vary depending on the information stored in the corresponding element of the qbf-rcc array. If an element in the qbf-rcc array is blank, the corresponding element in qbf-rcn is a field name. Otherwise, the element contains a comma-separated list of information about a calculated field.

  The format of the information list of a calculated field varies depending on the type of calculated field. The name of the calculated field is always the first entry in the list. By default, the calculated field name is qbf-###, where ### is a three-digit number representing the index of the current element in the qbf-rcn array. You can rename calculated fields using the Rename button in the Properties dialog box. The \( \text{ENTRY}(1, \text{qbf-rcn}[n]) \) function always returns the field name from an element of the qbf-rcn variable. Table 3–9 describes the format of the information list for each type of calculated field.

- **qbf-rcc variable** — Identifies a character array that is used to store information for each calculated field and stacked array in the current query. (Stacked arrays display the elements in a column within a single field on the display.) If the first character is blank, the associated field is not a calculated field or a stacked array. For each calculated field in the qbf-rcc variable, the corresponding element in qbf-rcn contains information about the expression used to calculate the field.

  Table 3–9 describes the symbols used in an element of the qbf-rcc array to represent the different types of calculated fields.
Table 3–9: Calculated field symbols

<table>
<thead>
<tr>
<th>First character</th>
<th>Description</th>
<th>Corresponding qbf–rcn value format</th>
</tr>
</thead>
</table>
| r               | Running total. | \( qFId, tFId \), where 
|                 |             | • \( qFId \) is the name of the query field. 
|                 |             | • \( tFId \) is the name of the field used to calculate the running total. |
| p               | Percent of total. | \( qFId, pFId \), where 
|                 |             | • \( qFId \) is the name of the query field. 
|                 |             | • \( pFId \) is the name of the field used to calculate the percent of total. |
| c               | Counter. \n|                 | The \( c \) is followed by one of the following symbols: <, >, or *, where 
|                 |             | • The < symbol signifies that the count is based on the outer-most section of the report. 
|                 |             | • The > symbol signifies that the count is based on the inner-most section of the report. 
|                 |             | • The * symbol signifies that the count is based on all sections of the report. |
### Table 3–9: Calculated field symbols

<table>
<thead>
<tr>
<th>First character</th>
<th>Description</th>
<th>Corresponding qbf–rcn value format</th>
</tr>
</thead>
</table>
| e               | Stacked array. The e is followed by the extent of the array (for example, e12 for `customer.mnth-sales[]`). | `qF1d, aF1d`, where  
  - `qF1d` is the name of the query field.  
  - `aF1d` is the array field. |
| s               | String calculated field. The s is followed by a comma-separated list of the names of the fields used in the calculation. | `qF1d, expr`, where  
  - `qF1d` is the name of the query field.  
  - `expr` is the expression used to calculate the field value. |
| n               | Numeric calculated field. The n is followed by a comma-separated list of the names of the fields used in the calculation. | `qF1d, expr`, where  
  - `qF1d` is the name of the query field.  
  - `expr` is the expression used to calculate the field value. |
| 1               | Logical calculated field. The 1 is followed by a comma-separated list of the names of the fields used in the calculation. | `qF1d, expr`, where  
  - `qF1d` is the name of the query field.  
  - `expr` is the expression used to calculate the field value. |
Table 3–9: Calculated field symbols

<table>
<thead>
<tr>
<th>First character</th>
<th>Description</th>
<th>Corresponding qbf–rcn value format</th>
</tr>
</thead>
</table>
| d               | Date calculated field. The d is followed by a comma-separated list of the names of the fields used in the calculation. | qFld, expr, where  
  • qFld is the name of the query field.  
  • expr is the expression used to calculate the field value. |
| x               | Lookup field. | qFld, sTbl, sFld, mTbl, mFld, dFld, eStr, where  
  • qFld is the name of the query field.  
  • sTbl is the name of the source table.  
  • sFld is the name of the source field containing the lookup values.  
  • mTbl is the name of the match table.  
  • mFld is the name of the field in the match table containing values used for comparison in the lookup operation.  
  • dFld is the name of the field in the match table containing values to display for successful matches.  
  • eStr is the error string to display if there is no valid match. |

Note: For calculated field types s, n, 1, and d, ENTRY(1,qbf–rcn[n]) is the column name and SUBSTRING(qbf–rcn, INDEX(qbf–rcn[n],”,”) + 1) contains the expression. You cannot use ENTRY(2,...) to retrieve the expression, since it might have embedded commas.
• The \texttt{qbf-rcg} variable is a character array containing totals information for each field in the current query. Elements that contain an empty string have no totals information for the corresponding query field. If an element contains an ampersand (\&), repeating values are hidden for the associated field.

An element of the \texttt{qbf-rcg} variable can also contain one or more aggregate strings that consist of a leading letter followed by an integer or 0. An aggregate string must have one of the forms listed in Table 3–10.

\textbf{Table 3–10: Aggregate string}

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{tn}</td>
<td>Total</td>
</tr>
<tr>
<td>\texttt{cn}</td>
<td>Count</td>
</tr>
<tr>
<td>\texttt{an}</td>
<td>Average</td>
</tr>
<tr>
<td>\texttt{nn}</td>
<td>Minimum</td>
</tr>
<tr>
<td>\texttt{xn}</td>
<td>Maximum</td>
</tr>
</tbody>
</table>

If \( n \) is 0, the total accumulation for the associated field is placed on the bottom line (summary line) of the report view of the current query. If \( n \) is an integer, it identifies an element in the \texttt{qbf-sortby} variable containing the name of a query field that triggers the accumulation.

An aggregate string can also contain a dollar sign ($), which indicates that the accumulate string is a totals-only string.

• The \texttt{qbf-rcl} variable is a character array containing labels for each field in the current query. Stacked column labels are supported. In stacked column labels, an exclamation point (!) breaks column labels into more than one level.

• The \texttt{qbf-rcf} variable is a character array containing format strings for each field in the current query. All OpenEdge Data Dictionary formats are supported.
The `qbf-rcp` variable is a character array containing layout parameters related to the report, form, and label views for a field in the current query. Each element of the `qbf-rcp` variable has the following syntax:

**Syntax**

```
rCol, rRow, fCol, fRow, lCol, lRow
```

Table 3–11 are the entries contained in each element of the `qbf-rcp` variable:

**Table 3–11: Elements of the qbf-rcp variable**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>rCol</code></td>
<td>An integer representing the column position in characters for the current field from the left side of the report view.</td>
</tr>
<tr>
<td><code>rRow</code></td>
<td>An integer representing the row position in lines for the current field from the top of the Report view.</td>
</tr>
<tr>
<td><code>fCol</code></td>
<td>An integer representing the column position in characters for the current field from the left side of the Form view.</td>
</tr>
<tr>
<td><code>fRow</code></td>
<td>An integer representing the row position in lines for the current field from the top of the Form view.</td>
</tr>
<tr>
<td><code>lCol</code></td>
<td>An integer representing the column position in characters for the current field from the left side of the Label view.</td>
</tr>
<tr>
<td><code>lRow</code></td>
<td>An integer representing the row position in lines for the current field from the top of the Label view.</td>
</tr>
</tbody>
</table>

**Note:** Do not set an element of the `qbf-rcp` variable to the empty string. Instead, set the element to a character string containing five commas (“,,,,”).  

- The `qbf-rcw` variable is an integer array containing character widths for each query field in the report view. The width of each field includes format, label widths, and stacked labels. This variable is for information purposes only. Results calculates the character width of a field automatically when the query displays.
• The qbf-rct variable is an integer array containing a data type identifier for each field in the current query. The data type identifier is an integer value between 1 and 7 (inclusive) that maps to a list element contained in the qbf-dtype variable.

The qbf-dtype character variable containing a comma-separated list of data types. The default value of this variable is a character array:

"character,date,logical,integer,decimal,raw,recid"

Use this variable with the qbf-rct variable to determine the data type of a field in the current query.

Determining the report format of the current query

The vgrpti.p API procedure retrieves report format information associated with the current query. Use the following syntax to call the vgrpti.p API procedure from a feature procedure:

Syntax

RUN aderes/vgrpti.p (OUTPUT leftOrigin, OUTPUT topOrigin, OUTPUT columnSpace, OUTPUT lineSpace, OUTPUT pageLines, OUTPUT headSpace, OUTPUT footSpace, OUTPUT pageEject, OUTPUT sumReport).

Parameters of the vgrpti.p API procedure

The following list describes the parameters of the vgrpti.p API procedure:

OUTPUT leftOrigin

An integer representing left margin setting, in characters, from the output origin (page or display window).

OUTPUT topOrigin

An integer representing top margin setting, in characters, from the output origin (page or display window).

OUTPUT columnSpace

An integer representing the number of character units between fields on the report.

OUTPUT lineSpace

An integer representing the number of empty lines between text lines on the report.
OUTPUT `pageLines`

An integer representing the maximum number of lines allowed on a printed page of the report.

OUTPUT `headSpace`

An integer representing the number of lines between the report body and the report header.

OUTPUT `footSpace`

An integer representing the number of lines between the report body and the report footer.

OUTPUT `pageEject`

A string value containing the name of the report field used for page ejects.

OUTPUT `sumReport`

A logical value that specifies whether the report is a summary report.

The report view does not have to be active in Results in order to run the `vgrpti.p` API procedure.

Setting table information for the current query

The `vstbli.p` API procedure sets table information associated with the current query. Use the following syntax to call the `vstbli.p` API procedure from a feature procedure:

Syntax

```
RUN aderes/vstbli.p (INPUT tableName, INPUT joinTable, INPUT joinInfo,
                     INPUT whereInfo, INPUT whereAsk, INPUT includedCode, OUTPUT result).
```

Parameters of the `vstbli.p` API procedure

The following list describes the parameters of the `vstbli.p` API procedure:

INPUT `tableName`

A string value representing the name of a table or alias used in the current query. The table name must be fully qualified (for example, `db.table.name`).

INPUT `joinTable`

A string value representing the name of the table to which `tableName` is joined, if any.
INPUT joinInfo

A string value containing the Progress 4GL code defining the join relationship between joinTable and tableName.

INPUT whereInfo

A string value representing a selection expression in the WHERE clause of the query. This string value does not contain the keyword WHERE and contains only the selection criteria defined explicitly for the query.

INPUT whereAsk

A string value representing the information used to prompt for a WHERE clause value at run time. This is the syntax for the string value:

Syntax

```/*dataType,Field,operator:promptString*/  TRUE```

The field, the data type of the field, the operator of the criteria expression, and prompt string are listed.

INPUT includedCode

A string value containing Progress 4GL statements to execute immediately after each record access from the specified table in the current query.

OUTPUT result

A logical value that indicates whether the API procedure executed successfully.
Setting the list of tables for the current query

The `vstbll.p` API procedure sets the list of tables associated with the current query. Use the following syntax to call the `vstbll.p` API procedure from a feature procedure:

**Syntax**

```
RUN aderes/vstbll.p (INPUT tableList, OUTPUT result).
```

**Parameters of the `vstbll.p` API procedure**

The following list describes the parameters of the `vstbll.p` API procedure:

**INPUT** `tableList`

A string value containing a list of tables to be used in the current query. The table names must be fully qualified (for example, `db.table.name`).

**OUTPUT** `result`

A logical value that indicates whether the API procedure executed successfully.

Setting the export format for the current query

The `vsexpi.p` API procedure sets the export format for the current query. Use the following syntax to call the `vsexpi.p` API procedure from a feature procedure:

**Syntax**

```
RUN aderes/vsexpi.p (INPUT newFormat, OUTPUT result, OUTPUT oldFormat).
```

**Parameters of the `vsexpi.p` API procedure**

The following list describes the parameters of the `vsexpi.p` API procedure:

**INPUT** `newFormat`

A string value representing the name of the export format to make active for the current query. If the format name is not found in the list of existing formats, it is not set.

**OUTPUT** `result`

A logical value that indicates whether the API procedure executed successfully.
OUTPUT oldFormat

A string value representing the name of the old (prior to calling this API) export format. This information can be used to restore the export format to its original state at the end of the feature procedure.

Setting the report format for the current query

The vsrpti.p API procedure sets the report (page) format for the current query. Use the following syntax to call the vsrpti.p API procedure from a feature procedure:

Syntax

RUN aderes/vsrpti.p (INPUT newFormat, OUTPUT result, OUTPUT oldFormat).

Parameters of the vsrpti.p API procedure

The following list describes the parameters of the vsrpti.p API procedure:

INPUT newFormat

A string value representing the name of the page format to make active for the current query. If the format name is not found in the list of existing formats, it is not set.

OUTPUT result

A logical value that signals whether or not the API procedure executed successfully.

OUTPUT oldFormat

A string value representing the name of the old (prior to calling this API) page format. This information can be used to restore the page format to its original state at the end of the feature procedure.

Setting the label format for the current query

The vslbli.p API procedure sets the label format for the current query. Use the following syntax to call the vslbli.p API procedure from a feature procedure:

Syntax

RUN aderes/vslbli.p (INPUT newFormat, OUTPUT result, OUTPUT oldFormat).
Parameters of the vslbli.p API procedure

The following list describes the parameters of the vslbli.p API procedure:

INPUT *newFormat*

A string value representing the name of the label format to make active for the current query. If the format name is not found in the list of existing formats, it is not set.

OUTPUT *result*

A logical value that indicates whether the API procedure executed successfully.

OUTPUT *oldFormat*

A string value representing the name of the old (prior to calling this API) label format. This information can be used to restore the label format to its original state at the end of the feature procedure.

Generating new queries

You can generate new queries programmatically in Results from a feature or integration procedure. Query generation from a feature or integration procedure uses the vstbll.p API procedure and some special Results features.

The vstbll.p API procedure allows you to set the table list for a new query in Results. You cannot run the vstbll.p API procedure when there is a current query in Results. If there is an active query in Results, you must execute the AdminProgInitialize feature to clear the query prior to running the vstbll.p API procedure. Use the following syntax to call the vstbll.p API procedure from a feature procedure or integration procedure:

**Syntax**

```
RUN aderes/vstbll.p (INPUT tableList, OUTPUT result).
```
Parameters of the vstbll.p API procedure

The following list describes the parameters associated with the vstbll.p API procedure:

**INPUT tableList**

A string value containing a comma-separated list of table or alias names to establish the currently active query in Results. The tables specified must be available in the currently attached databases. If you intend to join a table to another table, you must specify both tables in the list in the order specified in the join. For example, the join Customer OF Order requires that the Customer table must be listed before the Order table in the table list.

**OUTPUT result**

A logical value that indicates whether the API procedure executed successfully.

To generate queries from a feature or integration procedure:

1. Execute the AdminProgInitialize feature using the sffire.p API procedure to clear the current query from Results.

2. Run the vsfbll.p API procedure to set the table list for the new query.

3. Define fields and format information for the new query using the API shared variables and procedures. At a minimum, set the qbf-module and qbf-name variables and define a field for the query.

4. Execute the AdminProgInstantiate feature using the sffire.p API procedure to initialize any unset API shared variables with valid default values. You must execute this feature before you attempt to display or run the new query.

5. Save the new query, generate 4GL code for the query, then print it or display it in Results.
The feature procedure shown in Example 3–5 generates a new query, then displays it in Results.

Example 3–5: tstFeat.p

```pascal
/* 1 */
{ aderes/u-pvars.i }

/* 2 */
DEFINE INPUT PARAMETER args AS CHARACTER NO-UNDO.
DEFINE OUTPUT PARAMETER winState AS LOGICAL NO-UNDO.

/* 3 */
DEFINE VARIABLE lResult AS LOGICAL NO-UNDO.

/* 4 */
RUN aderes/sffire.p ("AdminProgInitialize", ?, OUTPUT result).

/* 5 */
OUTPUT lResult).
IF lResult = TRUE THEN DO:
/* 6 */
RUN aderes/vstb1i.p (INPUT "sports2000.Customer", INPUT ?, INPUT ?,
/* 7 */
ASSIGN
qbf-module = "r"
qbf-name  = "newque"
qbf-rc#   = 2
qbf-rc1[1] = "Cust Name"
qbf-rcf[1] = "X(25)"
qbf-rcr[1] = 1
qbf-rcc[1] = "........"
qbf-rc1[2] = "Ord Num"
qbf-rcf[2] = ">>>>9"
qbf-rcr[2] = 4
qbf-rcc[2] = "........".
END. /* DO */

/* 8 */
RUN aderes/sffire.p (INPUT "AdminProgInstantiate", INPUT ?, OUTPUT result).
/* 9 */
winState = TRUE.
```
The commented numbers in the code refer to these notes:

1. Includes the u-pvars.i file to define the API shared variables for access in the procedure.

2. Defines the INPUT and OUTPUT parameters required by a feature procedure.

3. Defines a variable to capture the output values of the different API procedures used in this feature procedure.

4. Executes the AdminProgInitialize feature using the sffire.p API procedure to clear the current query from Results.

5. Sets the table list for the new query. The example feature procedure uses tables from the sports2000 database.

6. Defines the join and selection criteria for the tables specified for the new query.

7. Defines two fields for the new query.

8. Instantiates the rest of the data structures of the new query in preparation for use in Results.

9. Sets the output parameter of the feature procedure to TRUE, which tells Results to redraw the window and display the new query defined in the feature procedure.

For more information about the language elements used in the this example procedure, see the OpenEdge Development: ABL Reference.

Output solutions in Results

By default, Results allows the user to view query output on screen using the Print Preview option and to direct output to the default system printer, a file, or the system clipboard using the Print menu options. You can develop your own output solutions and integrate them as features in Results. Several sample output feature procedures located in the ader es product directory provide examples for your own output solutions. Table 3–12 describes the sample output feature procedures.
Table 3–12: Sample output feature procedures

<table>
<thead>
<tr>
<th>Output procedure</th>
<th>Description</th>
<th>Syntax of required input parameter string</th>
</tr>
</thead>
<tbody>
<tr>
<td>u-cprint.p</td>
<td>Sends the output of the current query to a specified printer with control characters using the OUTPUT TO and PUT CONTROL statements.</td>
<td><code>printer [, control ]...</code>, where</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>printer</code> is the operating system name of a printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>control</code> is an integer representing the ASCII character value of a printer control character.</td>
</tr>
<tr>
<td>u-thru.p</td>
<td>Sends the output of the current query to a specified printer using the OUTPUT THROUGH statement. This procedure is designed exclusively for use on character-mode systems.</td>
<td><code>printer</code>, where <code>printer</code> is the operating system name of a spooled print device.</td>
</tr>
<tr>
<td>u-to.p</td>
<td>Sends the output of the current query to a specified printer using the OUTPUT TO statement.</td>
<td><code>printer</code>, where <code>printer</code> is the name of a printer.</td>
</tr>
<tr>
<td>u-pprog.p</td>
<td>Generates a temporary procedure file for the current query, then runs a specified Progress 4GL procedure with the generated procedure as an argument.</td>
<td><code>procedure</code>, where <code>procedure</code> is the name of a Progress procedure.</td>
</tr>
<tr>
<td>u-pview.p</td>
<td>Sends the output of the current query to a temporary text file, then runs a specified Progress procedure with the temporary text file as an argument.</td>
<td><code>procedure</code>, where <code>procedure</code> is the name of a Progress procedure.</td>
</tr>
</tbody>
</table>

**Note:** You cannot use these sample output procedures to direct output for queries in the browse and form views.
To add a sample output procedure to Results as a feature and menu option:

1. Choose Query → Customize → Feature to access the Feature Editor.

2. Define the feature, then choose Add. For example, the following list provides information that defines a feature that uses the u-cprint.p procedure to direct query output and printer control characters to a specified printer:

   - **Name** — PrintCompressed
   - **Program** — /usr/dlc/gui/aderes/u-cprint.p
   - **Argument** — lpr,15
   - **Label** — To &lpr compressed

3. Choose Query → Customize → Menu Layout to access the Menu Editor.

4. Add the new feature to the Query → Print menu.

For more information about output routing solutions, see the *OpenEdge Getting Started: ABL Essentials*. 
Export solutions in Results

Results provides a robust set of standard export formats, but you can also develop your own standard export format. There are two basic techniques for implementing a standard export format for use at a user site:

- Edit the existing Sample Export format.
- Edit the results.l file to define a new export format.

This section describes the Sample Export Format. For information about the contents of the results.l file, see Appendix C, “Results Files.”

The Sample Export format is one of the default standard export formats and performs an export using the default Progress export format. The Progress source procedure that implements the Sample Export format is u-export.p and is located in the aderes product directory.

You can edit the u-export.p procedure and code your own export solution. Note that the u-export.p procedure executes once for each field defined for export in the query. These fields are listed in the qbf-rcn API shared variable for the active query. The u-export.p procedure defines several input parameters that pass information about the current export field from Results to the procedure. Descriptions for each of these input parameters are located in the comment text of the u-export.p procedure.

The body of the u-export.p procedure builds an EXPORT statement using the input parameter values. The u-export.p procedure uses the PUT statement to write the EXPORT statement to a temporary file that Results executes to export data from the query. For more information about the EXPORT and PUT statements, see the OpenEdge Development: ABL Reference.

If you copy and edit the u-export.p file, make sure that the new procedure is located in a directory that is listed in the PROPATH before the product directory (DLC).
Results main application procedure

Most of the discussion in this chapter focuses on calling other Progress 4GL procedures from Results. However, you can also integrate Results into an existing OpenEdge application. The main procedure for the Results application is results.p, located in the product directory (DLC).

To run Results from another Progress 4GL procedure, use the following statement:

```
RUN results.p.
```

If you run Results from a OpenEdge application that has its own application window, use the technique outlined in Example 3–6 to manage user focus and multiple windows:

**Example 3–6: Technique to manage user focus and multiple windows**

```plaintext
/* Template Calling RESULTS from a OpenEdge application */
/* 1 */
DEFINE VARIABLE parentWin AS HANDLE NO-UNDO.
/* 2 */
ASSIGN
    parentWin = CURRENT-WINDOW
    parentWin:WINDOW-STATE = WINDOW-MINIMIZED
    parentWin:SENSITIVE = FALSE.
/* 3 */
RUN results.p.
ASSIGN
/* 4 */
    CURRENT-WINDOW = parentWin
/* 5 */
    parentWin:WINDOW-STATE = WINDOW-NORMAL
    parentWin:SENSITIVE = TRUE.
```
The commented numbers refer to these notes:

1. Create a variable to hold the widget handle of the parent application window.
2. Place the widget handle of the parent application window into the new variable. The CURRENT–WINDOW session handle returns the widget handle of the parent application window.
3. Minimize the parent application window and disable it for user input while the procedure displays the Results application window.
4. Restore the CURRENT–WINDOW handle to the original window handle.
5. Restore the parent application window and enable it for user input after the user closes the Results application window.

For more information about general programming concepts and techniques, see the OpenEdge Getting Started: ABL Essentials. See the OpenEdge Development: ABL Reference for information about language elements in the Progress 4GL.

**Code generation**

You can use Results to generate a Progress 4GL procedure for a query view and use the procedure in other OpenEdge applications. Results provides two ways to generate code:

- From within Results using the Query→Generate menu option.
- From an application using the AdminProgWrite4GL feature.

Regardless of which way you generate the code, you must consider how to prompt users for input. See the “Ask At Run Time values” section on page 3–56 for information about prompting users.
Generating code from within Results

The Query→Generate menu option generates a standalone Progress 4GL procedure for the current query and view. Table 3–13 provides some general information about how Query→Generate generates code for the current query and view.

<table>
<thead>
<tr>
<th>View</th>
<th>Code generation information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>For interactive use only. The code contains a WAIT-FOR statement but does not explicitly create a window widget.</td>
</tr>
<tr>
<td>Form</td>
<td>For interactive use only. The code contains a WAIT-FOR statement but does not explicitly create a window widget.</td>
</tr>
<tr>
<td>Report</td>
<td>The DISPLAY statement is used to output data. The OUTPUT statement is used to output the report to TERMINAL PAGED.</td>
</tr>
<tr>
<td>Label</td>
<td>For noninteractive use only. The PUT statement is used to output data to label.dat.</td>
</tr>
<tr>
<td>Export</td>
<td>For noninteractive use only. The EXPORT statement is used to output data to export.dat.</td>
</tr>
</tbody>
</table>

**Note:** Code generated for the form view of a query does not contain the Query By Example button or functionality.

Generating code from an application

You can also generate code by executing the AdminProgWrite4GL feature in a feature procedure. The AdminProgWrite4GL feature generates Progress 4GL code for the report, label, or export view of a query. However, the AdminProgWrite4GL feature does not generate code for the browse and form views of a query.
Arguments to the AdminProgWrite4GL feature allow you to specify an output file for the code and to determine whether the generated code is standalone Progress code or dependent on Results. The following statement shows the syntax required to execute the AdminProgWrite4GL feature in a feature procedure:

```
RUN aderes/sffire.p (INPUT "AdminProgWrite4GL", INPUT "proc-name, format", OUTPUT result).
```

The `proc-name` argument specifies the name of the operating system file where Results stores the generated code. The `format` argument must be the character `g` or `r`. The character `g` generates standalone code. See Table 3–13 for information about the standalone code that the AdminProgWrite4GL feature generates for different types of views. The character `r` generates code that is dependent on the Results application. Use the Results-dependent format to generate and run queries in Results that produce data in preparation for use with other applications that are integrated into the Results menu system (for example, business graphics applications).

**Ask At Run Time values**

You can prompt users for input in generated code with the Ask At Run Time feature. There are two parts to the process.

1. First, you specify that you want Results to accept input at run time.
2. Then, when you generate the code, you can either specify the input values yourself or you can have Results prompt users for the values when they run the application containing the code.

If you choose to prompt users for the value when the code is run, the generated code includes an UPDATE statement for the Ask At Run Time phrase.
Specifying the user prompt

You specify the user prompt when you are creating the query.

To specify the user prompt:

1. Choose Data→Selection. If the query includes multiple tables, the Available Tables dialog box appears. Select the desired table, then choose OK. The Data Selection dialog box appears. If the query contains a single table, the Data Selection dialog box appears immediately:

   ![Data Selection dialog box]

2. Select the Ask At Run Time toggle box. A checkmark displays in the toggle box.

3. Specify the selection criteria. The Ask At Run Time Prompt dialog box appears after you select an operator:

   ![Ask At Run Time Prompt dialog box]

4. Enter the string you want Results to use when it prompts the user for input, then choose OK. The Data Selection dialog box reappears. Notice that the selection criteria now contains the runtime expression, including the string you just entered.
5. Choose OK to save the specified criteria and return to the main window.

Now, when you run the query, Results prompts the user for the selection criteria.

Generating the query

This section describes how to generate the query.

To generate the query:

1. Choose Query → Generate. The Generate 4GL dialog box appears:

![Generate 4GL dialog box](image)

2. Specify the name of the file and select Save. If the file already exists, Results prompts you to replace the file.

After you specify the file name, Results generates the code. Because you created a prompt phrase, the following dialog box appears:

![Prompt dialog box](image)
3. Choose **Yes** if you want to prompt the user for the input values or **No** if you want to specify the input values now. If you choose **Yes**, Results prompts the user for input when the code is run.

For example, if you specify to ask the user “What is the customer’s number?”, the following dialog box appears when the code is run:
OpenEdge Reporting: Query/Results Administration and Development

3–60
Deploying Results Applications

This chapter describes how to deploy a Results application to an end-user environment. It contains information on the following topics:

- Before you begin
- Deployment process and site requirements
- Application files for deployment
- Application databases
- The application directory structure
- Progress Application compilation
- The fastload system
Before you begin

The information in this chapter is for programmers who are familiar with Results and understand general deployment issues for OpenEdge applications. This chapter describes deployment issues specific to Results and provides references to other OpenEdge-related publications for general deployment information.

Deployment process and site requirements

Deployment is the process of distributing an application for use in an end-user environment. Before you can deploy a Results application to an end-user environment, you must confirm that the environment has a licensed version of Results installed and also has Progress compilation capabilities.

There are a number of steps in the deployment process that you must perform in the development and end-user environments.

Initiating the deployment process

This procedure describes in general terms how to begin the deployment process.

To begin the deployment process for a Results application in the development environment:

1. Identify the files and directory structure of your Results application.
2. If you must deploy all, or a portion of your application databases, dump the appropriate data and data definitions from your databases.
3. Transfer the application and database files to the distribution media.

Once you have the application and database files ready for distribution, the deployment process shifts to building the application in the end-user environment. The following sections discuss how to build a Results application in the user environment.
Building a Results application

This procedure describes in general terms how to build a Results application in an end-user environment.

To build a Results application in the user environment, follow these steps:

1. Create the application directory and file structure.
2. If you deployed all, or a portion of your application databases, create the application database if necessary and then load the deployed data definitions and data.
3. Compile the deployed feature and integration procedures using the Progress Application Compiler.
4. Start Results and rebuild the fastload system.

The remaining sections provide more information about the deployment process and the application components involved in this process.

Application files for deployment

When you deploy a Results application, you are deploying only the files that are unique to your application. You are not deploying the entire Results product. To deploy the entire Results product would be a violation of the Results product license, thus a licensed version of Results must exist in the end-user environment.

As a general rule, deploy only the source files and not the r-code files of a Results application. Differences between the development and user environments and possible changes in the application directory structure might require that you recompile your application files in the end-user environment. Results must also recompile the fastload system for your application in the end-user environment. The end-user environment must have Progress compilation capabilities.

The following sections provide information about the files that you should deploy for a Results application.
The deployment report

As you build a Results application, Results creates and maintains a deployment report. The deployment report lists all of the databases, procedure files, ASCII files, and graphics files that are part of your application in Results. These are the files that you must deploy to install your application in end-user environments.

The name of the deployment report consists of the first five characters of the current QC7 file followed by .txt. Results creates the deployment report in the same directory as the QC7 file. Example 4–1 shows an example of a deployment report for a simple Results application.

Example 4–1: sport.txt

```
# Progress RESULTS Deployed Application FileList
# This reports does not provide Public Query Directory Information
baseResourceFile= aderes/results.l
configurationFile:ascii= sports.qc7
configurationFileAltSrc:featureFile= sportf.p
configurationFileAltSrc:menuFile= sportmt.p
database:1= sports
defaultIcon:Graph= C:/PROSPRT/GRAPH-D.BMP
defaultIcon:Graph= C:/PROSPRT/GRAPH-I.BMP
defaultIcon:Graph= C:/PROSPRT/GRAPH-U.BMP
featureFileSrc:Cmprint= C:\PROSPRT\CMPRINT.P
featureFileSrc:Graph= C:\PROSPRT\PRSGRAPH.P
integrationPointSrc:define= C:\PROSPRT\PRSDEF.P
integrationPointSrc:direct= C:\PROSPRT\PRSDIR.P
integrationPointSrc:field= C:\PROSPRT\PRSFLD.P
integrationPointSrc:login= C:\PROSPRT\PRSLOGN.P
integrationPointSrc:logo= C:\PROSPRT\PRSLOGO.P
integrationPointSrc:menu= C:\PROSPRT\PRSMENU.P
integrationPointSrc:sens= C:\PROSPRT\PRSMENU.P
integrationPointSrc:table= C:\PROSPRT\PRSTBL.P
integrationPointSrc:where= C:\PROSPRT\PRSTBL.P
logoIcon= C:\PROSPRT\PROSPRT.ico
```

Each file entry in the deployment report has a label that identifies how the file is integrated into Results.
Deployment file list

The following list identifies and describes the deployment report labels:

baseResourceFile

The relative pathname of the results.l file. Deploy this file only if you altered it to define export formats, page sizes, and label formats.

configurationFile: ascii

The pathname of the QC7 file.

configurationFileAltSrc: featureFile

The pathname of the feature definition file. This file loads the feature definitions for your application into Results. Results generates a compiled, optimized version of this file for the fastload system. You can set the name of this file with the Query→ Customize→ Deployment menu option.

configurationFileAltSrc: menuFile

The pathname of the menu definition file. This file loads the menu system and toolbar configuration for your application into Results. Results generates a compiled, optimized version of this file for the fastload system.

database:n

The name of a database referenced in the query configuration file. The deployment report contains an entry for each database referenced in the query configuration file. The \( n \) represents the number of the database in the order of listing in the query configuration file. In most cases, the application databases already exist in the user environment.
defaultIcon: *FeatureName*

The pathname of an icon specified for a programmer-defined feature. The *FeatureName* parameter is the name of the feature associated with the icon. The deployment report typically has three defaultIcon entries for each new feature to identify graphics files associated with the three states of the icon: up, down, and insensitive. The following excerpt from a deployment report shows the graphics files associated with a feature called Graph:

```
defaultIcon:Graph= C:/PROSPRT/GRAPH-D.BMP
defaultIcon:Graph= C:/PROSPRT/GRAPH-I.BMP
defaultIcon:Graph= C:/PROSPRT/GRAPH-U.BMP
```

**featureFileSrc:** *FeatureName*

The pathname of a source procedure file associated with a programmer-defined feature. The *featureName* parameter is the name of the new feature. The following excerpt from a deployment report shows the procedure file associated with a feature called Cmprint:

```
featureFileSrc:Cmprint= C:\PROSPRT\CMPRINT.P
```

The deployment report contains a featureFileSrc entry for each programmer-defined feature.

**integrationPointSrc:** *intPoint*

The pathname of a source procedure file associated with an integration point. The *intPoint* parameter is an identifier for an integration point. These are the valid identifiers and the names of the corresponding integration points:

- **define** — Initialize Vars and Interface
- **direct** — Query Directory Switch Program
- **field** — Field Security
- **login** — Login Program
- **logo** — Logo Screen
- **menu** — Feature Security
• **sens** — Menu Item Override
• **table** — Table Security
• **where** — Table Selection Security

The deployment report contains an integrationPointSrc entry for each integration point that has an assigned integration procedure.

**logoIcon**

The pathname of a graphics file defined as the application icon for Results in the window system.

The following section lists additional files that do not appear in the deployment report, but are potential candidates for deployment as part of a Results application.

### Other possible deployment files

The deployment report lists the majority, but not all, of the files that must be deployed with a Results application. There are several files in a Results application that the product does not track or manage. The following list identifies and describes these unmanaged files:

**u-export.p**

The procedure file associated with the Sample Export format in the **Standard Export** list. If you implement a custom export solution using this file, you must deploy the `u-export.p` file.

**Application files**

ASCII files, graphics files, include files, and other procedure files referenced in feature and integration procedure files. These files do not appear in the deployment report. You must track and manage these application files.

**Query directories**

Public and user query directory files containing predefined queries. If you deploy a query directory, you must also deploy the source files associated with the queries defined in the query directory. Results generates a source file for a query containing information that defines the query. The name of each source file begins with characters “que” followed by a unique five-digit number and the file extension.p (`que#####.p`).
Note the directory locations of these additional deployment files so that you can reimplement this application directory structure in the user environment.

**Graphics files**

When deploying a Results application from one window system to another, you must convert your graphics files to a format that Progress supports for the target windowing system. For Windows, Progress supports the use of bitmaps (BMP), icons (ICO), and cursors (CUR) in your applications.

**Application databases**

To deploy all or a portion of an application database, you must perform a dump-and-load operation. These are the situations that force you to deploy all or a portion of an application database from the development environment to the user environment:

- If the application database does not exist in the user environment, you must deploy the entire database.
- The application database exists in the user environment, but there are some changes to the schema of the database that you must deploy to the user environment.
- The application database exists in the user environment, but there is new data (for example, new user definitions in the _User file) that you must deploy to the user environment.

A dump operation produces text files containing data definitions (.df) files and data (.d) files. Transfer these data definition and data files to the user environment to recreate the application database or to load updates into an existing application database. When you deploy a database, remember to deploy the source code for any trigger procedures associated with the application database.

For more information about dumping and loading databases, see the *OpenEdge Data Management: Database Administration*. 
The application directory structure

As a general rule, the directory structure of your Results application should be similar in the development and user environments. The directory structure of a Results application is reflected in the pathnames contained in the deployment report for the application.

**Note:** In Results, all dialog boxes that allow you to browse through directories and select files in your operating system return absolute pathnames for the selected files. In most circumstances, you can specify a relative pathname for a file by typing a pathname in an input field. For example, the Files button in the Feature Editor dialog box allows you to specify an absolute pathname for a feature procedure. You can enter a relative pathname for a feature procedure by typing the pathname in the Program field.

Relative pathnames and Propath

Relative pathnames and the PROPATH variable provide some flexibility in the implementation of an application directory in the user environment. The PROPATH is a list of directory pathnames that Progress uses to locate directories and files at run time. For example, Results uses the PROPATH to locate a QC7 and QD7 files. If you use relative pathnames and your application files are not located in the current working directory or a OpenEdge product directory, you must include the directory where the files are located in the PROPATH. For Windows environments, the PROPATH environment variable is specified in the [Startup] section of the environment (.ini) file.

For more information about the PROPATH environment variable file, see *OpenEdge Data Management: Database Administration* and *OpenEdge Getting Started: Installation and Configuration*.

**Note:** If you create a directory structure in the user environment that is different from the one used to develop the application, you must edit the QC7 file, the feature file (basef.p), and the UI file (basemt.p) of the application. These files contain pathnames that must be changed to reflect the new application directory structure in the user environment. You must edit these files before starting Results in the user environment. See Appendix C, “Results Files,” for more information about QC7 files, feature files, and user interface (UI) files.
Progress Application compilation

Use the Progress Application Compiler or the `COMPILE` statement in the user environment to compile the feature, integration, and database trigger procedures of your application and your application database. You must be connected to the application database to compile procedures that access the databases. For information about the Progress Application Compiler, see the *OpenEdge Development: Basic Development Tools* online help. For information about the `COMPILE` statement, see the *OpenEdge Development: ABL Reference*.

The fastload system

The *fastload system* is the set of r-code files that optimizes the configuration of Results at startup. Results automatically generates and updates the fastload system associated with the current QC7 file.

**Note:** A fastload system for a Results application should not exist in the user environment prior to the initial startup of the application. Do not distribute the fastload system for an application from the development environment to the user environment. The fastload system for a Results application in the user environment must be generated as part of the initial startup of the application and must reflect the application directory structure implemented in the user environment.
To start and generate a fastload system for a Results application in an end-user environment:

1. Start up Results. The order of the application databases specified in the `startup` command must be in the same order as used to generate the QC7 file in the development environment. For information about startup commands for Results, see Chapter 1, “Results for Administrators and Programmers.”

2. At startup, Results checks the QC7 file for information about the required application databases. The QC7 file contains an integer, called a checksum number, for each application database from the development environment. The checksum number for a database is the sum of the last schema modification date for each table in the database. Results compares the checksum numbers from the development environment against the modification dates of the application databases in the user environment. If there is a difference, then the following warning message appears:

   ![Warning Message]

   Choose **No** to continue with the initial startup without rebuilding the table relationships.

3. After analyzing the application databases, Results checks for the existence of a fastload system. If it cannot find one, it displays the following error message:

   ![Error Message]
When you dismiss this error message, Results uses the QC7 to configure the features, menu system, and toolbar.

**Note:** This initial configuration process might take awhile because Results cannot use a compiled fastload system.

4. Exit Results. Before shutdown, Results updates the QC7 file with new checksum numbers for the application databases and regenerates the fastload system for the installation.

Your Results application is ready to use.
This appendix contains an alphabetical listing of reference entries for each feature in Results.

This appendix presents:

- Before you begin
- Reference entry details
Before you begin

The purpose of this reference is to help you to:

- Redesign the default menu system and tool bar layout.
- Set Feature security.
- Execute features from a feature procedure using the API `sffire.p` procedure.

See Chapter 3, “Programming Results,” for more information about API procedures and executing features from feature procedures.

Reference entry details

This reference section documents each type of Results feature that you can redesign.

Reference entry example

Figure A–1 provides a description of the types of information supplied for each reference entry.

<table>
<thead>
<tr>
<th>Feature name</th>
<th>Description</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>BrowseView</td>
<td>Displays the current query as in the browse view format.</td>
<td>Active query</td>
</tr>
<tr>
<td>Default menu assignment</td>
<td></td>
<td>Default Menu Label:</td>
</tr>
<tr>
<td>Default tool bar assigned</td>
<td></td>
<td>Default Tool Bar Icon:</td>
</tr>
</tbody>
</table>

Figure A–1: Reference entry example
**About Results**

Displays the *About Results* dialog box. This dialog box displays information about the current product installation.

**Requirements:** None.

**Default Menu Label:** Help → About Results

**Default Tool Bar Icon:** None. Not on the default tool bar.

**AdminCustomizeInterface**

Displays the *Preferences* dialog box. This dialog box allows you to set the product name displayed in the application window title bar, set the icon image for the application, and set the Results exit behavior.

**Requirements:** None.

**Default Menu Label:** Query → Customize → Preferences

**Default Tool Bar Icon:** None. Not on the default tool bar.

**AdminDeployment**

Displays the *Deployment* dialog box. This dialog box allows you to set the name of the fastload file, feature definition file, and graphical configuration file.

**Requirements:** None.

**Default Menu Label:** Query → Customize → Deployment

**Default Tool Bar Icon:** None. Not on the default tool bar.
AdminExportType

Displays the Standard Export dialog box. This dialog box allows you to define the standard export formats available for the current site.

Requirements: None.

Default Menu Label: Query→ Site Admin→ Standard Export Format

Default Tool Bar Icon: None. Not on the default tool bar.

AdminFeatures

Displays the Feature Editor dialog box. This dialog box allows you to create, edit, and delete features for Results. You cannot edit or delete Results features from this dialog box.

Requirements: None.

Default Menu Label: Query→ Customize→ Features

Default Tool Bar Icon: None. Not on the default tool bar.

AdminIntegration

Displays the Integration Procedures dialog box. This dialog box allows you to integrate Progress procedures into the Results engine to customize Results data security and interface management processing.

Requirements: None.

Default Menu Label: Query→ Customize→ Integration Procedures

Default Tool Bar Icon: None. Not on the default tool bar.
AdminLabelField

Displays the **Label Field Selection** dialog box. This dialog box allows you to define the parameters that determine default label selection for all tables in the connected databases.

**Requirements:** None.

**Default Menu Label:** Query → Site Admin → Label Field Selection

**Default Tool Bar Icon:** None. Not on the default tool bar.

AdminLabelType

Displays the **Standard Label** dialog box. This dialog box allows you to define the label sizes available for use in the label view.

**Requirements:** None.

**Default Menu Label:** Query → Site Admin → Standard Label Size

**Default Tool Bar Icon:** None. Not on the default tool bar.

AdminMenuEdit

Displays the **Menu Editor** dialog box. This dialog box allows you to add, edit, and delete menu items from the Results menu structure. You can also use this dialog box to associate features with menu items.

**Requirements:** None.

**Default Menu Label:** Query → Customize → Menu Layout

**Default Tool Bar Icon:** None. Not on the default tool bar.
AdminProgInitialize

Clears the current query and initializes the API shared variables. Use this feature prior to creating a new query in a feature procedure. This feature is designed specifically for use with the API sffire.p procedure.

Requirements: None.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.

AdminProgInstantiate

Initializes any unset API shared variables and all other API data structures with valid default values. Use this feature prior to executing (displaying, printing, generating, or saving) a query defined or modified in a feature procedure. This feature is designed specifically for use with the API sffire.p procedure.

Requirements: None.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.
AdminProgWrite4GL

Generates 4GL code for the current query and view, placing the source in a specified ASCII file. This feature is designed specifically for use with the API `sffire.p` procedure.

**Requirements:** None.

**Default Menu Label:** None. Not in the default menu system.

**Default Tool Bar Icon:** None. Not on the default tool bar.

This feature has two arguments:

```plaintext
proc-name, code-format
```

The `proc-name` argument specifies the name of an ASCII file where the generated code is stored. The `code-format` argument must be the character `g` or `r`. The character `g` generates stand-alone code. The character `r` generates code dependent on the Results application. You cannot generate code with the `r` option if the current view is the browse or form view.

AdminRebuild

Displays the Application Rebuild dialog box. This dialog box allows you to rebuild the database query configuration file and all query files when you change the schema of an application database.

**Requirements:** None.

**Default Menu Label:** Query → Site Admin → Application Rebuild

**Default Tool Bar Icon:** None. Not on the default tool bar.
**AdminReportType**

Displays the **Standard Page Size** dialog box. This dialog box allows you to define the page sizes available for use in the report view.

**Requirements:** None.

**Default Menu Label:** Query → Site Admin → Standard Page Size

**Default Tool Bar Icon:** None. Not on the default tool bar.

**AdminReset**

Displays the **Reset** dialog box. This dialog box allows you to reset the Results menu system and tool bar to their default states. It also allows you to delete all user-defined features in the current installation of Results.

**Requirements:** None.

**Default Menu Label:** Query → Customize → Reset

**Default Tool Bar Icon:** None. Not on the default tool bar.

**AdminSecurity**

Displays the **Feature Security** dialog box. This dialog box allows you to specify which users can access features defined in Results. For each feature, you can specify a list of user IDs that have access to the feature.

**Requirements:** None.

**Default Menu Label:** Query → Site Admin → Feature Security

**Default Tool Bar Icon:** None. Not on the default tool bar.
AdminSubMenu

Represents the Site Administration submenu and cannot be executed from a feature procedure using the API sfire.p procedure. This menu provides access to the following administration features: AdminExportType, AdminLabelField, AdminLabelType, AdminRebuild, AdminReportType, AdminSecurity, AdminTableAlias, AdminTableRelations, and AdminWhere.

Requirements: None.

Default Menu Label: Query → Site Admin

Default Tool Bar Icon: None. Not on the default tool bar.

AdminTableAlias

Displays the Table Alias dialog box. This dialog box allows you to define or delete aliases for tables in the connected databases.

Requirements: None.

Default Menu Label: Query → Site Admin → Table Aliases

Default Tool Bar Icon: None. Not on the default tool bar.

AdminTableRelations

Displays the Table Relationships dialog box. This dialog box allows you to define or limit relationships between tables in the connected databases.

Requirements: None.

Default Menu Label: Query → Site Admin → Table Relationships

Default Tool Bar Icon: None. Not on the default tool bar.
AdminToolBarEdit
Displays the **ToolBar Layout** dialog box. This dialog box allows you to add and delete icons on the Results tool bar. You can also use this feature to redefine the features associated with icons on the Results tool bar.

**Requirements:** None.

**Default Menu Label:** Query → Customize → Tool Bar Layout

**Default Tool Bar Icon:** None. Not on the default tool bar.

AdminWhere
Displays the **Table Data Selection** dialog box. This dialog box allows you to define static selection criteria (WHERE clause) for tables in the connected database to limit access to the data stored in those tables. The static selection criteria specified for a table executes every time you access a record in the table.

**Requirements:** None.

**Default Menu Label:** Query → Site Admin → Table Data Selection

**Default Tool Bar Icon:** None. Not on the default tool bar.

Array
Displays the **Stack Array** dialog box. This dialog box allows you to format a stacked array.

**Requirements:** Active query.

**Default Menu Label:** Field → Add Calculated Field → Stacked Array

**Default Tool Bar Icon:** None. Not on the default tool bar.
BrowseView

Displays the current query, as in the browse view format.

Requirements: Active query.

Default Menu Label: View → As Browse

Default Tool Bar Icon:

CalcSubMenu

Represents the Add Calculated Field submenu and cannot be executed from a feature procedure using the API sffire.p procedure. This menu provides access to the following features: PercentTotal, RunningTotal, Counter, Array, Lookup, Math, StringFunc, NumericFunc, DateFunc, and LogicalFunc.

Requirements: Active query.

Default Menu Label: Field → Add Calculated Field

Default Tool Bar Icon: None. Not on the default tool bar.

Counter

Displays the Counter dialog box. This dialog box allows you to define a counter field for the current query.

Requirements: Active query and any view format except the label view.

Default Menu Label: Field → Add Calculated Field → Counter

Default Tool Bar Icon: None. Not on the default tool bar.
CustomLabel

Displays the Custom Label dialog box. This dialog box allows you to define the dimensions of the label view for the active query.

Requirements: Active query and the label view.

Default Menu Label: Options→ Custom Label

Default Tool Bar Icon: None. Not on the default tool bar.

CustomReport

Displays the Custom Page Size dialog box. This dialog box allows you to define line spacing, column spacing, page length, left margin, and lines between the report sections for the report view of the active query.

Requirements: Active query and the report view.

Default Menu Label: Options→ Custom Page Size

Default Tool Bar Icon: None. Not on the default tool bar.

DataGovernor

Displays the Data Governor dialog box. This dialog box allows you to limit the number of records a query displays.

Requirements: Active query.

Default Menu Label: Data→ Governor

Default Tool Bar Icon: None. Not on the default tool bar.
DateFunc

Displays the Date Function dialog box. This dialog box allows you to define an expression that yields a date value represented by a field in the active query.

Requirements: Active query.

Default Menu Label: Field→Add Calculated Field→Date Function

Default Tool Bar Icon: None. Not on the default tool bar.

Exit

Exits Results. If you modified the active query and did not save it, this feature displays an alert box notifying you of the changes and prompting you to save your changes to the query. Exit behavior is governed by the AdminCustomizeInterface feature.

Requirements: None.

Default Menu Label: Query→Exit

Default Tool Bar Icon: None. Not on the default tool bar.

ExportSubMenu

This feature represents the Custom Export submenu and cannot be executed from a feature procedure using the API sffire.p procedure. This menu provides access to the following custom export features: FieldDelimiters, FieldSeparators, FixedWidthFields, OutputHeaderRecord, RecordEnd, and RecordStart.

Requirements: Active query and the export view.

Default Menu Label: Options→Custom Export

Default Tool Bar Icon: None. Not on the default tool bar.
ExportView

Displays the current query, as in the export view format.

Requirements: Active query.

Default Menu Label: View → As Export

Default Tool Bar Icon:

FieldDelimiters

Displays the Field Delimiters dialog box. This dialog box allows you to specify the delimiter characters for fields in a data export. Delimiter characters begin and end each field in the export.

Requirements: Active query and the export view.

Default Menu Label: Options → Custom Export → Field Delimiters

Default Tool Bar Icon: None. Not on the default tool bar.

FieldProperties

Displays the Properties dialog box. This dialog box allows you to manipulate the display format, label, any underlying expression of a field in the active query.

Requirements: Active query and any view format except the label view.

Default Menu Label: Field → Properties

Default Tool Bar Icon: None. Not on the default tool bar.
Fields

Displays the **Add/Remove Fields** dialog box for the active query in the browse, form, report, or export view. The **Add/Remove Fields** dialog box allows you to redefine the fields included in the active query. The Fields feature displays the **Label Layout** dialog box for the active query in the label view. This feature requires an active query in Results.

**Requirements:** Active query.

**Default Menu Label:** Field → Add/Remove Fields

**Default Tool Bar Icon:** None. Not on the default tool bar.

FieldSeparators

Displays the **Field Separators** dialog box. This dialog box allows you to specify the character used to separate the fields of a data export.

**Requirements:** Active query and the export view.

**Default Menu Label:** Options → Custom Export → Field Separators

**Default Tool Bar Icon:** None. Not on the default tool bar.

FileClose

Closes the active query. If the active query is new or has some unsaved modifications, Results uses an alert box to prompt you to save the active query.

**Requirements:** Active query.

**Default Menu Label:** Query → Close

**Default Tool Bar Icon:** None. Not on the default tool bar.
**FileDelete**

Displays the **Delete** dialog box. This dialog box displays a list of queries defined in the current query directory. You can select one or more queries to delete.

**Requirements:** None.

**Default Menu Label:** Query→Delete

**Default Tool Bar Icon:** None. Not on the default tool bar.

**FileOpen**

Displays the **Open** dialog box. This dialog box allows you to select a query to open from the current query directory, a public query directory, or a query directory of another user. The FileOpen feature closes an existing active query prior to opening a new query.

**Requirements:** None.

**Default Menu Label:** Query→Open

**Default Tool Bar Icon:**

![Folder Icon](image)

**FileSave**

Saves the active query in the current query directory. If the active query is new, Results displays the **Save As** dialog box to allow you to name and save the active query.

**Requirements:** Active query.

**Default Menu Label:** Query→Save

**Default Tool Bar Icon:**

![Folder Icon](image)
Results Features

**FileSaveAs**

Displays the Save As dialog box. This dialog box allows you to save the active query under a specified name in the current query directory.

**Requirements:** Active query.

**Default Menu Label:** Query→Save As

**Default Tool Bar Icon:** None. Not on the default tool bar.

**FixedWidthFields**

Toggles between fixed and variable field lengths for data export operations. In a variable-length data export, the length of the data within a column varies across the rows in the export. The maximum width of the data in the column is governed by the Format phrase specified for the column in the OpenEdge Data Dictionary. In a fixed-width data export, the character length within columns is constant across the rows in the export. The maximum width of the data in the column is governed by the Format phrase specified for the column in the OpenEdge Data Dictionary. Values that do not fill the maximum width are padded with trailing space characters.

**Requirements:** Active query and the export view.

**Default Menu Label:** Options→Custom Export→Fixed-width Fields

**Default Tool Bar Icon:** None. Not on the default tool bar.

**FormView**

Displays the current query as in the form view format.

**Requirements:** Active query.

**Default Menu Label:** View→As Form

**Default Tool Bar Icon:**
**FrameProperties**

Displays the **Frame Properties** dialog box. This dialog box allows you to specify a title and the vertical position of a frame associated with the browse view or form view of an active query. You can also use the **Frame Properties** dialog box to arrange multiple frames on the display and to designate a frame as read only.

**Requirements:** Active query and the form view or the browse view.

**Default Menu Label:** Options→Frame Properties

**Default Tool Bar Icon:** None. Not on the default tool bar.

**Generate**

Displays the **Generate 4GL** dialog box. This dialog box allows you to specify the name of an ASCII file to contain the stand-alone Progress source code generated for the active query and view in the Results product.

**Requirements:** Active query.

**Default Menu Label:** Query→Generate

**Default Tool Bar Icon:** None. Not on the default tool bar.

**HeadersAndFooters**

Displays the **Headers and Footers** dialog box. This dialog box allows you to position, format, and edit the content of report headers and footers.

**Requirements:** Active query and the report view.

**Default Menu Label:** Options→Headers and Footers

**Default Tool Bar Icon:** None. Not on the default tool bar.
HelpContents

Displays the main table of contents topic of the Results help file in the help viewer.

Requirements: None.

Default Menu Label: Help → Contents

Default Tool Bar Icon: None. Not on the default tool bar.

HelpSearch

Displays the Search dialog box of the help viewer. This dialog box allows you to search for help information using keywords.

Requirements: None.

Default Menu Label: Help → Search for Help On

Default Tool Bar Icon: None. Not on the default tool bar.

Includes

Displays the Available Table dialog box followed by the Insert Code dialog box. The Available Table dialog box allows you to select a table referenced in the active query. Once you select a table, the Insert Code dialog box allows you to specify Progress code to insert after the FOR statement associated with the selected table in the active query.

Requirements: Active query.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.
**Information**

Displays the **Query Information** dialog box. This dialog box displays information about the active query, including the tables and fields referenced in the query.

**Requirements**: Active query.

**Default Menu Label**: Options → Query Information

**Default Tool Bar Icon**: None. Not on the default tool bar.

**Joins**

Displays the **Relationship Types** dialog box to define the characteristics of a join in the active query.

**Requirements**: Active query with at least two tables.

**Default Menu Label**: Table → Relationship Types

**Default Tool Bar Icon**: None. Not on the default tool bar.

**LabelView**

Displays the label view associated with the active query.

**Requirements**: Active query.

**Default Menu Label**: View → As Label

**Default Tool Bar Icon**: 

![Label View Icon](image)
LogicalFunc

Displays the Logical Function dialog box. This dialog box allows you to define an expression that yields a logical value represented by a field in the active query.

Requirements: Active query.

Default Menu Label: Field→ Add Calculated Field→ Logical Function

Default Tool Bar Icon: None. Not on the default tool bar.

Lookup

Displays the Lookup Source Field dialog box. This dialog box allows you to define a lookup field to display in the active query. A lookup field is a field in the active query that you can use to establish a one-to-one relationship with a new table not in the active query to display one or more fields from the new table as part of the active query.

Requirements: Active query.

Default Menu Label: Field→ Add Calculated Field→ Lookup Field

Default Tool Bar Icon: None. Not on the default tool bar.

MasterDetail

Displays the Master-Detail dialog box. This dialog box allows you to set a visual break point between tables on a report, browse, or form view.

Requirements: Active query with at least two tables and the browse, form, or report view.

Default Menu Label: Options→ Master-Detail

Default Tool Bar Icon: None. Not on the default tool bar.
Math

Displays the Math dialog box. This dialog box allows you to define an expression that yields a numeric value represented by a field in the active query.

Requirements: Active query.

Default Menu Label: Field → Add Calculated Field → Math

Default Tool Bar Icon: None. Not on the default tool bar.

Messages

Displays the Messages dialog box. This dialog box allows you to get information about a specified Progress error message.

Requirements: None.

Default Menu Label: Help → Messages

Default Tool Bar Icon: None. Not on the default tool bar.

NewBrowseView

Displays the Add/Remove Tables dialog box to allow you to define a new query and display it in the browse view.

Requirements: None.

Default Menu Label: Query → New → Browse

Default Tool Bar Icon: None. Not on the default tool bar.
NewDuplicateView

Displays the Add/Remove Tables dialog box to allow you to define a new query. The query appears on the display in the view mode of the last active query.

Requirements: Active query.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon:

NewExportView

Displays the Add/Remove Tables dialog box to allow you to define a new query and display it in the export view.

Requirements: None.

Default Menu Label: Query→ New→ Export

Default Tool Bar Icon: None. Not on the default tool bar.

NewFormView

Displays the Add/Remove Tables dialog box to allow you to define a new query and display it in the form view.

Requirements: None.

Default Menu Label: Query→ New→ Form

Default Tool Bar Icon: None. Not on the default tool bar.
NewLabelView

Displays the Add/Remove Tables dialog box to allow you to define a new query and display it in the label view.

Requirements: None.

Default Menu Label: Query → New → Label

Default Tool Bar Icon: None. Not on the default tool bar.

NewReportView

Displays the Add/Remove Tables dialog box to allow you to define a new query and display it in the report view.

Requirements: None.

Default Menu Label: Query → New → Report

Default Tool Bar Icon: None. Not on the default tool bar.

NewSubMenu

Provides access to the following features: NewBrowseView, NewExportView, NewFormView, NewLabelView, and NewReportView. This feature represents the New submenu and cannot be executed from a feature procedure using the API sffire.p procedure.

Requirements: None.

Default Menu Label: Query → New

Default Tool Bar Icon: None. Not on the default tool bar.
NumericFunc
Displays the Numeric Function dialog box. This dialog box allows you to define an expression that yields a numeric value represented by a field in the active query.

Requirements: Active query.
Default Menu Label: Field → Add Calculated Field → Numeric Function
Default Tool Bar Icon: None. Not on the default tool bar.

OutputHeaderRecord
Toggles Output Headers on or off for data export operations.

Requirements: Active query and the export view.
Default Menu Label: Options → Custom Export → Output Header Record
Default Tool Bar Icon: None. Not on the default tool bar.

PageBreak
Displays the Page Break dialog box. This dialog box allows you to select a previously defined sort field in the active query to govern page breaks.

Requirements: Active query with sorted fields and the report view.
Default Menu Label: Options → Page Break
Default Tool Bar Icon: None. Not on the default tool bar.

PercentTotal
Displays the Percent of Total dialog box. This dialog box allows you to select a numeric field from a table defined in the active query to be used in a percentage of total calculation.

Requirements: Active query.
Default Menu Label: Field → Add Calculated Field → Percent of Total
Default Tool Bar Icon: None. Not on the default tool bar.
PrintClip

Executes the active query and sends the output to the system clipboard.

Requirements: Active query.

Default Menu Label: Query→Print→To Clipboard

Default Tool Bar Icon: None. Not on the default tool bar.

PrintFile

Displays the Output to File dialog box. This dialog box allows you to specify the name of an ASCII file. Once you specify an output file, the active query executes and the output goes to that file.

Requirements: Active query.

Default Menu Label: Query→Print→To File

Default Tool Bar Icon: None. Not on the default tool bar.

PrintPreview

Executes the active query and displays the output on screen in the Print Preview dialog box.

Requirements: Active query.

Default Menu Label: Query→Print Preview

Default Tool Bar Icon:
PrintPrinter

Executes the active query and prints the query output. In Windows, this feature displays the Print dialog box to allow the user to specify a different printer.

Requirements: Active query.

Default Menu Label: Query → Print → To Printer

Default Tool Bar Icon: None. Not on the default tool bar.

PrintPrinterNoBox

Executes the active query and prints the query output to the default system printer. In Windows, this feature sends the output to the default system printer.

Requirements: Active query.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon:

PrintSubMenu

Provides access to the following features: PrintClip, PrintFile, and PrintPrinter. This feature represents the Print submenu and cannot be executed from a feature procedure using the API sffire.p procedure.

Requirements: Active query.

Default Menu Label: Query → Print

Default Tool Bar Icon: None. Not on the default tool bar.
ProgrammingSubMenu

Provides access to the following features: AdminCustomizeInterface, AdminDeployment, AdminFeatures, AdminIntegration, AdminMenuEdit, AdminReset, and AdminToolBarEdit. This feature represents the Customize submenu and cannot be executed from a feature procedure using the API sffire.p procedure.

Requirements: Active query.

Default Menu Label: Query → Customize

Default Tool Bar Icon: None. Not on the default tool bar.

ReadOtherDirectory

No functionality associated with this feature. The primary use for this feature is to provide control over user access to query directories through the Feature Security mechanism. It is not designed for use with the API sffire.p procedure.

Requirements: None.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.

ReadPublicDirectory

No functionality associated with this feature. The primary use for this feature is to provide control over user access to query directories through the Feature Security mechanism. It is not designed for use with the API sffire.p procedure.

Requirements: None.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.
ReAsk

Displays the **Ask At Run Time** dialog box to prompt for a value to use in the selection criteria associated with the current query.

**Requirements:** Active query with defined selection criteria that prompts for a value at run time (Ask At Run Time). The current view must be the browse or form view.

**Default Menu Label:** Data → Re-ask Questions

**Default Tool Bar Icon:** None. Not on the default tool bar.

RecentMessages

Displays the **Recent Messages** dialog box. This dialog box allows you to get information about recent Progress error messages.

**Requirements:** None.

**Default Menu Label:** Help → Recent → Messages

**Default Tool Bar Icon:** None. Not on the default tool bar.

RecordAdd

No functionality associated with this feature. Use this feature to allow or deny a user, through the Feature Security mechanism, permission to add database records using a Results query in the form view. It is not designed for use with the API sffir.ep procedure.

**Requirements:** None.

**Default Menu Label:** None. Not in the default menu system.

**Default Tool Bar Icon:** None. Not on the default tool bar.
**RecordDelete**

No functionality associated with this feature. Use this feature to allow or deny a user, through the Feature Security mechanism, permission to delete database records using a Results query in the form view. It is not designed for use with the API `sffire.p` procedure.

**Requirements:** None.

**Default Menu Label:** None. Not in the default menu system.

**Default Tool Bar Icon:** None. Not on the default tool bar.

**RecordEnd**

Displays the **Record End** dialog box. This dialog box allows you to specify the character used to signal the end of a record in the output of a data export operation.

**Requirements:** Active query and the export view.

**Default Menu Label:** Options → Custom Export → Record End

**Default Tool Bar Icon:** None. Not on the default tool bar.

**RecordStart**

Displays the **Record Start** dialog box. This dialog box allows you to specify the character used to signal the start of a record in the output of a data export operation.

**Requirements:** Active query and the export view.

**Default Menu Label:** Options → Custom Export → Record Start

**Default Tool Bar Icon:** None. Not on the default tool bar.
**RecordUpdate**

No functionality associated with this feature. Use this feature to allow or deny a user, through the Feature Security mechanism, permission to update database records using a Results query in the form view. It is not designed for use with the API `sffire.p` procedure.

**Requirements:** None.

**Default Menu Label:** None. Not in the default menu system.

**Default Tool Bar Icon:** None. Not on the default tool bar.

**ReportView**

Displays the report view associated with the active query.

**Requirements:** Active query.

**Default Menu Label:** View → As Report

**Default Tool Bar Icon:**

![Report View Icon](image)

**RunningTotal**

Displays the Running Totals dialog box. This dialog box allows you to select a database field from a table in the active query and use it to define a calculated field that will keep a running total for the selected database field across the records returned in the active query.

**Requirements:** Active query.

**Default Menu Label:** Field → Add Calculated Field → Running Total

**Default Tool Bar Icon:** None. Not on the default tool bar.
Selection

Displays the Available Tables dialog box. From this dialog box, you can select a table in the active query and construct a WHERE clause that refines the data selection criteria associated with the selected table.

Requirements: Active query.

Default Menu Label: Data→Selection

Default Tool Bar Icon:

SortOrdering

Displays the Sort Order Fields dialog box. This dialog box allows you to select the fields to use when sorting the data output of the active query.

Requirements: Active query.

Default Menu Label: Data→Sort Ordering

Default Tool Bar Icon:

StandardExport

Displays the Standard Export dialog box containing a list of predefined export formats. This dialog box allows you to select and assign a predefined export format for the export view of the active query.

Requirements: Active query and the export view.

Default Menu Label: Options→Standard Export

Default Tool Bar Icon: None. Not on the default tool bar.
StandardLabel

Displays the **Standard Label** dialog box containing a list of predefined label formats. This dialog box allows you to select and assign a predefined label format for the label view of the active query.

**Requirements:** Active query and the label view.

**Default Menu Label:** Options → Standard Label

**Default Tool Bar Icon:** None. Not on the default tool bar.

StandardReport

Displays the **Standard Page Size** dialog box containing a list of predefined page sizes. This dialog box allows you to select and assign a predefined page size for the report view of the active query.

**Requirements:** Active query and report view.

**Default Menu Label:** Options → Standard Page Size

**Default Tool Bar Icon:** None. Not on the default tool bar.

StatusLine

Toggles the display of the status line located at the bottom of the Results application window.

**Requirements:** Active query.

**Default Menu Label:** View → Status Line

**Default Tool Bar Icon:** None. Not on the default tool bar.
**StringFunc**

Displays the **String Function** dialog box. This dialog box allows you to define an expression that yields a character value represented by a field in the active query.

**Requirements:** Active query.

**Default Menu Label:** Field → Add Calculated Field → String Function

**Default Tool Bar Icon:** None. Not on the default tool bar.

**Tables**

Displays the **Add/Remove Tables** dialog box. This dialog box allows you to insert or remove tables from the active query.

**Requirements:** Active query.

**Default Menu Label:** Table → Add/Remove Tables

**Default Tool Bar Icon:** None. Not on the default tool bar.

**ToolBar**

Toggles the display of the tool bar located underneath the menu bar of the Results application window.

**Requirements:** Active query.

**Default Menu Label:** View → Tool Bar

**Default Tool Bar Icon:** None. Not on the default tool bar.
Totals

Displays the Field Aggregates dialog box. This dialog box allows you to select a field defined for the active query and define a totals operation for the selected field. You can specify the total for the field to display after a break group or in the summary section of the report output.

Requirements: Active query and the report view.

Default Menu Label: Field → Aggregates

Default Tool Bar Icon: None. Not on the default tool bar.

TotalsOnly

Displays the Totals Only Summary dialog box. This dialog box allows you to define report sections as summarized. You can select one or more fields to summarize based on the last field chosen in the sort list of the active query.

Requirements: Active query with sorted fields and the report view.

Default Menu Label: Options → Totals Only Summary

Default Tool Bar Icon: None. Not on the default tool bar.

WriteOtherDirectory

No functionality associated with this feature. The primary use for this feature is to provide control over user access to query directories through the Feature Security mechanism. It is not designed for use with the API sffire.p procedure.

Requirements: None.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.
WritePublicDirectory

No functionality associated with this feature. The primary use for this feature is to provide control over user access to query directories through the Feature Security mechanism. It is not designed for use with the API sffire.p procedure.

Requirements: None.

Default Menu Label: None. Not in the default menu system.

Default Tool Bar Icon: None. Not on the default tool bar.
This appendix identifies the limits that exist within Results. This appendix presents:

- Results limitations
- Additional information
Results limitations

This section presents limitations for the following Results functionality:

- Views
- Queries
- Miscellaneous

Results views limitations

Table B–1 lists the limitations for Results views.

Table B–1: View limitations

<table>
<thead>
<tr>
<th>–</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines in a mailing label</td>
<td>1-66.</td>
</tr>
<tr>
<td>Fields in a browse, form, report, or export view</td>
<td>1-64.</td>
</tr>
<tr>
<td>Header and footer lines</td>
<td>1-8 per position.</td>
</tr>
</tbody>
</table>

Results queries limitations

Table B–2 lists the limitations for Results queries.

Table B–2: Query limitations

<table>
<thead>
<tr>
<th>–</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters in a query name</td>
<td>1-48.</td>
</tr>
<tr>
<td>Fields in a query</td>
<td>1-64.</td>
</tr>
<tr>
<td>Query definitions in a single query directory (qd7) file</td>
<td>1-256.</td>
</tr>
<tr>
<td>Query source files (que####.p) in a single operating system directory</td>
<td>1-99,999.</td>
</tr>
</tbody>
</table>
Results Limits

Table B–2: Query limitations

<table>
<thead>
<tr>
<th>—</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>QD7 files in a single operating system directory</td>
<td>1-390.</td>
</tr>
<tr>
<td>Sort fields per table</td>
<td>1-16.</td>
</tr>
<tr>
<td>Characters in the selection criteria (WHERE clause) of a table</td>
<td>Based on Stash Area (-stsh) parameter value (1-31, default 2) or Stack Size (-s) parameter value (3-63, default 63).</td>
</tr>
<tr>
<td>Stored custom table relationships (WHERE relationships)</td>
<td>Available disk space.</td>
</tr>
<tr>
<td>Stored natural table relationships</td>
<td>Available disk space.</td>
</tr>
<tr>
<td>Table WHERE clauses</td>
<td>Available disk space.</td>
</tr>
</tbody>
</table>

Table B–2: Query limitations (2 of 2)

Miscellaneous Results limitations

Table B–3 lists miscellaneous Results limitations.

Table B–3: Miscellaneous limitations

<table>
<thead>
<tr>
<th>—</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Preview pages</td>
<td>1-1,024.</td>
</tr>
<tr>
<td>Printers</td>
<td>Feature memory space.</td>
</tr>
<tr>
<td>Databases</td>
<td>Up to 32K (size of character fields).</td>
</tr>
<tr>
<td>Fields in field picker</td>
<td>1-512 per table.</td>
</tr>
<tr>
<td>Tool bar icons</td>
<td>1-14.</td>
</tr>
</tbody>
</table>
Additional information

Table B–4 identifies information on other limits and notes where to find details about a topic in the OpenEdge documentation set.

<table>
<thead>
<tr>
<th>For details about...</th>
<th>See the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database limits—length limits for names</td>
<td><em>OpenEdge Data Management: Database Administration</em></td>
</tr>
<tr>
<td>Data value limits</td>
<td><em>OpenEdge Development: ABL Reference</em></td>
</tr>
<tr>
<td>Progress Procedure Editor limits</td>
<td><em>OpenEdge Development: Basic Development Tools</em> (Character only; information for Windows is in online help)</td>
</tr>
<tr>
<td>Client input/output and sorting limits; name-length limits; compiler limits</td>
<td><em>OpenEdge Deployment: Managing ABL Applications</em></td>
</tr>
</tbody>
</table>

Table B–5 lists the limitations for Results queries.

Table B–5: Query limitations *(1 of 2)*

<table>
<thead>
<tr>
<th>Limitations</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters in a query name</td>
<td>1-48.</td>
</tr>
<tr>
<td>Fields in a query</td>
<td>1-64.</td>
</tr>
<tr>
<td>Query definitions in a single query directory (qd7) file</td>
<td>1-256.</td>
</tr>
<tr>
<td>Query source files (<em>que#####.p</em>) in a single operating system directory</td>
<td>1-99,999.</td>
</tr>
<tr>
<td>QD7 files in a single operating system directory</td>
<td>1-390.</td>
</tr>
<tr>
<td>Sort fields per table</td>
<td>1-16.</td>
</tr>
<tr>
<td>Characters in the selection criteria (<em>WHERE</em> clause) of a table</td>
<td>Based on Stash Area (-stsh) parameter value (1-31, default 2) or Stack Size (-s) parameter value (3-63, default 63).</td>
</tr>
</tbody>
</table>
Table B–5: Query limitations

<table>
<thead>
<tr>
<th>-</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored custom table relationships (WHERE relationships)</td>
<td>Available disk space.</td>
</tr>
<tr>
<td>Stored natural table relationships</td>
<td>Available disk space</td>
</tr>
<tr>
<td>Table WHERE clauses</td>
<td>Available disk space</td>
</tr>
</tbody>
</table>

Table B–6 lists miscellaneous Results limitations.

Table B–6: Miscellaneous limitations

<table>
<thead>
<tr>
<th>-</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Preview pages</td>
<td>1-1,024.</td>
</tr>
<tr>
<td>Printers</td>
<td>Feature memory space.</td>
</tr>
<tr>
<td>Databases</td>
<td>Up to 32K (size of character fields).</td>
</tr>
<tr>
<td>Fields in field picker</td>
<td>1-512 per table.</td>
</tr>
<tr>
<td>Tool bar icons</td>
<td>1-14.</td>
</tr>
</tbody>
</table>
This appendix provides information about important files associated with the Results product. This appendix presents:

- Results-generated files
- Editing the results.l file
- Editing a QC7 file
- Editing a QD7 file
- Editing user interface and feature files
## Results-generated files

Table C–1 describes the files generated by Results.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>database.qc7</td>
<td>A query configuration file (QC7). The query configuration file contains the default file relationships, security settings, label settings, data export settings, and report settings for a Results application. The <code>database</code> value is the name of the first application database connected for the Results application. Results cannot run without the QC7 file. For more information about query configuration files, see Chapter 2, “Administering Results.” This appendix provides information about editing a QC7 file.</td>
</tr>
<tr>
<td>database.r</td>
<td>The main fastload procedure for a Results application. The fastload system optimizes the loading of information from the current QC7 file into Results at startup. The <code>database</code> value is the base string specified in the Deployment dialog box for the generation of fastload files for a Results application. The default base string is the first five characters of the database name used to name the current QC7 file. For more information about the fastload system for a Results application, see Chapter 3, “Programming Results.”</td>
</tr>
<tr>
<td>base###.r</td>
<td>Secondary fastload files. Base is the base string specified in the Deployment dialog box for the generation of fastload files for a Results application. The default base string is the first five characters of the database name used to name the current QC7 file.</td>
</tr>
<tr>
<td>basef.p</td>
<td>The feature files of a Results application. The feature file is a Progress procedure file in the fastload system that defines and loads features into Results at startup. The basef.r file is not a compiled version of the basef.p file. It is optimized for fast loads and accesses internal data structures of the Results product. The source code in the basef.p file performs that same function as the basef.r file, only slower. It is supplied to support the deployment process of a Results application. For more information about the fastload system for a Results application, see Chapter 3, “Programming Results.”</td>
</tr>
</tbody>
</table>
### Table C–1: Files generated by Results

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>basemt.p</td>
<td>The user interface (UI) files of a Results application. The UI file is a Progress procedure file in the fastload system that configures the menu system and tool bar of Results at startup. The basemt.r file is not a compiled version of the basemt.p file. It is optimized for fast loads and accesses internal data structures of the Results product. The source code in the basemt.p file performs the same function as the basemt.r file, only slower. It is supplied to support the deployment process of a Results application. For more information about the fastload system for a Results application, see Chapter 3, “Programming Results.”</td>
</tr>
<tr>
<td>public.qd7</td>
<td>Query directory files. The public query directory (public.qd7) contains query definitions accessible by all or a select group of users. Results also automatically generates a query directory to store the query definitions of a user (userid.qd7). It uses the user’s user ID to name the query directory file. For users who have the blank user ID, Results creates the results.qd7 query directory file to store the query definitions of that user.</td>
</tr>
<tr>
<td>userid.qd7</td>
<td></td>
</tr>
<tr>
<td>results.qd7</td>
<td></td>
</tr>
<tr>
<td>que#####.p</td>
<td>Source files for query definitions in the query definitions files located in the current directory. Results creates query source files in the directory that contains the corresponding query definition. Query source files are five-digit numbers (#####). Results uses these numbers to maintain the queries. If you delete a query source file, you cannot open the corresponding query in Results.</td>
</tr>
<tr>
<td>database.q1</td>
<td>A query log file. Results uses this file to record status and error messages that occur when you build the query configuration file or open a query. For more information about the query log file, see Chapter 2, “Administering Results.”</td>
</tr>
<tr>
<td>base.txt</td>
<td>The deployment report for a Results application. This file lists the files to deploy for a Results application. Base is the base string specified in the Deployment dialog box for the generation of fastload files for a Results application. For more information about the deployment report, see Chapter 4, “Deploying Results Applications.”</td>
</tr>
<tr>
<td>_qbf####.d _qbfq####.p _qbf####.p temp.p</td>
<td>Temporary files that Results uses to store information. As you exit Results, it automatically deletes these files. But if your system crashes, they could remain on your disk. You can delete them manually.</td>
</tr>
</tbody>
</table>
Editing the results.l file

The results.l file resides in the aderes directory in the Progress product directory ($DLC\GUI). It contains the following default site settings:

- Characters used to delimit fields in address labels and functions in report headers and footers.
- Standard export format definitions used in the export view of a query.
- Standard label format definitions used in the label view of a query.
- Standard page size definitions used in the report view of a query.

Results uses the results.l file to perform the initial build of a QC7 file for a user site. The default settings in the results.l file are transferred directly to the QC7 file during the build. For more information about the results.l and QC7 files, see Chapter 2, “Administering Results.”

The following sections provide more information about the default settings in the results.l file. You can use this information to change the delimiter characters and implement new export, label, and page formats.

**Note:** If you introduce errors into the results.l file, you might encounter problems during the initial build of a QC7 file. Avoid editing existing export, label, and page formats.

Delimiter characters

By default, Results uses curly braces { } to delimit functions in report headers and footers. It also uses braces to delimit the fields in address, and other, labels. You can change these default settings by editing the results.l file before you perform the initial build. For example, seven-bit character sets use the curly braces for special characters, so you can change the results.l file to specify angle brackets < > as delimiter characters.
To change these delimiter characters, edit the following lines in the `results.l` file before the initial build:

```
left-delim= "{"  
right-delim= "}"  
```

**Note:** Do not specify the same character for the left and right delimiter. You can use square brackets `[ ]` as long as there are no arrays within your reports or labels. You cannot use parentheses `( )` because they interfere with the label generation code.

### Standard export formats

The `results.l` file contains several lines that define the standard export formats available for use in the export view of a query. Each line that defines an export format has the following syntax:

**Syntax**

```
export[integer]= "code [ code ] . . ."  
```

The `integer` argument is a unique integer value that identifies the export format definition. The integers used to identify export formats must be sequential. The `code` parameter followed by a value defines the export format. All codes specified for an export format must be enclosed within a single set of double quotes and must be separated using a vertical line (|). Table C–2 provides information about the different definitional codes for an export format.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1=</td>
<td>Specifies an integer representing the ASCII value of a character to start each line of the export. If you want to specify more than one character, specify a comma-separated list of integers. There is no default character for this setting.</td>
</tr>
<tr>
<td>2=</td>
<td>Specifies an integer representing the ASCII value of a character to end each line of the export. If you want to specify more than one character, specify a comma-separated list of integers. There is no default character for this setting.</td>
</tr>
</tbody>
</table>
3= Specifies an integer representing the ASCII value of a character to delimit each field of the export. If you want to specify more than one character, specify a comma-separated list of integers. There is no default character for this setting.

4= Specifies an integer representing the ASCII value of a character to separate each field in a line of the export. If you want to specify more than one character, specify a comma-separated list of integers. There is no default character for this setting.

b= Specifies the base date for a DIF export. The default value is the unknown value (?). If you do not specify a base date, then all dates are exported as character values.

d= Specifies the data types to delimit as fields using the characters specified with the “3=” code. Data type specifications are represented as integer values.

1 CHARACTER
2 DATE
3 LOGICAL
4 INTEGER
5 DECIMAL
6 RAW
7 RECID

Do not separate data type integers with commas or spaces. For example, d=123 specifies the CHARACTER, DATE, and LOGICAL data types. The default value is an asterisk (*), representing all data types.

f= Specifies “y” for a fixed width export. The default value is “n” for a variable-width export.

h= Specifies “y” to include field headers in the export. The default value is “n.”

i= Specifies “y” if the export program (p=) requires a prepass to count records. The default value is “n.”

l= Specifies a label for the export format. This label represents the format in Results.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3=</td>
<td>Specifies an integer representing the ASCII value of a character to delimit each field of the export. If you want to specify more than one character, specify a comma-separated list of integers. There is no default character for this setting.</td>
</tr>
<tr>
<td>4=</td>
<td>Specifies an integer representing the ASCII value of a character to separate each field in a line of the export. If you want to specify more than one character, specify a comma-separated list of integers. There is no default character for this setting.</td>
</tr>
<tr>
<td>b=</td>
<td>Specifies the base date for a DIF export. The default value is the unknown value (?). If you do not specify a base date, then all dates are exported as character values.</td>
</tr>
<tr>
<td>d=</td>
<td>Specifies the data types to delimit as fields using the characters specified with the “3=” code. Data type specifications are represented as integer values.</td>
</tr>
<tr>
<td></td>
<td>1 CHARACTER</td>
</tr>
<tr>
<td></td>
<td>2 DATE</td>
</tr>
<tr>
<td></td>
<td>3 LOGICAL</td>
</tr>
<tr>
<td></td>
<td>4 INTEGER</td>
</tr>
<tr>
<td></td>
<td>5 DECIMAL</td>
</tr>
<tr>
<td></td>
<td>6 RAW</td>
</tr>
<tr>
<td></td>
<td>7 RECID</td>
</tr>
<tr>
<td></td>
<td>Do not separate data type integers with commas or spaces. For example, d=123 specifies the CHARACTER, DATE, and LOGICAL data types. The default value is an asterisk (*), representing all data types.</td>
</tr>
<tr>
<td>f=</td>
<td>Specifies “y” for a fixed width export. The default value is “n” for a variable-width export.</td>
</tr>
<tr>
<td>h=</td>
<td>Specifies “y” to include field headers in the export. The default value is “n.”</td>
</tr>
<tr>
<td>i=</td>
<td>Specifies “y” if the export program (p=) requires a prepass to count records. The default value is “n.”</td>
</tr>
<tr>
<td>l=</td>
<td>Specifies a label for the export format. This label represents the format in Results.</td>
</tr>
</tbody>
</table>
The following excerpt from the result.1 file shows some export format definitions:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>p=</td>
<td>Specifies the name of the procedure that generates the export. Results currently supports the following export procedures:</td>
</tr>
<tr>
<td></td>
<td>e-pro</td>
</tr>
<tr>
<td></td>
<td>e-ascii</td>
</tr>
<tr>
<td></td>
<td>e-dif</td>
</tr>
<tr>
<td></td>
<td>e-sylk</td>
</tr>
<tr>
<td></td>
<td>The u-export.p procedure is a sample export procedure. See Chapter 3, “Programming Results,” for more information about this procedure.</td>
</tr>
<tr>
<td>t=</td>
<td>Specifies a name for the export format. Results uses this name to manage the format, so the name must be unique.</td>
</tr>
</tbody>
</table>

The following excerpt from the result.1 file shows some export format definitions:

<table>
<thead>
<tr>
<th>Sample Export Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>export[1]= &quot;t=PROGRESS</td>
</tr>
<tr>
<td>export[2]= &quot;t=ASCII</td>
</tr>
<tr>
<td>export[3]= &quot;t=ASCII-H</td>
</tr>
<tr>
<td>export[11]= &quot;t=DIF</td>
</tr>
<tr>
<td>export[15]= &quot;t=SYLK</td>
</tr>
</tbody>
</table>
Standard label formats

The results.l file contains several lines that define the standard label formats available for use in the label view of a query. Each line that defines a label format has the following syntax:

Syntax

\[
\text{label[integer]} = \ "code [ | code ] \ldots "
\]

The \text{integer} argument is a unique integer value that identifies the label format definition. The integers used to identify label formats must be sequential. The \text{code} parameter is a special code followed by a value that defines the label format. All codes specified for a label format must be enclosed within a single set of double quotes and must be separated using a vertical line (\mid). Table C–3 provides information about the different definitional codes for a label format.

Table C–3: Definitional codes for label formats

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a=</td>
<td>Specifies the number of labels across the printed page. The default value is 1.</td>
</tr>
<tr>
<td>c=</td>
<td>Specifies a name for the label format. This name represents the format in Results. Must be a unique name.</td>
</tr>
<tr>
<td>d=</td>
<td>Specifies the width and height of the label in inches. For example, 3-1/2 x 1. Separate the width and height values using an x. The width value must be first. Specifies fractional values by separating the numerator and denominator values with a forward slash (/). If the fractional value is preceded by a whole number, separate the whole number from the fraction using a hyphen (–).</td>
</tr>
<tr>
<td>h=</td>
<td>Specifies the height of the label in lines.</td>
</tr>
<tr>
<td>l=</td>
<td>Specifies the number of lines between labels. The default value is 1.</td>
</tr>
<tr>
<td>s=</td>
<td>Specifies the horizontal space between labels in characters. The default value is 0.</td>
</tr>
<tr>
<td>w=</td>
<td>Specifies the width of the label in characters.</td>
</tr>
<tr>
<td>x=</td>
<td>Specifies the left margin of the paper in characters. The default value is 0.</td>
</tr>
</tbody>
</table>
The following excerpt from the result.1 file shows some label format definitions:

```
label[1] = "Standard Label Sizes"
label[2] = "d=3-1/2 x 15/16 in|w=35|h=5|c=1-wide"
label[3] = "d=3-1/2 x 15/16 in|w=35|h=5|a=2|s=2|c=2-wide"
...
label[14] = "Avery Catalog Labels"
label[15] = "d=3-1/2 x 15/16 in|w=35|h=5|c=Avery 4145 Address"
lable[16] = "d=3-1/2 x 15/16 in|w=35|h=5|c=Avery 4010 Address (roll)"
```

If the first code parameter of a label format definition begins with an asterisk (*), Results ignores the definition and moves on to the next definition.

### Standard page formats

The results.1 file contains several lines that define the standard page formats available for use in the report view of a query. Each line that defines a page format has the following syntax:

**Syntax**

```
```

The `integer` argument is a unique integer value that identifies the page format definition. The integers used to identify page formats must be sequential. The `code` parameter is a special code followed by a value that defines the page format. All codes specified for a page format must be enclosed within a single set of double quotes and must be separated using a vertical line (|).
Table C–4 provides information about the different definitional codes for a page format.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Specifies a label for the page format. This label represents the format in Results. Must be a unique name.</td>
</tr>
<tr>
<td>d</td>
<td>Specifies the width and height of the label in inches (in) or millimeters (mm). For example, 210 x 297 mm or 3-1/2 x 1 in. Separate the width and height values using an x. The width value must be first. Specifies fractional values by separating the numerator and denominator with a forward slash ( / ). If the fractional value is preceded by a whole number, separate the whole number from the fraction using a hyphen (-).</td>
</tr>
<tr>
<td>h</td>
<td>Specifies the page height in lines.</td>
</tr>
<tr>
<td>w</td>
<td>Specifies the page width in characters.</td>
</tr>
</tbody>
</table>

The following excerpt from the result.l file shows some page format definitions:

```
page[1] = "d=8-1/2 x 11 in|w=85|h=66|c=Letter"
page[2] = "d=8-1/2 x 14 in|w=85|h=84|c=Legal"
page[3] = "d=11 x 17 in|w=110|h=102|c=Tabloid"
page[4] = "d=9-1/2 x 4-1/8 in|w=95|h=24|c=Envelope-#10"
page[5] = "d=229 x 162 mm|w=90|h=38|c=Envelope-C5"
page[6] = "d=220 x 110 mm|w=86|h=26|c=Envelope-DL"
page[7] = "d=7-1/2 x 3-7/8 in|w=75|h=23|c=Envelope-Monarch"
page[8] = "d=7-1/4 x 10-1/2 in|w=72|h=63|c=Executive"
page[9] = "d=297 x 420 mm|w=117|h=99|c=A3"
page[10] = "d=210 x 297 mm|w=82|h=70|c=A4"
page[11] = "d=148 x 210 mm|w=58|h=49|c=A5"
page[12] = "d=182 x 257 mm|w=71|h=60|c=A5"
page[13] = "d=7-1/3 x 11 in|w=73|h=66|c=35mm-Slide"
```
Editing a QC7 file

The QC7 file (query configuration file) contains information about table relationships, security, export formats, label formats, page formats, and so forth for a Results application. When you start Results with a database or set of databases for the first time, Results builds a QC7 file and names the file using the name of the first database connected (dbname.qc7).

By default, Results tries to create the QC7 file in the same directory that contains the first database connected. However, if the database is on another machine, Results might not be able to reach that directory. In that case, Results places the QC7 file in the current directory. Once Results creates the QC7 file, you can move it to any directory in the PROPATH. When you start Results, it first searches the current directory and then the directories of the PROPATH for a QC7 file. For Windows environments, the PROPATH environment variable is specified in the [Startup] section of the environment (.ini) file.

For more information about the PROPATH environment variable file, see OpenEdge Getting Started: Installation and Configuration.

The Query→ Site Admin and Query→ Customize menus allow you to interactively edit a QC7 file. As a general rule, you should not edit a QC7 file using an ASCII editor. There are a few exceptions to this general rule:

- The r-code version has changed and you must regenerate the fastload system associated with the current QC7 file.
- The directory structure of your Results application has changed during the deployment process. If this happens, you must fix the pathnames specified for feature procedures, integration procedures, and icon files in the QC7 file prior to starting Results.

If you must edit a QC7 file with an ASCII editor, follow these guidelines:

- Always back up the QC7 file before editing it.
- Do not change the order of options before the fastload= line in the QC7 file. However, after the fastload= line, the order of entries after the QC7 file does not matter, as long as each group of entries is together.
- Delete the s.r file from the file. Deleting the s.r file from the QC7 file forces Results to regenerate the fastload system from the QC7 file the next time you start Results.

For more information about QC7 files, see Chapter 2, “Administering Results.”
Editing a QD7 file

A QD7 file (query directory file) contains query definitions. Results creates and maintains three distinct types of query directory files. The public query directory (public.qd7) contains query definitions accessible by all or a select group of users. Results also automatically generates a query directory for each user (userid.qd7) and uses the user ID as part of the query directory filename. For users who have the blank user ID, Results creates the results.qd7 query directory file to store the query definitions of that user.

A single QD7 file can contain up to 256 query definitions. There is a query definition per line in a QD7 file and each definition has the following syntax:

Syntax

```
query[integerID] = "obsolete" "queryname" "dblist"
```

A query definition has a unique integer identifier, a name, and a comma-separated list containing the names of databases connected during the creation of the query. Leave the obsolete parameter empty.

Results uses the integer identifier to relate a query definition in a QD7 file with the query source file (que#####.p). For example, a query definition number 5 has a corresponding query source file named que00005.p. The query source files associated with the query definitions in a QD7 file must be located in the same operating system directory as the QD7 file.

The integer identifier for a query definition is unique across all query definitions in all QD7 files in a single operating system directory. An operating system directory can contain up to 99,999 query source files. Based on this limit and the fact that a QD7 file can contain up to 256 query definitions, do not place more than 390 QD7 files in a single operating system directory.

By default, Results creates QD7 files in the user’s working directory. After Results creates a QD7 file, you can move the file to a directory in the PROPATH. If you move a QD7 file to a new directory, you must move all query source files associated with the QD7 file to the same directory. If another QD7 file already exists in the new directory, you might have to change the integer identifiers for query definitions and the name of associated query source files to ensure that queries are unique in the operating system directory.

See Chapter 2, “Administering Results,” for more information about QD7 files.
Editing user interface and feature files

The user interface (UI) file contains code that configures the tool bar and menu system for a Results application. The feature file contains code that defines and loads the features of a Results application. These two files are crucial to the deployment process of a Results application.

Results creates and maintains the UI and feature files. The Query → Customize → Deployment menu option allows you to rename these files. The Query → Customize → Menu Layout and Query → Customize → Tool Bar Layout menu options allow you to edit the UI file, and the Query → Customize → Feature menu option allows you to interactively edit the feature file. You can add and remove only custom features, not Results features.

The only time you should edit the UI and feature files using an ASCII editor is during the deployment process. If you intend to alter the directory structure of a Results application, you must fix the pathnames of application files prior to starting Results. Edit only the pathnames of the integration procedures and new feature procedures specified in the feature file. In the UI file, edit only the pathnames of icon files associated with new features added to the Results tool bar.

For more information about UI and feature files, see Chapter 3, “Programming Results.”
Index

A

AboutResults feature A–3
Accessing data 2–8
AdminCustomizeInterface feature A–3
AdminDeployment feature A–3
AdminExportType feature A–4
AdminFeatures feature A–4
AdminIntegration feature A–4
AdminLabelField feature A–5
AdminLabelType feature A–5
AdminMenuEdit feature A–5
AdminProgInitialize feature 3–29, A–6
AdminProgInstantiate feature 3–29, A–6
AdminRebuild feature A–7
AdminReportType feature A–8

AdminReset feature A–8
AdminSecurity feature A–8
AdminSubMenu feature A–9
AdminTableAlias feature A–9
AdminTableRelations feature A–9
AdminToolbarEdit feature A–10
AdminWhere feature A–10

Aggregates
  defining A–35

Aliases
  query configuration files 2–7
  tables 2–6, A–9

API. See Application Programming Interface

API shared variables
  qbf-dtype 3–41
  qbf-rect 3–41
  qbf-rcw 3–40

Application
  generated files C–2

Application databases. See Databases
Index—2

OpenEdge Reporting: Query/Results Administration and Development

Application Programming Interface 3–13, 3–24
  basics 3–25
calculated fields 3–36
current view 3–31
editing queries 3–31
error messages 3–30
feature execution 3–28
field information 3–34
  procedures 3–27
  product version number 3–30
query fields 3–34
query names 3–32
query table list
  accessing 3–32
  setting 3–46
report formatting 3–41
sort order 3–34
table information
  accessing 3–32

Application security 2–19
  features 2–20
  integration points 3–9
QD7 files 2–22

Applications
  base files 3–5
  compiling 4–10
  configuration 3–4
  deployment process 4–2
  deployment report 4–4
  development process 3–3
  directory structure 4–9
  files 4–3, 4–7
  generating code 3–55
  icons 3–7, A–3
  integrating Results 3–53
  preferences 3–6
  product name 3–7
PROPATH 4–9
QC7 files 2–3
rebuilding 2–11, 2–15
tool bar icons 4–6
window title bar A–3

Arrays A–10

Ask at Run Time 3–56, A–29

B
Base files 3–5
  fastload files 3–5
  feature file 3–5
  UI files 3–5

Begins operator 2–26

Blank user IDs 2–17, 2–18
Browse views A–11
  queries A–22

C
CalcSubMenu feature A–11

Calculations
  percent total A–25
  running total A–31
  string function A–34

Characters
  delimiters 2–5, 3–7, A–14, C–4

Clipboard
  output A–26

Closing
  queries A–15

Code generation 3–54

Commands
  PROSERVE 1–7
  WPROSERVE 1–7

Configuration files
  database 2–3
  initial builds 2–3
  query (QC7). See Query configuration files
  query log files 2–4
configurationFileAltSrc 4–5
  featureFile 4–5
  menuFile 4–5
Configuring applications 3–4
Connecting databases 1–6, 2–4
CONTAINS operator 2–26
Counter A–11
CURRENT-WINDOW session handle 3–14
Customizing relationships 2–10
CustomLabel feature A–12
CustomReport feature A–12

D

Data
access
restricting 2–8
Data Administration tool 2–23
export formats A–32
exporting 3–52
security 2–23
features 2–28
integration points 3–9
table data selection 2–24
selection 2–24
selection criteria A–32
width A–17
Data Administration tool 2–23
Database configuration files
initial builds. See Configuration files
Databases 2–3
accessing 1–6
connecting 2–4
connections 1–6
parameters 1–7
deploying 4–5
deployment 4–8
design 3–3
multi-user 1–7
schema 2–15
servers
shutting down 1–8
starting 1–7
single-user 1–7
DataGovernor feature A–12
DateFunc feature A–13
-db startup parameter 1–7
Defined Shared Variable statement 3–26
Deleting
queries A–16
relationships 2–15
Delimiters 3–7, A–14, C–4
characters 2–5
Deploying applications 4–2
application files 4–7
compiling 4–10
databases 4–5
directory structure 4–9
feature file 4–9
QC7 files 4–9
UI files 4–9
fastload system 4–10
feature file 4–5
feature procedures 4–6
files 4–3
integration procedures 4–6
product icon file 4–7
PROPATH 4–9
QC7 files 4–5
QD7 files 4–7
query source files 4–7
report 4–4
results.l file 4–5
site requirements 4–2
tool bar icon files 4–6
u-export.p file 4–7
UI files 4–5
Deployment
  user environment 4–2
Developing applications 3–3

E

Editing
  feature files C–13
  features 3–15
  menus 3–18
  QC7 files C–11
  QD7 files C–12
  results.l C–4
  site defaults 2–28
  table aliases 2–6
  tool bar 3–22
  UI files C–13
Environment variables 4–9
  PROPATH 2–4, 3–6
Error messages 2–16, A–22, A–29
  API 3–30
  QL files 2–16
Exit A–13
Export formats 2–30, C–5
Export procedure 3–52
Export statement 3–55
Export view A–32
  queries A–23
  standard export formats 2–30
Export views
  field limits B–2
export.dat file 3–55
Exporting
  data 3–52
  delimiters A–14
  field lengths A–17
  separators A–15
  formats 2–5, 3–44, A–32
  records A–30
  setting formats A–4
ExportSubMenu feature A–13
ExportView feature A–14

F

Fastload system 3–5
  building 4–10
  deploying 4–10
  Propath 3–6
Feature Editor 3–15, A–4
Feature files 3–5
  deploying 4–5
  directory structure 4–9
  editing C–13
Feature procedures 3–12, 3–13
  arguments 3–16
  deploying 4–6
  executing features 3–28
  input parameters 3–13
  output parameters 3–13
  templates 3–14
Feature Security
  integration point 3–10
Features 3–2, A–1
  customizing A–4
  data security 2–28
  default menu label 3–16
  default tool bar icons 3–17
  defining 3–12, 3–15
  executing 3–28
  management 3–24
  menu option 3–18
  reset 3–24
  security 2–20
  sffire.p file 3–28
  toolbar icon 3–22
  user-defined A–8
Field security
  integration points 3–10

FieldDelimiters feature A–14

FieldProperties feature A–14

Fields 3–34, A–15
  aggregates A–35
  counter A–11
  delimiter characters A–14
  labels 2–32
  length A–17
  limits B–2
  logical A–21
  lookup A–21
  manipulating A–15
  numeric A–22, A–25
  properties A–14
  query information 3–34
  separators A–15
  sorting A–32
  summarizing A–35
  totals A–35

FieldsSeparators feature A–15

FileClose feature A–15

FileDelete feature A–16

FileOpen feature A–16

Files
  base 3–5
  database configuration. See Database configuration files
  deploying 4–4
  export.dat 3–55
  feature 3–5
  label.dat 3–55
  naming
    fastload A–3
    feature definition A–3
    GUI configuration A–3
  public.qd7 2–18
  query configuration
    rebuilding A–7
  See Query configuration files

query directory. See Query directory files

Results C–1
  results.l 2–5, 3–52, C–4
  results.qd7 2–18

FileSync feature A–16

FileSyncAs feature A–17

FixedWidthFields feature A–17

Footers
  manipulating A–18

Form views
  field limits B–2
  queries A–23

FormView feature A–17

4GL code
  generating A–7

FrameProperties feature A–18

Frames
  properties A–18

G

Generating A–18
  code 3–54
  queries 3–46, 3–58

Graphics
  conversion 4–8

H

Headers
  manipulating A–18, A–25

HeadersAndFooters feature A–18

Help systems
  contents A–19
  search A–19
HelpContents feature A–19
HelpSearch feature A–19

I
Icons 3–7
  adding to tool bar 3–22
  conversion 4–8
  deploying 4–6
  security 2–20
  tool bar B–3, B–5
Includes A–19
Indexes
  word 2–26
Information A–20
Initial builds
  QC7 files 2–3
  QL files 2–4
  results.l file 2–5
Integrating Results 3–53
Integration points 1–3, 3–2
  Feature Security 3–10
  Field Security 3–10
  Initialize Vars and Interface 3–10
  login program 3–10
  Menu Item Override 3–11, 3–23
  Table Security 3–11
  Table Selection Security 3–11
Integration procedures 1–3, 3–2, 3–9
  deploying 4–6

J
Joins A–20
  See also Relationships
  See Relationships
  self-joins 2–6

L
-l startup parameter 1–7
Label view A–20, A–33
  maximum lines B–2
  queries A–24
Label views
  field selection behavior 2–32
  standard label sizes 2–31
label.dat file 3–55
Labels
  default selection A–5
  fields 2–32
  formats 3–45, A–33, C–8
  maximum lines B–2
  sizes 2–5, 2–31, A–5
LabelView feature A–20
Limits B–1
List operator 2–26
Logical values A–21
LogicalFunc feature A–21
Login Program
  integration points 3–10
Logo Screen
  integration point 3–10
Lookup A–21

M
MasterDetail feature A–21
Matches operator 2–26
Math A–22
Maximum Memory (-mmax) startup parameter 1–7
Memory configuration 1–7

Menu Item Override
integration point 3–11, 3–23

Menu options
security 2–20

Menus
adding features 3–18
customizing A–5
display states 3–19
features 3–18
management 3–11, 3–20
reset 3–24
sensitivities 3–19

Messages A–22
-mmax startup parameter 1–7
Mprowin command 1–6
Multi-table queries 2–8

N
NewBrowseView feature A–22
NewDuplicateView feature A–23
NewExportView feature A–23
NewFormView feature A–23
NewLabelView feature A–24
NewReportView feature A–24
NewSubMenu feature A–24
NumericFunc feature A–25

O
Of relationships 2–8
OpenEdge
ever error messages A–22, A–29
Opening queries A–16
Operating system
security 2–17

Operators
Begins 2–26
Contains 2–26
LIST 2–26
MATCHES 2–26
Range 2–27

Options
adding to menus 3–18
Output 3–49
procedures 3–50
Output statement 3–55
Output through statement 3–50
Output to statement 3–50
OutputHeaderRecord feature A–25

P
Page breaks A–25
PageBreak feature A–25
Pages
customizing A–12
formats C–9
sizes 2–5, 2–29, A–8, A–33
Passwords. See Security
PercentTotal feature A–25
Physical Database Name (-db) startup parameter 1–7
Preferences A–3
applications 3–6
PrintClip feature A–26
PrintFile feature A–26
OpenEdge Reporting: Query/Results Administration and Development

Printing 3–49
PrintPreview feature A–26
PrintPrinter feature A–27
PrintPrinterNoBox feature A–27
PrintSubMenu feature A–27

Procedures
API 3–27
feature 3–12
initializing variables A–6
integrating A–4
integration 1–3, 3–9
parameters 3–28
results.p 3–53
sfire.p 3–27, 3–28
u-cprint.p 3–50
u-define.p 3–10
u-direct.p 3–11
u-export.p 3–52
u-export.p file 4–7
u-field.p 3–10
u-login.p 3–10
u-logo.p 3–10
u-mcheck.p 3–11, 3–20
u-pprog.p 3–50
u-pview.p 3–50
u-secure.p 3–10
u-table.p 3–11
u-thru.p 3–50
u-to.p 3–50
u-where.p 3–11
vgrpti.p 3–27, 3–41
vgtbli.p 3–27, 3–32
vgtbl.p 3–27, 3–32
vsexpi.p 3–28, 3–44
vslbi.p 3–28, 3–45
vsrpti.p 3–27, 3–45
vstbli.p 3–27, 3–42
vstbl.p 3–27, 3–44, 3–46

Processing points 3–2
Product architecture 1–2
Product icons 3–7
deploying 4–7

Product name 3–7
ProgrammingSubMenu feature A–28
Prompts 3–56

Propath
directory structure 4–9
fastload system 3–6
QC7 files 2–4
QD7 files 2–18
u-export.p file 3–52

Properties
fields A–14
frames A–18

PROSERVE command 1–7
Proserve command 1–7
Proshut command 1–8
Prowin command 1–6
_Prowin executable 1–6

Put control statement 3–50
Put statement 3–55

Q
qbf-count shared variable 3–25
qbf-dtype shared variable 3–26, 3–41
qbf-governor shared variable 3–25
qbf-module shared variable 3–25, 3–31
qbf-name shared variable 3–25, 3–32
qbf-rc# shared variable 3–25, 3–35
qbf-rcc shared variable 3–26, 3–35
qbf-rcf shared variable 3–26, 3–39
qbf-rcg shared variable 3–26, 3–39
qbf-rcl shared variable 3–26, 3–39
qbf-rcc shared variable 3–26, 3–35
qbf-rct shared variable 3–26, 3–41
qbf-rcw shared variable 3–26, 3–40
qbf-sortby shared variable 3–25, 3–34
qbf-vers shared variable 3–25, 3–30
QC7 files
   query definition limits B–2, B–4
   See Query configuration files
QD7 files. See Query directory files
QL files. See Query configuration log files

Queries
   aggregates 3–39
   browse view A–11
   calculated fields 3–35
   closing A–15
   creating 3–46
   dates A–13
   defining A–22, A–23, A–24, A–32
   definitions 2–18
   deleting A–16
   displaying information A–20
   export format 3–44
   fields 3–34
      counter A–11
      data types 3–41
      formats 3–39
      labels 3–39
      names 3–35
      number of 3–35
      width 3–40
   form view A–17
   frames A–18
   generating 3–58
   information 3–25
inserting code A–19
label format A–19
label view A–12
limiting records A–12
lookup fields A–21
multiple tables A–8
name 3–32
opening A–16
previewing output A–26
printing output A–27
report format 3–45
saving A–16, A–17
sending output to clipboard A–26
sending output to file A–26
sort fields 3–34
source code files A–18
table information 3–42
   accessing 3–32
   setting 3–46
table list 3–44
tables 3–32, A–34
view 3–31
view layout 3–40

Query
   name length limit B–2, B–4

Query configuration files
   aliases 2–7
   database connections 2–4
   deploying 4–5
   directory structure 4–9
   editing 3–8, C–11
   fastload system 3–5
   feature security 2–20
   initial builds 2–3
   location 2–4
   multiple databases 2–4
   PROPATH 2–4
   rebuilding 2–15, A–7
   results 2–5
   save behavior 3–8
   standard export formats 2–30
   standard label sizes 2–31
   standard page sizes 2–29
   table relationships 2–8, 2–10
Query configuration log files 2–4
   rebuild messages 2–16
Query definition
   limits B–2, B–4
Query directories 2–18
Query directory files 2–18
   blank user 2–18
   creating 2–18
   deployment 4–7
   editing C–12
   integration points 3–11
   location 2–18
   public 2–18
   user IDs 2–18
Query source file
   deployment 4–7
   limits B–2, B–4

Records
   exporting A–30
   limiting A–12
   security A–29, A–30, A–31
RecordStart feature A–30
RecordUpdate feature 2–28, A–31
Relationships 2–8
   building 2–14
   creating 2–11
   custom 2–10
   defining A–20
   deleting 2–15
   editing 2–12
   OF relationships 2–8
   rebuilding 2–15
   tables A–9
   WHERE relationships 2–13
Report format 3–45
ReportView feature A–31
Report views A–31, A–33
   field limits B–2
   formatting 3–41
   queries A–24
   standard page sizes 2–29
Reports
   default format 2–5
result.l file
   deploying 4–5
Results
   add calculated field menu A–11
   administration menu A–9
API. See Application Programming Interface
   architecture 1–2
   code generation 3–54
   custom export menu A–13
   customize menu A–28
   customizing 1–4
delimiter characters 3–7
deploying 4–2
   exit behavior A–3
Index

exiting A–13
exporting data 3–52
features A–1
    customizing A–4
files C–1
generated files C–2
help system A–19
installing A–3
integrating 3–53
limits B–1
memory configuration 1–7
menu bar
    customizing A–8
menu system 3–18
new query menu A–24
output solutions 3–49
print menu A–27
programmer 1–4
query configuration files 2–3
security A–8
site administrator 1–4
starting 1–6
startup procedure 3–53
stopping 1–6
tool bar 3–22
    customizing A–8
version 2 1–1

Results engine 1–4

results.l
    delimiters C–4
    editing C–4
    standard export formats C–5
    standard label sizes C–8
    standard page sizes C–9

results.l file 2–5
    standard export formats 2–30, 3–52
    standard label sizes 2–31
    standard page sizes 2–29

results.p file 3–53
results.qd7 file 2–18
Run statement 3–28

Run time
    user input A–29

RunningTotal feature A–31

S

-s startup parameter B–3, B–4

Saving
    queries A–16, A–17

Security 2–23
    application 2–19
    data 2–23
    features 2–20
    integration points 3–9
    QD7 files 2–18, 2–22
    query directory files 2–18
    tables 3–11
    user access 2–18, A–28, A–29, A–30,
    user IDs 2–17

Selection A–32

Selection criteria
    API procedures
        vgtbli.p file 3–32
    Begins operator 2–26
    CONTAINS operator 2–26
    defining 2–27
    integration points 3–11
    limits B–3, B–4
    LIST operator 2–26
    MATCHES operator 2–26
    RANGE operator 2–27
    run-time prompts 2–27
    tables A–10
    word indexes 2–26

Self-joins 2–6

Server shutdown command 1–8

Servers
    starting 1–7

Index–11
Session handles
  Current-Window 3–14

sffire.p file 3–27
  parameters 3–28

Shared variables
  API 3–25
  qbf-count 3–25
  qbf-dtype 3–26
  qbf-governor 3–25
  qbf-module 3–25, 3–31
  qbf-name 3–25, 3–32
  qbf-rc# 3–25, 3–35
  qbf-rcc 3–26, 3–35
  qbf-rcl 3–26, 3–39
  qbf-rcg 3–26, 3–39
  qbf-rcl 3–26, 3–39
  qbf-rcf 3–26, 3–39
  qbf-rcw 3–26
  qbf-sortby 3–25, 3–34
  qbf-vers 3–25, 3–30
  u-pvars.i 3–26

Shutdown commands 1–6

Single-user Mode (-1) startup parameter 1–7

Site defaults 2–5, 2–28
  editing 2–5
  label field selection 2–32
  standard export formats 2–30
  standard label sizes 2–31
  standard page sizes 2–29

Sorting data A–32

SortOrdering feature A–32

Stack Size (-s) startup parameter B–3, B–4

Stacked arrays A–10

Standard export formats 2–30

Standard label sizes 2–31

Standard page sizes 2–29

StandardExport feature A–32

StandardLabel feature A–33

StandardReport feature A–33

Starting Results 1–6

Startup commands 1–6
  Mprowin 1–6
  Prowin 1–6

Startup parameters
  Maximum Memory (-mmax) 1–7
  Physical Database Name (-db) startup parameter 1–7
  Single-user Mode (-1) 1–7
  Stack Size (-s) B–3, B–4
  Stash Area (-stsh) B–3, B–4

Stash Area (-stsh) startup parameter B–3, B–4

Statements
  DEFINE SHARED VARIABLE 3–26
  Export 3–55
  OUTPUT THROUGH 3–50
  OUTPUT TO 3–50
  Put 3–55
  PUT CONTROL 3–50
  RUN 3–28
  TERMINAL PAGED 3–55
  UPDATE 3–56
  WAIT-FOR 3–55

Status line
  displaying A–33

StatusLine feature A–33

Stopping Results 1–6

StringFunc feature A–34

-stsh startup parameter B–3, B–4
Index

T

Table
sort field limit B–3, B–4

Table relationships
building 2–14
creating 2–11
custom 2–10
default 2–8
deleting 2–15
editing 2–12
OF relationships 2–8
rebuilding 2–15
WHERE relationships 2–13
limits B–3, B–5

Table Selection Security
integration point 3–11

Tables A–34
aliases 2–6, A–9
break points A–21
data selection 2–24
including in queries A–19
information
accessing 3–32
joining 2–6
queries 3–42, 3–44, A–34
query information 3–32
relationships 2–8, A–9
security 3–11
selection criteria 2–24, A–10

Templates
feature procedures 3–14

TERMINAL PAGED statement 3–55

Tool bar A–34
customizing A–10
displaying A–34
editing 3–22
features 3–22
icon display state 3–23
icon sensitivity 3–23
icons 3–23
limits B–3, B–5
management 3–23
managing 3–11, 3–23
reset 3–24
Totals A–35
TotalsOnly feature A–35

U

u-cprint.p file 3–50
u-define.p file 3–10
u-direct.p file 3–11
u-export.p file 3–52
deployment 4–7
PROPATH 3–52
u-field.p file 3–10
u-login.p file 3–10
u-logo.p file 3–10
u-mcheck.p file 3–11, 3–20
u-pprog.p file 3–50
u-pvars.i file 3–26
u-pview.p file 3–50
u-secure.p file 3–10
u-table.p file 3–11
u-thru.p file 3–50
u-to.p file 3–50
u-where.p file 3–11

UI files 3–5
deploying 4–5
directory structure 4–9
editing C–13

UPDATE statement 3–56
User environment
   deployment process 4–2
   requirements 4–2
User IDs 2–17
   blank 2–17, 2–18
   feature security 2–21
   lists 2–21
   operating system 2–17
   passwords 2–17
   QD7 files 2–18
   specifications 2–21
User interface
   integration points 3–10
   management 3–24
   menu management 3–11, 3–20
   product icons 3–7
   product name 3–7
   toolbar management 3–11, 3–23
User lists 2–21
Users
   access A–8

V
Variables
   API 3–25
   initializing A–6
   vgrpti.p file 3–27
      parameters 3–41
   vgtblp file 3–27
      parameters 3–32
   vgtblp file 3–27
      parameters 3–32
   Views 3–31
   browse A–11, A–22
   export A–14, A–23, A–32
   form A–17, A–23
   label A–12, A–20, A–24, A–33
   report A–12, A–24, A–33
   vsexpi.p file 3–28
      parameters 3–44
   vslblp file 3–28
      parameters 3–45
   vsrpti.p file 3–27
      parameters 3–45
   vstblp file 3–27
      parameters 3–42
   vstblp file 3–27
      parameters 3–44, 3–46

W
WAIT-FOR statement 3–55
WHERE clause 3–11, A–32, B–3, B–5
   table relationships 2–13
   tables A–10
Word indexes 2–26
WPROSERV executable 1–7
WPROSERVE command 1–7
WPROSHUT executable 1–8
WriteOtherDirectory feature 2–18, 2–22, A–35